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 PROFESSIONAL  WEB  DESIGNER  COURSE

บทที่ 1

ความรู้ทั่วไปเกี่ยวกับอินเทอร์เน็ตและการออกแบบ  Web Site 


ถ้าจะพูดถึงการสื่อสารในรูปแบบใหม่ ที่สามารถสื่อสารกันได้อย่างรวดเร็วและมีราคาถูกที่สุด ก็คงหนีไม่พ้นที่จะกล่าวถึง “อินเทอร์เน็ต” ซึ่งได้รับความนิยมไปทั่วโลก ไม่เว้นแม้กระทั่งประเทศไทย ซึ่งในปัจจุบันก็มีการใช้งานอินเทอร์เน็ตกันแพร่หลายในหน่วยงานราชการ องค์กรต่าง ๆ โดยได้รับความสนใจจากกลุ่มผู้ใช้ทุกระดับเพิ่มขึ้นเรื่อย ๆ โดยเฉพาะนักเรียน นิสิต นักศึกษาที่กำลังเป็นกลุ่มผู้ใช้อินเทอร์เน็ตที่ใหญ่ที่สุดสำหรับประเทศไทย และอาจจะพูดได้ว่า อินเทอร์เน็ตนำมาซึ่งการเปลี่ยนแปลงของวงการคอมพิวเตอร์ครั้งสำคัญที่สุด นับตั้งแต่มีการเปิดตัวเครื่องพีซี การเชื่อมต่อคอมพิวเตอร์จำนวนมากเข้าด้วยกันเป็นเครือข่ายอินเทอร์เน็ต ก่อให้เกิดการแลกเปลี่ยนข้อมูล และการสื่อสารที่เป็นประโยชน์อย่างมหาศาล คนจากทั่วโลกแทบทุกเพศทุกวัยและทุกอาชีพ สามารถสื่อสารกันผ่านเครือข่ายอินเทอร์เน็ตได้อย่างไม่มีข้อจำกัดทางเชื้อชาติ หรือศาสนา อินเทอร์เน็ตจึงได้กลายเป็นสังคมขนาดใหญ่ที่เกิดขึ้นในโลกคอมพิวเตอร์โดยถูกขนานนามว่า “ ไซเบอร์สเปซ (Cyberspace) ” 


อินเทอร์เน็ตกำลังเติบโตขึ้นอย่างรวดเร็ว ปัจจุบันมีผู้ใช้อินเทอร์เน็ตทั่วโลกมากกว่า 60 ล้านคน และมีผู้สมัครเป็นสมาชิกเพื่อขอใช้บริการอินเทอร์เน็ตมากกว่า 1 ล้านคนต่อเดือน อินเทอร์เน็ตจึงก่อให้เกิดโอกาสและบริการใหม่มากมาย เช่น สามารถทำธุรกรรมผ่านระบบอินเทอร์เน็ต พบประสนทนากับผู้อื่น เผยแพร่ความรู้ และให้บริการด้านข้อมูลข่าวสาร นอกจากนี้อินเทอร์เน็ตยังเป็นสื่อที่นำเสนอความบันเทิงในรูปแบบของรายการวิทยุ โทรทัศน์ ดนตรี ภาพยนตร์ และเกมส์ จนมีการกล่าวว่าถ้าธุรกิจใดไม่สนใจโลกไซเบอร์สเปซ ธุรกิจนั้นกำลังปฏิเสธอนาคตของตัวเองเสียแล้ว 
ความเป็นมาของอินเทอร์เน็ต

อินเทอร์เน็ตคือเครือข่ายของระบบคอมพิวเตอร์ขนาดต่าง ๆ เชื่อมต่อเข้าหากันจนเป็นระบบเครือข่ายคอมพิวเตอร์ที่ใหญ่ที่สุด เป็นจำนวนหลายล้าน ๆ เครื่องโดยใช้โปรโตคอลชนิดพิเศษในการสื่อสารซึ่งอินเทอร์เน็ตได้มีบริการต่าง ๆ หลายอย่างซึ่งมีความสามารถต่าง ๆ กันไป
ประวัติความเป็นมาของอินเทอร์เน็ตเริ่มต้นจากเครือข่าย ARPAnet ของหน่วยงานชื่อ Advance Research Projects Agency ซึ่งเป็นเครือข่ายการวิจัยเพื่อป้องกันของ U.S. Department if Defense ซึ่งเกิดในช่วงปี 1970 มีการออกแบบระบบที่ทำให้นักวิจัยและนักวิทยาศาสตร์ทำการแลกเปลี่ยนข้อมูลข่าวสารระหว่างกันและกันได้ดีขึ้น และทำให้เกิดการพัฒนาเป็นระบบโอนถ่ายข้อมูล รูปแบบใหม่ที่สามารถสื่อสารได้หลายทางคือ Transmission Control Protocol / Internet protocol (TCP/IP)   ซึ่งต่อมาคือ มาตรฐานการรับส่งข้อมูลของ
อินเทอร์เน็ต



ต่อมาจึงมีการจัดตั้งหน่วยงานใหม่ที่ชื่อว่า The National Science Foundation (NFS) หรือ NFSNET โดยผู้เชี่ยวชาญจาก ARPAnet ที่แยกตัวออกมา เครือข่ายนี้ใช้สำหรับเชื่อมต่อเครือข่ายของมหาวิทยาลัย และศูนย์วิจัยต่าง ๆ เข้าด้วยกันทำให้เกิดการเพิ่มปริมาณเครือข่าย และการติดต่อสื่อสารในรูปแบบต่าง ๆ เช่น
 E-mail, การโอนถ่ายข้อมูล (FTP) และการใช้ข้อมูลร่วมกัน และในที่สุดก็เรียกเครือข่ายนี้ว่า “ อินเทอร์เน็ต (Internet) ”

ส่วนประกอบต่าง ๆ ของอินเทอร์เน็ต (Components of Internet)


ในอินเทอร์เน็ตมีบริการต่าง ๆ ที่มีความแตกต่างกันตามจุดประสงค์การใช้งานของผู้ใช้ เช่น ความต้องการในการสื่อสาร ,ความต้องการในการหาข้อมูล , การนำเสนอสินค้าและบริการผ่านทางเครือข่าย เป็นต้น ดังนั้นจึงจำเป็นที่จะต้องทำความรู้จักกับบริการต่าง ๆ ในอินเทอร์เน็ตเพื่อที่จะได้ใช้งานอย่างคุ้มค่า ซึ่งในเครือข่ายอินเทอร์เน็ตที่เชื่อมกันอยู่นั้นประกอบด้วยเครื่องคอมพิวเตอร์ที่ทำหน้าที่เป้น Server หรือเรียกอีกแบบคือ Host ซึ่งทำหน้าที่ต่าง ๆ กันในการให้บริการในระบบ   ซึ่งสามารถแบ่งบริการต่าง ๆ ของอินเทอร์เน็ตเป็น  
2 ส่วนดังนี้
1. บริการด้านการสื่อสาร (Communication Service)

2. บริการด้านการค้นหาข้อมูล (Information Service)

บริการด้านการสื่อสารในอินเทอร์เน็ตมีความหลากหลายในแง่ของวัตถุประสงค์ การใช้งานและความสามารถของโปรแกรมที่ใช้ในแต่ละบริการ ซึ่งอาจแบ่งแยกย่อยได้ดังนี้
จดหมายอิเล็กทรอนิกส์ (E-mail)


E-mail ย่อมาจาก Electronic Mail   E-mail จึงเป็นบริการในอินเทอร์เน็ตที่ได้รับความนิยมมากที่สุด เนื่องจากการใช้งานที่ง่ายและความต้องการในการติดต่อของผู้คนในปัจจุบันมีสูงมาก ทำให้บริการ E-mail ได้รับการตอบรับจากผู้ใช้ในวงกว้าง ความสามารถของ E-mail คือการส่งข่าวสารไปถึงผู้รับได้ในระยะเวลาอันสั้นแทบจะทันทีหลังจากมีการส่ง ทำให้เป็นระบบที่รวดเร็วกว่าการสื่อสารแบบอื่น อีกทั้งยังประหยัดเงินในการใช้งานมากกว่าการสื่อสารแบบเก่า เช่น FAX เป็นต้น ดังนั้นการแพร่หลายของ E-mail ฟรี ของ Web Site ต่าง เช่น Hotmail (http://www.hotmail.com) , USA net (http://www.usa.net) หรือแม้แต่ E-mail ฟรี ของคนไทยคือ Thaimail (http://www.thaimail.com) เป็นต้น ในสมัยที่ Email ยังไม่ได้รับการพัฒนาเป็นแบบ Graphic นั้น  โปรแกรมเมล์ที่มีอยู่จะใช้ได้กับเครื่องที่รับระบบปฏิบัติการ UNIX เท่านั้น ซึ่งใช้การ input ข้อมูลและคำสั่งแบบตัวอักษร (Text mode) เช่น โปรแกรม PINE ซึ่งต่อมามีการพัฒนาโปรแกรมแบบที่เป็น Graphic เช่น โปรแกรม Eudora ซึ่งเป็นโปรแกรมเมล์ที่ใช้ง่าย และมีความสามารถในการปรับแต่งค่าต่าง ๆ ได้มากมาย แต่ในปัจจุบัน โปรแกรม Web browser เช่น Netscape Navigator และ Internet Explorer ได้รวมโปรแกรมเมล์ไว้ในตัวอยู่แล้ว ซึ่งโปรแกรมเมล์ที่รวมอยู่ใน Browser ส่วนใหญ่มีความสามารถสูงและใช้งานง่าย
บริการกระดานข่าวอิเล็กทรอนิกส์ (Usenet) 


เป็นบริการที่ได้รับความนิยมมากพอสมควร เนื่องจากลักษณะพิเศษ คือ การแบ่งหัวข้อความสนใจในเรื่องต่าง ๆ ออกเป็นเรื่องย่อย ๆ  แล้วแต่ว่าจะมีคนตั้งขึ้นมา แล้วให้มีคนที่มีความสนใจคล้ายกันเข้ามาทิ้งข้อความต่าง ๆ เกี่ยวกับเรื่องนั้น ๆ ไว้ แล้วผู้ที่เข้ามาอ่านคนอื่น ๆ สามารถเข้ามาแสดงความคิดเห็นได้ บริการนี้จะเรียกอีกชื่อหนึ่งว่า Newsgroup ปัจจุบันมี  Web Site  ที่ให้การบริการแบบกระดานข่าวอิเล็กทรอนิกส์ เกิดขึ้นมากมายทั้งของไทยและต่างประเทศ สำหรับประเทศไทย  Web Site  ที่มีชื่อเสียงในการบริการทางด้านนี้ดีที่สุดก็คงเป็น  Web Site  พันธ์ทิพย์ (http://www.pantip.com) ซึ่งได้แบ่งหัวข้อต่าง ๆ ไว้มากมายสามารถเข้าไปสอบถามปัญหาหรือเรื่องราวต่าง ๆ ที่ตนเองสนใจได้ตลอดเวลา
การโอนถ่ายข้อมูลระหว่างเครื่อง (File Transfer Protocol : FTP)


FTP เป็นบริการอีกอย่างหนึ่งที่มีความจำเป็นมากในระบบอินเทอร์เน็ต เนื่องจากเมื่อระบบ World wide Web มีการขยายตัวของผู้ใช้มากขึ้น ก็ต้องมีการโอนถ่ายข้อมูลระหว่างเครื่องมากขึ้น เช่น เมื่อผู้ต้องการออกแบบ  Web Site  ได้ทำการออกแบบเสร็จแล้ว ต้องมีการส่งข้อมูลทั้งหมดไปที่ Server เพื่อให้ผู้ใช้ (User) สามารถเข้าไปที่  Web Site  เพื่อดูข้อมูลได้ ปัจจุบันมีโปรแกรมที่สามารถทำให้ใช้งานในรูปแบบของ FTP ได้ง่ายขึ้นเช่น WS_FTP, Cute_FTP เป็นต้น
การสนทนาผ่านระบบออนไลน์ (Internet Relay Chat : IRC)


IRC คือห้องสนทนาแบบออนไลน์ ซึ่งแบ่งเป็นห้องย่อยให้ผู้ใช้ log in เข้ามาเพื่อพูดคุยกันในเรื่องต่าง ๆ
ที่ต้องการ โดยอาจจะมีการตั้งหัวข้อเป็นชื่อห้องไว้ก่อนก็ได้ หรือเข้ามาแล้วค่อยตั้งประเด็นในการพูดคุยกันก็ได้ วิธีการใช้คือสามารถพิมพ์ข้อความที่ต้องการจากเครื่องของ หลังจากเคาะปุ่ม enter แล้ว ข้อความนั้นจะไปปรากฏบนหน้าจอของคนอื่นๆ ซึ่งเขาก็สามารถอ่านได้ ในขณะเดียวกันก็สามารถอ่านข้อความจากคนอื่น ๆ ได้เช่นกัน เรียกบริการนี้อีกชื่อหนึ่งว่า Chat Room ปัจจุบันมีโปแกรมอีกแบบหนึ่งที่ได้รับความนิยมมากขึ้นเรื่อย ๆ คือ ICQ  (I Seek You)  ซึ่งเป็นอีกรูปแบบหนึ่งของการพูดคุยทางอินเทอร์เน็ตเหมือนกัน
World Wide Web 


เป็นบริการที่ได้รับความนิยมมากที่สุดรองจากการใช้ E-mail เนื่องจากเป็นช่องทางการเข้าถึงข้อมูลที่สะดวกที่สุดในปัจจุบัน กระแสความนิยมของอินเทอร์เน็ตที่เกิดขึ้นอาจจะเรียกได้ว่าเป็นเพราะ  Web Site  เลยทีเดียว เนื่องจากปัจจุบันมี  Web Site  เกิดขึ้นใหม่ทุกวันและเป็นข้อมูลที่กล่าวกันว่า ถ้าเข้าไปดู  Web Site  ละหนึ่งนาทีก็ไม่สามารถดูข้อมูลได้หมดในช่วงชีวิตของ นอกจากนี้กระแสความนิยมของ  Web Site  ทำให้เกิดธุรกิจที่เกี่ยวข้องตามมาอีกมากมาย  เช่น  E-Commerce, การเจริญเติบโตของตลาดคอมพิวเตอร์ ฯลฯ 
ประวัติของ World Wide Web (Web History)


การพัฒนาระบบ World Wide Web เริ่มต้นเมื่อเดือนมกราคม 1989 โดยนักวิจัยจากสถาบัน CERN (Conseil European Pour La Recherche Nucleaire) ซึ่งเป็นห้องทดลองใน เจนีวา ประเทศสวิสเซอร์แลนด์ ชื่อ Tim Berners-Lee ได้นำความคิดเรื่อง Hypertext ของ Vannevar Bush และ Ted Nelson มาใช้ในจุดประสงค์ที่จะกระจายข้อมูลในองค์กร ซึ่งมีหลัก 3 ประการที่สำคัญคือ
1. การทำงานในหน้าของผู้ใช้ (User) จะต้องสามารถเรียกใช้ข้อมูลจากเครื่องคอมพิวเตอร์ที่หลากหลายในด้านระบบปฏิบัติการได้
2. Interface จะต้องสามารถแสดงผลกับข้อมูลหลายรูปแบบได้
3. ต้องสามารถให้ผู้ใช้เข้าถึงข้อมูลใน Network ได้ง่าย
ช่วงปลายปี 1990
ต้นแบบของ www ได้ทดลอง Run บนเครื่อง Next แต่ยังไม่รับความแพร่หลายนัก
มีนาคม 1991
www interface ได้ถูกใช้ใน Network โดยการลงที่เครื่อง Server ของ CERN ปลายปี 1991 ทาง CERN ได้ประกาศระบบไฟล์ใน Uernet Newsgroup และโปรแกรม WAIS ได้ประกาศใช้อย่างเป็นทางการ
ปี 1992
CERN ได้พัฒนา Web อย่างต่อเนื่อง และเริ่มแพร่หลายในหมู่นักวิจัย โดยมีจำนวน Web server ประมาณ 50 server

ปี 1993
เริ่มมีการพัฒนา Graphic Interface Viewer ขึ้นมาเป็นครั้งแรกโดยเรียกว่า Browser โดยนักศึกษาปริญญาตรี มหาวิทยาลัย Illinois At Urbana Champaign ชื่อว่า มาร์ค แอนเดรสัน โดยโปรแกรมนี้ชื่อว่า Mosaic ซึ่งเป็นโปรแกรมที่แสดงผลของ Web โดยใช้ระบบ Point-And-Click-Design การเจริญเติบโตของ Web ในปี 1993 เติบโตอย่างรวดเร็วทำให้มีจำนวน Server เพิ่มขึ้นเป็น 500 Server ในปลายปี 1993

ปี 1994
บริษัทต่าง ๆ เริ่มโดดเข้ามาร่วมในการพัฒนา Browser ต่าง ๆ โดยมีการเปิดตัว Browser ใหม่ ๆ หลายบริษัท เช่น Netscape Communication Corporation ทำให้ในกลางปี 1994 มี Web server เพิ่มขึ้นมาเป็น 1,500 Server มีการกำหนดมาตรฐานของ Web โดยตั้งองค์กรขึ้นมา เพื่อควบคุมพัฒนากาการของ Web ให้เป็นไปในแนวทางเดียวกันชื่อว่า World Wide Web Consortium หรือ W3C (www.w3c.org)

ปี 1995
การเติบโตของ Web ยังคงรวดเร็วและต่อเนื่องโดยมีจุดเปลี่ยนแปลงอยบู่ที่ Browser ของ Netscape Communication ซึ่งใช้ชื่อว่า Netscape Navigation ซึ่งมีความสามารถในการแสดงผลของ HTML (Hypertext Mark-up Language) ได้ดีขึ้น ซึ่งสนับสนุน HTML2 ของ W3C ซึ่งทำให้ Netscape Navigation คือ Browser ที่ครองตลาดกว่า 90% ในปีนั้น และการใช้ Web ทางการค้าก็ได้เริ่มขึ้นอย่างจริงจังในปีนี้ โดยเริ่มต้นธุรกิจที่เกี่ยวกับ Web เช่น Search Engine, ISP , Web Designer เป็นต้น
ปี 1996
มีการแข่งขันกันอย่างมากในวงการ Internet และ Browser เนื่องจาก Microsoft ได้เปลี่ยนมาประกาศสนับสนุนการพัฒนาโปรแกรมต่าง ๆ เพื่อใช้งานร่วมกับอินเทอร์เน็ตโดยการออกโปรแกรม Browser ใหม่ชื่อว่า Internet Explorer ทำให้เกิดสงคราม Browser ขึ้นมาเนื่องจากนโยบายการแจก Browser ฟรีของ Microsoft ทำให้ส่วนแบ่งการตลาดของ Netscape ตกลงอย่างรวดเร็ว
ปี 1997- ปัจจุบัน
มาถึงวันนี้วงการอินเทอร์เน็ตและ  Web Site  ได้พัฒนาขึ้นอย่างมากมาย มีกระแสหลายอย่างที่ผลักดันให้อินเทอร์เน็ตได้รับความนิยมมากขึ้น โปรแกรม Browser ก็ได้รับการพัฒนาและมีขีดความสามารถสูงขึ้นอย่างมากมาย และ Browser ที่ได้รับความนิยมมากที่สุดในปัจจุบันก็คือ Internet Explorer ซึ่งพัฒนามาถึง version 6 แล้ว ทำให้ทุกวันนี้คงไม่มีใครไม่รู้จักคำว่า อินเทอร์เน็ต อีกต่อไป
 Web Site  สามารถใช้ทำอะไรได้บ้าง


โดยหลักการแล้ว WWW ได้ถูกออกแบบมาให้เป็นเอกสารอิเล็กทรอนิกส์ซึ่งปัจจุบันถูกเรียกย่อ ๆ ว่า Web ซึ่งขีดความสามารถของเทคโนโลยีWebมีความสามารถในการทำหลาย ๆ สิ่งมากยิ่งขึ้น จึงทำให้การประยุกต์ใช้งานต่าง ๆ บน WWW เป็นไปอย่างหลากหลายตั้งแต่การประกาศข่าวธรรมดา ๆ ไปจนถึงการทำการค้าด้วยระบบอิเล็กทรอนิกส์ นี่เป็นเพียงตัวอย่างที่ต้องการแสดงให้เห็นว่าเทคโนโลยีของWeb ทำอะไรได้บ้าง
เอกสารประชาสัมพันธ์ (Catalog / Brochure)


เอกสารประชาสัมพันธ์ ถือได้ว่าเป็นเอกสารที่องค์กรประเภทขายตรง ซุปเปอร์มาเก็ต ห้างสรรพสินค้า ฯลฯ นำมาเป็นเอกสารหลักในการประชาสัมพันธ์ทางการตลาดเพื่อให้ลูกค้าสารมารถเห็นสินค้าต่าง ๆ จูงใจทางราคาและให้รายละเอียดคร่าว ๆ ของสินค้า การจัดพิมพ์เอกสารเหล่านี้ในแต่ละครั้ง องค์กรจะต้องเสียค่าใช้จ่ายจำนวนมาก หากต้องการพิมพ์สี่สีทั้งเล่ม ก็จะต้องเสียค่าใช้จ่ายเพิ่มเป็น 2 เท่าของการพิมพ์แบบขาวดำ การจัดทำ  Web Site  เพื่อประชาสัมพันธ์เหล่านี้จึงเป็นวิธีที่สามารถลดค่าใช้จ่ายขององค์กรลงได้ นอกจากลูกค้าจะสามารถเข้าชม  Web Site  ได้ตลอด 24 ชั่วโมงแล้ว องค์กรเองก็สามารถปรับปรุง  Web Site  ของตนเองได้ตลอดเวลาโดยไม่จำเป็นต้องเสียค่าใช้จ่ายในการพิมพ์เอกสารเหล่านั้นอีกครั้งหนึ่ง
ห้องแสดงสินค้า (Showroom)


จะเห็นได้ว่า ธุรกิจหลายประเภทในปัจจุบันนี้เช่น ขายรถยนต์ โทรศัพท์เคลื่อนที่ ของเล่น ภาพวาด ฯลฯ ธุรกิจประเภทนี้โดยปกติจำเป็นต้องสร้างร้านเพื่อแสดงสินค้า ซึ่งสินค้าต่าง ๆ เหล่านั้นเป็นสินค้าที่มีราคาสูง หากนำสินค้าจริงทุกรุ่นมาตั้งไว้ให้ลูกค้าชม ก็จำเป็นต้องลงทุนเป็นจำนวนมหาศาล ด้วยเทคโนโลยีของอินเทอร์เน็ตในปัจจุบัน การจัดทำ  Web Site  จะสามารถทดแทนลักษณะของสำนักงานหรือร้านค้าที่เป็นห้องแสดงสินค้าได้เป็นอย่างดี เนื่องจากสามารถพัฒนา  Web Site  เป็นลักษณะสามมิติ ซึ่งผู้ชมสามารถจับหรือเคลื่อนสิ้นค้าเหล่านี้แบบเสมือนจริง
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ศูนย์บริการทางอินเทอร์เน็ต (Internet Service Center)


อินเทอร์เน็ตถือได้ว่าเป็นสังคมของผู้ใช้คอมพิวเตอร์ที่ใหญ่ที่สุดโลก ซึ่งมี  Web Site  จำนวนมากที่ถูกสร้างขึ้นเพื่อเป็นศูนย์กลางในการติดต่อสื่อสารของคนทั้งโลก ไม่ว่าจะเป็นการให้บริการทางด้านการค้นหาข้อมูลที่ต้องการ (Search Engine), การให้บริการด้านอีเมล์ , การให้บริการพื้นที่สำหรับการสร้าง  Web Site  หรือการให้บริการทางด้านห้องสนทนา (Chat Room)
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รูปที่ 1.2 การให้บริการต่าง ๆ บน  Web Site 

การศึกษาระยะทางไกล (Distance Education)


ด้วยเทคโนโลยีของอินเทอร์เน็ตที่ก่อกำเนิดมาจากการศึกษา ในขั้นเริ่มต้นของ WWW ความสามารถในตอนนี้คือสามารถทำเป็นหนังสืออิเล็กทรอนิกส์ได้อยู่แล้ว โดยสามารถทีทั้งภาพและข้อความ แต่ในปัจจุบันภาพวีดีโอและเสียงต่าง ๆ สามารถถูกส่งผ่านระบบอินเทอร์เน็ตไปถึงผู้เข้าชม  Web Site  ได้อย่างง่ายดาย ดังนั้นการศึกษาระยะไกล หรือที่เรียกอีกอย่างหนึ่งในปัจจุบันว่า E - Learning จึงเป็นสิ่งที่เป็นไปได้และกำลังแพร่หลายในปัจจุบัน
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ธุรกิจออนไลน์ (Online Business)


นับเป็นการปฏิวัติครั้งสำคัญในการทำการค้าของมนุษยชาติเมื่อรูปแบบการค้าที่เคยทำกันมาตั้งแต่อดีต ถูกแทนที่ด้วยระบบคอมพิวเตอร์ ซึ่งก่อนหน้านี้ไม่เคยมีใครคาดคิดมาก่อนว่า การค้าขายโดยผ่านระบบคอมพิวเตอร์จะทำได้จริงโดยไม่จำเป็นจะต้องมีคนมาเป็นพนักงานขาย  บริษัทที่เป็นผู้บุกเบิกการค้าผ่านระบบอินเทอร์เน็ต และประสบความสำเร็จที่คนทั่วโลกรู้จักก็คือ Amazon.com นั้นเอง หลังจากที่ Amazon.com ประสบความสำเร็จสามารถล้มยักษ์ใหญ่ของธุรกิจหนังสือ Barnes and Noble ได้สำเร็จ แม้ว่า Barnes and Noble จะสร้าง  Web Site  มารองรับแล้วก็ตาม กระแสของ E-commerce ประทุขึ้นทั่วโลก แนวโน้มในอนาคต Online Business จะเป็นแนวทางที่เกือบทุกองค์กร โดยเฉพาะอย่างยิ่งองค์กรธุรกิจจำเป็นต้องนำมาเป็นส่วนหนึ่งของ องค์กร ไม่ว่าทางใดก็ทางหนึ่ง
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รูปที่ 1.4 ธุรกิจออนไลน์บนอินเทอร์เน็ต
ความสำคัญของการออกแบบ  Web Site 


 Web Site  เป็นสื่อที่อยู่ในความควบคุมของผู้ใช้โดยสมบูรณ์ เพราะผู้ใช้มีโอกาสที่จะเลือก Click หรือไม่Click ที่ไดก็ได้ตามต้องการ และสามารถไปยังทุกหนแห่งได้อย่างง่ายดายด้วยการใช้ Mouse Click ไปตามLink ต่าง ๆ ผู้ใช้จึงมักไม่ค่อยมีความอดทนกับอุปสรรคและปัญหาที่เกิดจากการออกแบบที่ผิดพลาด ถ้าผู้ใช้ไม่สามารถมองเห็นประโยชน์จาก  Web Site  ของ หรือดูแล้วไม่เข้าใจว่าจะใช้งานอย่างไร ก็มักจะเปลี่ยนไปยัง Web Site  อื่นอย่างรวดเร็ว ดังนั้นจึงจำเป็นต้องออกแบบ  Web Site  เพื่อให้เกิดประโยชน์สูงสุดต่อผู้ใช้ และดึงดูดให้พวกเขาเข้ามาใช้บริการใน  Web Site  อยู่เสมอ

ในปัจจุบันนี้ นอกจากจะมี  Web Site  อยู่มากมายแล้ว ก็ยังมี Web ที่เกิดขึ้นใหม่ทุก ๆ วัน ผู้ใช้จึงมีทางเลือกมากขึ้นที่จะเข้าไปทดลองใช้บริการใน Web ต่าง ๆ เพื่อนำมาเปรียบเทียบหา Web ที่ถูกใจมากที่สุด แทนที่จะทนอยู่ในWebที่ดูแล้วสับสน ไม่น่าพอใจ ผู้ใช้งานอินเทอร์เน็ตทุกคนคงชอบ Web ที่ออกแบบมาอย่างสวยงามและมีการใช้งานที่สะดวกมากกว่าWebที่ดูแล้วสับสนวุ่นวาย มีข้อมูลมากมายเต็มหน้าจอ แต่หาอะไรไม่เจอ แถมยังใช้เวลาแสดงผลในแต่ละหน้านานจนไม่อยากรอ สิ่งเหล่านี้ล้วนเป็นผลมาจากความแตกต่างในการออกแบบ Web Site  นั่นเอง

การออกแบบ  Web Site  จึงมีส่วนสำคัญในการสร้างความประทับใจให้กับผู้ใช้บริการ และทำให้อยากกลับเข้ามาใช้อีกในอนาคต และนอกจากจะต้องพัฒนา Web ให้ดีและมีประโยชน์แล้ว ยังต้องแข่งขันกับ Web Site อื่นที่ให้บริการเช่นเดียวกับ Web ของในปัจจุบัน และยังต้องสร้างความได้เปรียบเหนือ Web Site ใหม่ที่กำลังจะมาแรงและเกิดขึ้นในอนาคตอีกด้วย ดังนั้นไม่ว่า Web ของจะมีคู่แข่งอยู่แล้วหรือไม่ในวันนี้ ก็ควรจะออกแบบ Web อย่างมีคุณภาพ เพื่อดึงดูดผู้ใช้ให้อยู่กับ Web ของไปตลอด
สร้างความได้เปรียบเหนือคู่แข่ง

สำหรับ Web ทางธุรกิจยิ่งจำเป็นต้องให้ความสำคัญกับการออกแบบมากขึ้น เนื่องจากพฤติกรรมการใช้จ่ายบน Web นั้นมีลักษณะไม่เหมือนกับการซื้อขายทั่วไปที่คุ้นเคย ลูกค้าสามารถเข้าไปใน Web Site หลาย ๆ แห่งพร้อมกันเพื่อเปรียบเทียบหาสินค้าแลบริการที่ดีที่สุดเท่าที่จะหาได้ โดยไม่ต้องเกรงใจผู้ขายเหมือนกับในร้านจริง และยังไม่มีข้อได้เปรียบเสียเปรียบในเรื่องทำเลที่ตั้ง ทุกร้านค้าบน Web จึงถือได้ว่าอยู่ในที่เดียวกันโดยไม่มีความแตกต่างของระยะทาง ไม่ว่า Web นั้นจะอยู่ภายในหรือนอกประเทศผู้ใช้ก็สามารถไปถึงได้ด้วยการกรอกชื่อของ Web Site ลงไปเท่านั้น

คงจะห้ามกันไม่ได้ถ้าผู้ใช้จะประเมินค่าของหน่วยงานหรือบริษัทตามลักษณะของ Web Site ที่ได้สัมผัส และมักจะเป็นสิ่งที่เกิดขึ้นบ่อยเสียด้วย จึงเป็นช่องทางที่ร้านค้าขนาดเล็กสามารถออกแบบให้ Web Site มีความยิ่งใหญ่และน่าเชื่อถือได้มากกว่าร้านค้าขนาดใหญ่ก็เป็นได้ ถ้ามีความรู้และความเข้าใจที่ถูกต้องเนื่องจากต้นทุนในการสร้าง Web Site นั้นต่ำมาก เมื่อเทียบกับการเปิดร้านตามศูนย์การค้าต่าง ๆ และยังสามารถรองรับลูกค้าได้จากทุกแห่งทั่วโลก โดยที่ผลประโยชน์ที่ได้รับจาก Web Site นั้นอาจมีค่ามหาศาลเกินกว่าที่จะคาดคิด ดังนั้น Web Site ของจึงไม่ควรยอมให้มีการออกแบบที่ดูน่าเชื่อถือน้อยกว่าคู่แข่ง ซึ่งจะทำให้พลาดโอกาสทางธุรกิจไปได้อย่างน่าเสียดาย
การออกแบบ Web Site ที่ดี

ก่อนอื่นต้องขอทำความเข้าใจให้ตรงกันก่อนว่า การออกแบบ Web Site นั้นไม่ได้หมายถึงลักษณะน่าตาของ Web Site เพียงอย่างเดียว แต่เกี่ยวข้องกับการเริ่มต้นกำหนดเป้าหมายของ Web Site  , ระบุกลุ่มผู้ใช้ , การจัดระบบข้อมูล , การสร้างระบบ Navigation , การออกแบบหน้าWeb , รวมไปถึงการใช้ Graphic , การเลือกใช้สี การจัดรูปแบบตัวอักษร นอกจากนั้นยังต้องคำนึงถึงความแตกต่างของสื่อกลางในการแสดงผล Web Site นั้นด้วย สิ่งเหล่านี้ได้แก่ ชนิดและรุ่นของ Browser ขนาดของหน้าจอมอนิเตอร์ ความละเอียดของสี รวมไปถึง Plug-in ชนิดต่าง ๆ ที่ผู้ใช้มีอยู่ เพื่อให้ผู้ใช้เกิดความสะดวกและความพอใจที่จะท่องไปใน Web Site นั้น ดังนั้นทุกสิ่งทุกอย่างใน Web Site ที่มองเห็นและมองไม่เห็นล้วนเป็นผลมาจากกระบวนการออกแบบ Web Site ทั้งสิ้น

 Web Site ที่ดูสวยงามหรือมีลูกเล่นมากมายนั้น อาจจะไม่นับเป็นการออกแบบที่ดีก็ได้ ถ้าความสวยงามและลูกเล่นเหล่านั้นไม่เหมาะสมกับลักษณะของ Web Site  ด้วยเหตุนี้จึงเป็นเรื่องยากที่จะระบุว่าการออกแบบ Web Site ที่ดีนั้นควรเป็นอย่างไร เนื่องจากไม่มีหลักเกณฑ์ที่แน่นอนที่จะใช้ได้กับทุก Web Site  แนวทางการออกแบบบางอย่างที่เหมาะสมกับ Web Site หนึ่งอาจไม่เหมาะกับอีก Web Site หนึ่งก็ได้ ทำให้แนวทางในการออกแบบของแต่ละ Web Site นั้นแตกต่างกันไปตามเป้าหมายและลักษณะของ Web Site นั้น  Web Site บางแห่งอาจต้องการความสนุกสนาน บันเทิง ขณะที่ Web อื่นกลับต้องการความถูกต้อง ความน่าเชื่อถือเป็นหลัก ดังนั้นอาจสรุปได้ว่าการออกแบบที่ดีคือ การออกแบบให้เหมาะสมกับเป้าหมายและลักษณะของ Web Site  โดยคำนึงถึงความสะดวกในการใช้งานของผู้ใช้เป็นหลัก
องค์ประกอบของการออกแบบ Web Site อย่างมีประสิทธิภาพ
ความเรียบง่าย (Simplicity)


ถ้าลองสำรวจ Web Site ของบริษัทใหญ่ ๆ เช่น Adobe , Apple , IBM จะพบว่าWebของบริษัทเหล่านั้นมีรูปแบบที่เรียบง่าย ไม่ซับซ้อน และใช้งานได้อย่างสะดวก แม้ว่าจะมีข้อมูลใน Web Site นั้นอยู่มากมาย แต่แทบไม่มีโอกาสเห็น Graphic หรือตัวอักษรที่เคลื่อนไหวอยู่ตลอดเวลา ซึ่งจะรบกวนสายตาและสร้างความรำคาญให้แก่ผู้ใช้ ( การใช้ภาพเคลื่อนไหว (Animation ) จะดูหวือหวาและน่าในใจในตอนแรก แต่เมื่อดูบ่อยเข้าและ ตลอดเวลาผู้ใช้จะเริ่มรู้สึกรำคาญได้ ) นอกจากนั้นยังใช้ชนิดและสีของตัวอักษรไม่มากจนเกินไปจนเกิดความสับสน ในส่วนตัวเนื้อหาก็จะใช้ตัวอักษรสีดำบนพื้นสีขาวตามปกติ และไม่มีการเปลี่ยนสีของ Link ให้ลับสนแต่อย่างใด สรูปว่าหลักสำคัญของความเรียบง่ายก็คือ การสื่อเนื้อหาถึงผู้ใช้โดยจำกัดองค์ประกอบเสริมที่เกี่ยวข้องกับการนำเสนอให้เหลือเฉพาะสิ่งที่จำเป็นเท่านั้น
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ความสม่ำเสมอ (Consistency)


สามารถสร้างความสม่ำเสมอให้กับ Web Site นั้นได้ โดยใช้รูปแบบเดียวกันตลอดทั้ง Web Site เนื่องจากผู้ใช้จะรู้สึกเหมือนกับว่า  Web Site นั้นเหมือนสถานที่จริง ถ้าลักษณะของแต่ละหน้าใน Web เดียวกันนั้นแตกต่างกันมาก ผู้ใช้จะเกิดความสับสนและไม่แน่ใจว่ากำลังอยู่ใน Web เดิมหรือไม่ ดังนั้นรูปแบบของหน้า ระบบ Navigation และโทนสีที่ใช้ควรมีความคล้ายคลึงกันตลอดทั้ง Web Site 

ความเป็นเอกลักษณ์ (Identity)

การออกแบบต้องคำนึงถึงลักษณะขององค์กร เนื่องจากรูปแบบของ Web Site สามารถสะท้อนถึงเอกลักษณ์และลักษณะขององค์กรนั้นได้  Web Site ของธนาคารจึงไม่ควรดูเหมือนกับสวนสนุก การใช้ชุดสี ชนิดตัวอักษร รูปภาพ Graphic จะมีผลต่อรูปแบบของ Web Site อย่างมาก ผู้ออกแบบจึงต้องเลือกใช้องค์ประกอบเหล่านี้อย่างเหมาะสม
เนื้อหาที่มีประโยชน์ (Useful Content)

เนื้อหาถือเป็นสิ่งที่สำคัญที่สุดใน Web Site  ดังนั้นใน Web Site ควรจัดเตรียมเนื้อหาและข้อมูลที่ผู้ใช้ต้องการให้ถูกต้องและสมบูรณ์ โดยมีการปรับปรุงและเพิ่มเติมให้ทันต่อเหตุการณ์อยู่เสมอ เนื้อหาที่สำคัญที่สุดคือ เนื้อหาที่สร้างขึ้นมาเองและไม่ซ้ำกับ Web อื่น ๆ เพราะจะเป็นสิ่งที่ดึงดูดผู้ใช้ให้เข้ามาใน Web Site อยู่เสมอ ต่างจากที่ Link ไป Web Site อื่น ซึ่งเมื่อผู้ใช้รู้ถึงแหล่งข้อมูลจริง ๆ แล้วก็ไม่จำเป็นต้องกลับมาที่ Link เหล่านั้นอีก
ระบบ Navigationที่ใช้งานง่าย (User-Friendly-Navigation)


ระบบ Navigation เป็นองค์ประกอบที่สำคัญมากของ Web Site  จะออกแบบให้ผู้ใช้เข้าใจได้ง่ายและใช้งานสะดวก โดยใช้ Graphic ที่สื่อความหมายร่วมกับคำอธิบายที่ชัดเจน รวมทั้งมีรูปแบบและลำดับของรายการที่สม่ำเสมอ เช่นวางไว้ในตำแหน่งเดียวกันของทุก ๆ หน้า นอกจากนั้นถ้าใช้ระบบ Navigation แบบGraphic ในส่วนของหน้าแล้ว อาจเพิ่มระบบ Navigation ที่เป็นตัวอักษรไว้ตอนท้ายของหน้า เพื่อช่วยอำนวยความสะดวกกับผู้ที่สั่งBrowserไม่ให้แสดงผลรูป Graphic เพื่อความสะดวกรวดเร็วในการดู
มีลักษณะที่น่าสนใจ (Visual Appeal)


เป็นเรื่องที่ยากที่จะตัดสินใจว่า ลักษณะหน้าตาของ Web Site แห่งใดแห่งหนึ่งนั้นน่าสนใจหรือไม่ เพราะเกี่ยวข้องกับความชอบของแต่ละบุคคล อย่างไรก็ดีหน้าตามของ Web Site จะมีความสัมพันธ์กับคุณภาพขององค์ประกอบต่าง ๆ เช่น คุณภาพของ Graphic ที่จะต้องสมบูรณ์ ไม่มีร่องรอยความเสียหายเป็นจุดด่างหรือมีขอบเป็นบันไดให้เห็น การใช้ชนิดตัวอักษรที่อ่านง่าย สบายตา และการใช้โทนสีที่เข้ากันได้อย่างสวยงาม เป็นต้น
การใช้งานได้อย่างไม่จำกัด (Compatible)


ในการออกแบบ Web Site นั้น จะต้องออกแบบให้คนส่วนใหญ่เข้าถึงได้มากที่สุด โดยไม่มีการบังคับให้ผู้ใช้ต้องติดตั้งโปรแกรมใด ๆ เพิ่มเติม หรือต้องเลือกใช้ Browser ชนิดใดชนิดหนึ่งจึงจะสามารถเข้าถึงเนื้อหาได้ สามารถแสดงผลได้ในทุกระบบปฏิบัติการและที่ความละเอียดหน้าจอต่าง ๆ กันได้อย่างไม่มีปัญหา สิ่งเหล่านี้จะมีความสำคัญมากขึ้น สำหรับ Webที่มีผู้ใช้บริการจำนวนมาก หรือมีกลุ่มเป้าหมายที่หลากหลาย
คุณภาพการออกแบบ (Design Stability) 


ถ้าอยากให้ผู้ใช้รู้สึกว่า Web ของมีคุณภาพถูกต้อง และเชื่อถือได้ ก็ควรให้ความสำคัญกับการออกแบบ Web Site เป็นอย่างมาก เช่นเดียวกันกับสื่อประเภทอื่น ๆ ที่ต้องออกแบบและเรียบเรียงเนื้อหาอย่างรอบคอบ Web ที่ทำขึ้นมาอย่างลวก ๆ ไม่ได้มาตรฐานการออกแบบและการจัดระบบข้อมูลนั้น เมื่อมีข้อมูลเพิ่มมากขึ้นเรื่อย ๆ ก็จะเกิดปัญหาและไม่สามารถสร้างความน่าเชื่อถือได้
ระบบการใช้งานที่ถูกต้อง (Functional Stability)


ระบบการทำงานต่าง ๆ ใน Web Site จะต้องมีความแน่นอนและทำหน้าที่ได้อย่างถูกต้อง ตัวอย่างเช่น ถ้ามีแบบฟอร์มให้ผู้ใช้กรอกข้อมูล ก็ต้องแน่ใจว่าฟอร์มนั้นสามารถใช้งานได้จริง หรืออย่างง่ายที่สุดก็คือ Linkต่าง ๆ ที่มีอยู่นั้นต้องเชื่อมโยงไปยังหน้าที่มีปรากฏอยู่จริงและถูกต้องด้วย ความรับผิดชอบแรกของคือการทำให้ระบบเหล่านั้นใช้งานได้จริงตั้งแต่หน้าแรกและยังคงต้องคอยตรวจเช็คอยู่เสมอเพื่อให้แน่ใจว่าสิ่งเหล่านั้นยังทำงานได้ดี โดยเฉพาะหน้าที่ Link เชื่อมไปยัง Web อื่นที่อาจมีการเปลี่ยนแปลงได้ตลอดเวลา โดยที่ไม่รู้เรื่อง
โปรแกรมที่นิยมใช้ในการออกแบบ Web Site 


โปรแกรมที่นิยมใช้ในการออกแบบหน้าWebให้มีความสวยงามนั้น มีอยู่มากมายหลายโปรแกรม แต่โปรแกรมที่มีคนนิยมใช้งานการออกแบบ Web มากที่สุด ก็คงหนีไม่พ้นโปรแกรม Photoshop ของค่าย Abobe ซึ่งตอนนี้ออกมาถึงเวอร์ชั่น 7 แล้ว โปรแกรม Photoshop นั้นเป็นโปรแกรมที่รูปแบบที่เรียกว่า Raster ซึ่งเป็นการนำจุดสีหลาย ๆ จุดมารวมตัวกันจนเกิดเป็นภาพขึ้น ซึ่งผลที่ได้ก็คือทำให้ภาพมีรายละเอียดสวยงาม จึงเหมาะสมในการนำโปรแกรมตัวนี้มาทำงานในการตกแต่งภาพ  สามารถนำไปประยุกต์ใช้ทำงานได้หลายชนิด ไม่ว่าจะเป็นการออกแบบ Graphic  สิ่งพิมพ์ ในการทำปกหนังสือ , โปสเตอร์ , แผ่นพับ , ออกแบบปกเทป ปกซีดี ,งานGraphic โทรทัศน์ รวมไปถึงงานออกแบบหน้า Web ซึ่ง Photoshop ตั้งแต่เวอร์ชั่น 5.5 เป็นต้นมา ก็ได้ใส่คำสั่งและอุปกรณ์ในส่วนที่เกี่ยวข้องกับการออกแบบ Web Site มามากมาย    ที่ทำให้นักออกแบบ Web Site สามารถทำงานได้ง่ายและสะดวกมากขึ้น ซึ่งจะกล่าวถึงรายละเอียดในบทที่ 2 ต่อไป

นอกจากโปรแกรม Photoshop แล้วยังมีอีกหลายโปรแกรมที่สามารถใช้ในการออกแบบ Web Site ได้ และก็เป็นที่นิยมกันทั่วไป เช่น Macromedia Firework 4 , Adobe Illustrator 10 เป็นต้น 
รูปแบบของไฟล์ Graphic บน Web Site 


รูปแบบ Graphic หมายถึง รูปแบบมาตรฐานของรูปภาพซึ่งได้รับการรับรองความเป็นมาตรฐานของแต่ละหน่วยงานที่คิดค้นวิธีการบันทึกและแสดงภาพเหล่านั้นขึ้นมา รูปแบบของรูปภาพที่สามารถนำมาใช้บน 
Web Page ได้นั้น มีอยู่ 2 ชนิด แต่เนื่องด้วยทั้ง 2 ชนิดนี้มีจุดเด่นที่แตกต่างกัน และจำเป็นต้องใช้ทั้ง 2 ชนิดนี้ควบคู่กันไป ไม่สามารถเลือกเฉพาะแบบใดแบบหนึ่งมาใช้งานได้ ซึ่ง Graphic ทั้ง 2 ชนิดนี้ก็คือ GIF และ JPG 

GIF (Graphic Interchange Format)

เป็นรูปแบบของไฟล์รูปภาพที่ถูกพัฒนาโดยบริษัท CompuServe ในช่วง 1980s และปรับปรุงเรื่อยมาจนถึงปัจจุบัน Gif มีความแตกต่างของสีต่อจุดได้ 256 สี (8 BIT) ซึ่งใช้หลักการในการ Map สีต่าง ๆ ที่มีอยู่ใน

ตารางสี (Palette) ด้วยจำนวนสีเพียงเท่านี้และใช้เทคโนโลยีในการ Map สีต่าง ๆ ก็สามารถทำให้แยกแยะความแตกต่างในสิ่งต่าง ๆ บนรูปภาพได้ดีพอสมควร

อย่างไรก็ตาม เสน่ห์ของการใช้รูปภาพแบบ GIF ก็ยังคงมีอยู่มากพอตัวทีเดียว หลังจากที่มีการปรับปรุงคุณภาพของรูปแบบมาอย่างต่อเนื่อง จึงทำให้รูปภาพไฟล์แบบ Gif มีความสามารถในการทำงานต่าง ๆ ได้คือ
การบีบอัดไฟล์ GIF (GIF File Compression)


มีหลายคนยังเข้าใจผิดอยู่ว่า ไฟล์รูปภาพแบบ GIF ไม่สามารถที่จะทำการบีบอัดข้อมูลได้เช่นเดียวกับรูปแบบอื่น ๆ ในปัจจุบันไฟล์รูปภาพ เสียง และวิดีโอ มักจะมีการบีบอัดข้อมูลกันทั้งนั้น แล้วแต่ว่าจะเลือกวิธีการบีบอัดข้อมูลแบบใด ข้อดีของการบีบอัดคือทำให้ไฟล์มีขนาดเล็กลง แต่ข้อเสียคือคุณภาพของภาพเหล่านั้นก็จะลดลงเป็นเงาตามตัวไปด้วย วิธีการบีบอัดข้อมูลของ GIF จะใช้หลักการของ Lempel Zev Welch (LZW) ซึ่งเป็นวิธีการบีบอัดข้อมูลที่มีประสิทธิภาพดีที่สุดสำหรับภาพที่มีสีซ้ำกันมาก ๆ แต่จะไม่เหมาะกับภาพที่มีสีหลากหลาย

Transparent Gif


ภาพที่มีลักษณะเป็น Transparent หมายถึงภาพที่มีส่วนใดส่วนหนึ่งจะสามารถมองทะลุไปยังเบื้องหลังของภาพนั้นได้ (ไม่มี Background) รูปภาพโดยทั่ว ๆ ไปจะไม่มีคุณสมบัติเหล่านี้อยู่ รูปแบบของ GIF นั้นมีอยู่หลายรูปแบบด้วยกัน เช่น GIF87a และ GIF89a หากต้องการจะทำให้ภาพเป็น Transparent จะต้องเลือกบันทึกข้อมูลให้เป็นแบบ GIF89a การทำให้ภาพเป็น Transparent จะทำให้ผู้ที่ชมภาพรู้สึกในการมองภาพในWeb เป็นธรรมชาติมากขึ้น เพราะขอบภาพที่เป็นรอยหยักจะถูกกำจัดออกไป เหลือเอาไว้แต่ภาพจริง ๆ เท่านั้น

Interlaced และ Non-Interlaced GIF


หากเข้าไปสำรวจใน Web Site อื่น ๆ บ่อยครั้ง จะพบว่าในการแสดงรูปภาพของ Web Browserอาจไม่เหมือนกันในแต่ละภาพ เช่นการเริ่มแสดงภาพทีละบรรทัดจากด้านบนสู่ด้านล่าง ทำอย่างนี้ไปเรื่อย ๆ จนได้ภาพทั้งหมด วิธีการอ่านข้อมูลแบบนั้นเนื่องมาจากการบันทึกภาพนั้นให้เป็นแบบ Non-Interlaced GIF หรือ Standard GIF


หากแต่ Web Browser มีการแสดงภาพขึ้นมาทั้งหมดในครั้งเดียว แต่ภาพยังยังไม่ชัดเจน แล้วค่อย ๆ มีการปรับภาพนั้นให้ชัดขึ้นไปเรื่อย ๆ ในแต่ละครั้ง จนกระทั่งเมื่อหยุดการทำงานในการดาวน์โหลดข้อมูลทั้งหมดแล้ว รูปภาพจึงจะชัดเจนทั้งหมด นั้นคือรูปแบบของ Interlaced GIF

การบีบอัดไฟล์ JPEG (JPEG File Compression)


การบีบอัดข้อมูลของรูปแบบนี้จะใช้หลักการทางคณิตศาสตร์ที่มีประสิทธิภาพสูงมาก ๆ เทคนิคในการคำนวณถูกเรียกว่า Discrete Cosine Transformation ซึ่งสามารถตั้งระดับของการบีบอัดข้อมูลได้ตามต้องการ แน่นอนว่าการบีบอัดข้อมูลมีอัตราส่วนมากเท่าไหร่ คุณภาพในการแสดงผลของภาพนั้นจะลดลงไปด้วย การบีบอัดข้อมูลของรูปแบบนี้จะสามารถลดขนาดไฟล์จากขนาดจริงได้มากถึง 100 เท่า
โปรแกรมช่วยในการสร้าง Web


ในปัจจุบันนี้มีโปรแกรมที่ช่วยในการสร้าง Web มากมายให้เลือกใช้ ทั้งที่เป็น Shareware แจกฟรีและที่เป็นโปรแกรมสำเร็จรูปราคาแพง ที่ได้ยินกันบ่อย ๆ ได้แก่ Coffee Cup , Dreamweaver , FrontPage , Golive , HomeSite เป็นต้น ซึ่งโปรแกรมเหล่านี้มีประโยชน์อย่างมากที่จะช่วยให้พัฒนา Web Site ได้อย่างสะดวกรวดเร็ว โดยที่ไม่จำเป็นต้องรู้ภาษา HTML เลย

แต่ในที่นี้จะขอแนะนำโปรแกรมยอดนิยม 3 ตัว เพื่อเป็นข้อมูลในการเลือกใช้ให้เหมาะสม
1. Adobe Golive 6.0

โปรแกรม Adobe Golive เป็นโปรแกรมที่มาจากค่าย Adobe ซึ่งเป็นค่ายเดียวกันกับโปรแกรมออกแบบ Graphic ชื่อดังคือ Photoshop ประสิทธิภาพของตัว Golive โดยเฉพาะในเวอร์ชั่นล่าสุดคือ 6.0 นั้นถือว่าสูงมาก มีเครื่องมือต่าง ๆ ที่ใช้ในการสร้างหน้า Web ได้อย่างครบคRun สร้าง Web  ได้ตั้งแต่ระดับพื้นฐานไปจนถึงระดับสูง สามารถนำข้อความต่าง ๆ ตลอดจนรูปภาพไปวางตรงส่วนไหนของหน้า Web ก็ได้ตามต้องการ โดยไม่จำเป็นต้องใส่ Layer เหมือนในโปรแกรมตัวอื่น ๆ ซึ่งจุดเด่นในข้อนี้ทำให้ Golive เป็นที่นิยมใช้กันมากในต่างประเทศ นอกจากนี้ยังมีลูกเล่นที่เป็น Dynamic Script และ Java Script มากมาย โดยที่ผู้ใช้งานไม่จำเป็นต้องมีความรู้ทางด้านภาษา HTML หรือ Java Script แต่อย่างใดหรือผู้ใช้ที่เป็นโปรแกรมเมอร์ก็สามารถพัฒนาและปรับปรุงแก้ไข script ได้ด้วยตนเองโดยผ่านทางหน้า HTML Code Editor  สำหรับทางด้านเทคโนโลยีบนโทรศัพท์มือถือ Golive ก็ได้เตรียมอุปกรณ์ที่ใช้สร้าง WAP สำหรับใช้บนโทรศัพท์มือถือ รวมไปถึงเทคโนโลยีระบบ I-mode ที่เป็นสุดยอดการใช้อินเทอร์เน็ตมือถือของประเทศญี่ปุ่น ก็สามารถสร้างโดยโปรแกรม Golive ได้
2. Macromedia Dreamweaver

Dreamweaver เป็นโปรแกรมจากค่าย Macromedia เจ้าของโปรแกรม Flash MX อันลือลั่น และถือว่าเป็นคู่แข่งตลอดกาลของ Abode Golive สำหรับ Dreamweaver นั้น ผู้ออกแบบสามารถออกแบบหน้า Web ได้อย่างสะดวกโดยอาศัยเครื่องมือต่าง ๆ ในส่วนของ Design View ทำให้ผู้ใช้ออกแบบหน้า Web โดยไม่จำเป็นต้องรู้ภาษา HTML และถ้าผู้ใช้ต้องการแก้ไข Code ก็สามารถแก้ไขได้โดยผ่านทางหน้า Code View นอกเหนือจากนี้ยังมีระบบ Template ที่ทำให้ผู้ออกแบบสามารถใช้โครงสร้างของหน้า Web เพียงแบบเดียวกันกับเนื้อหาในทุก ๆ หน้าของ Web Site ได้ ซึ่งจะช่วยเพิ่มความสะดวกทั้งในขั้นตอนการปรับปรุงพัฒนาและการแก้ไขอย่างมาก แต่ทางด้าน Dynamic Script หรือพวก Action Script ที่โปรแกรมให้มายังน้อยเกินไป
3. Microsoft FrontPage

FrontPage เป็นโปรแกรมที่ช่วยสร้าง Web Site ที่มีเนื้อหาอยู่ในรูปแบบของ โปรแกรม Microsoft Office โดยสามารถเปลี่ยนไฟล์เอกสารที่เป็น Word , PowerPoint ,Excel ให้เป็น ไฟล์ HTML ได้อย่างง่ายดาย ซึ่งเป็นที่นิยมในหมู่ผู้เริ่มต้นทั้งหลาย มี Wizard ช่วยในการออกแบบ Web Site โดยไม่ต้องยุ่งกับภาษา HTML โปรแกรมนี้จึงเป็นเครื่องมือที่ช่วยผู้ออกแบบระดับต้นและระดับกลางสามารถออกแบบ Web Site ได้อย่างสะดวกรวดเร็ว โปรแกรมตัวนี้มีจุดเด่นในเรื่องของการบริหารจัดการ Web Site  โดยมีระบบรายงานเกี่ยวกับหน้า  WebPage ที่แสดงผลช้า WebPage ที่ถูกเพิ่มเข้าไป Link ที่ใช้งานไม่ได้ นอกจากนี้ยังสามารถเชื่อมโยงกับระบบฐานข้อมูลได้อย่างสะดวกอีกด้วย ส่วนข้อเสียก็คือการแทรกคำสั่งเพิ่มเติมเฉพาะของโปรแกรมเข้ามาโดยไม่จำเป็น หรืออาจมีการเปลี่ยนแปลง Code ของโดยไม่รู้ตัว
การเลือกใช้สีสำหรับ Web Site  (Designing Web Color)


สีสันในหน้า WebPage เป็นสิ่งที่มีความสำคัญมากในการดึงดูดความสนใจของผู้ใช้ เนื่องจากสิ่งแรกที่ผู้ใช้มองเห็นจาก WebPage ก็คือสี ซึ่งเป็นสิ่งกำหนดบรรยากาศและความรู้สึกโดยรวมของ Web Site  สามารถใช้สีได้กับทุกองค์ประกอบของ WebPage  ตั้งแต่ตัวอักษร , รูปภาพ, Link, สีพื้นหลัง หรือรูปภาพพื้นหลัง การเลือกใช้สีอย่างเหมาะสมจะช่วยสื่อความหมายของเนื้อหา และเพิ่มความสวยงามให้กับหน้า Web นั้น แต่ในทางกลับกัน สีที่ไม่เหมาะสมอาจสร้างความยากลำบากในการอ่านหรือรบกวนสายตาผู้ใช้รวมอาจทำให้การสื่อความหมายไม่ถูกต้องก็ได้

เรื่องของสีใน Web Site มีความซับซ้อนพอสมควร เริ่มตั้งแต่การเข้าใจถึงการแสดงออกของสีภายใต้สิ่งแวดล้อมที่ต่างกันของ Browser , จอมอนิเตอร์ และระบบปฏิบัติการ ตลอดจนมีความเข้าใจในทฤษฎีสี รู้จักการเลือกใช้สีที่เหมาะสมเพื่อการสื่อความหมายอย่างสวยงาม ดังนั้น ความหมายของคือการตัดสินใจเลือกใช้สีให้เหมาะสมกับบุคคลและเป้าหมายของ Web Site  เพื่อการแสดงผลที่ตรงกับความประสงค์มากที่สุด การใช้ชุดสีที่เหมาะสม กลมกลืน ไม่เพียงแต่จะสร้างความพึงพอใจให้กับผู้ใช้ แต่ยังทำให้พวกเขามีความรู้สึกร่วมไปกับเป้าหมายของ Web Site นั้นด้วย ไม่ว่าจะเป็นการให้ข้อมูล สร้างความบันเทิง รวมถึงการขายสินค้าหรือบริการ
ประโยชน์ของสีใน Web Site 


สีเป็นเครื่องมืออเนกประสงค์อย่างหนึ่งที่มีความสำคัญมากในการออกแบบ Web Site  เนื่องจากสีสามารถสื่อถึงความรู้สึกและอารมณ์ และช่วยสร้างความสัมพันธ์ระหว่างสถานที่กับเวลาอีกด้วย ดังนั้นสีจึงเป็นปัจจัยสำคัญอย่างหนึ่งที่จะช่วยเสริมสร้างความหมายขององค์ประกอบให้กับ WebPage ได้เป็นอย่างดี

1. สีสามารถชักนำสายตาผู้อ่านไปยังทุกบริเวณให้หน้า WebPage ผู้อ่านจะมีการเชื่อมโยงความรู้สึกกับบริเวณของสีในรูปแบบที่คาดหวังไว้ได้ การเลือกเฉดสีและตำแหน่งของสีอย่างรอบคอบในหน้า Web สามารถนำทางให้ผู้อ่านติดตามเนื้อหาบริเวณต่าง ๆ ตามที่กำหนดไว้ได้ วิธีนี้จะเป็นประโยชน์อย่างมากเมื่อต้องการให้ผู้อ่านให้ความสนใจกับส่วนใดส่วนหนึ่งใน Web Site เป็นพิเศษ เช่น ข้อมูลใหม่ โปรโมชั่นพิเศษ หรือบริเวณที่ไม่ค่อยได้รับความสนใจมาก่อน

2. สีช่วยเชื่อมโยงบริเวณที่ได้รับการออกแบบเข้าด้วยกัน ผู้อ่านจะมีความรู้สึกว่าบริเวณที่มีสีเดียวกันจะมีความสำคัญเท่ากัน วิธีการเชื่อมโยงแบบนี้ช่วยจัดกลุ่มของข้อมูลที่มีความสัมพันธ์อย่างไม่เด่นชัดเข้าด้วยกันได้
3. สีสามารถนำไปใช้ในการแบ่งบริเวณต่าง ๆ ออกจากกัน ทำนองเดียวกับการเชื่อมโยงบริเวณที่มีสีเหมือนกันเข้าด้วยกัน แต่ในขณะเดียวกันก็เป็นการแบ่งแยกบริเวณที่มีสีต่างกันออกจากกัน
4. สีสามารถดึงดูดความสนใจของผู้อ่าน สายตาของผู้อ่านมักจะมองไปที่สีที่มีลักษณะเด่นหรือผิดปกติเสมอ การออกแบบ Web Site ด้วยการเลือกใช้สีอย่างรอบคอบ ไม่เพียงแต่กระตุ้นความสนใจของผู้อ่านเพียงเท่านั้น แต่ยังช่วยหน่วงเหนี่ยวให้พวกเขาอยู่ใน Web Site ได้นานยิ่งขึ้น ส่วน Web Site ที่ใช้สีไม่เหมาะสม เสมือนเป็นการขับไล่ผู้ชมไปสู่ Web อื่นที่มีการออกแบบที่ดีกว่า
5. สีสามารถสร้างอารมณ์โดยรวมของ WebPage และกระตุ้นความรู้สึกตอบสนองจากผู้ชมได้ นอกเหนือจากความรู้สึกที่ได้รับจากสีตามหลักจิตวิทยาแล้ว ผู้ชมยังอาจมีอารมณ์และความรู้สึกสัมพันธ์กับสีบางสีหรือบางกลุ่มเป็นพิเศษ
6. สีสามารถช่วยสร้างระเบียบให้กับข้อความต่าง ๆ เช่นการใช้สีแยกส่วนระหว่างหัวเรื่องกับตัวเรื่อง หรือการสร้างความแตกต่างให้กับข้อความบางส่วน โดยที่ใช้สีแดงสำหรับคำเตือน หรือใช้สีเทาสำหรับสิ่งที่เป็นทางเลือก
7. นอกเหนือจากการใช้สีในการออกแบบแล้ว สียังสามารถส่งเสริมเอกลักษณ์ขององค์กรหรือหน่วยงาน ๆ นั้นได้ ด้วยการใช้สีที่เป็นเอกลักษณ์ขององค์กรมาเป็นโทนสีหลักของ Web Site 

การออกแบบเกี่ยวกับสีไม่ใช่เรื่องง่าย แม้ว่าจะมีกฎเกณฑ์ต่าง ๆ ที่จะช่วยในการสร้างชุดสี ที่มีประโยชน์มากมาย แต่ก็มีแนวทางและความเข้าใจผิดจำนวนมากที่จะนำไปสู่การสร้างชุดสีที่ให้ความรู้สึกไม่เหมาะสม ในบางสถานการณ์อาจใช้สีเป็นเพียงเครื่องประดับอย่างหนึ่งในการออกแบบ แต่ในทางตรงกันข้าม การใช้สีที่มากเกินไปอาจทำให้ไปบดบังองค์ประกอบอื่น ๆ ในหน้า WebPage ได้ ดังนั้นการเลือกใช้สีให้เหมาะสมและเกิดประโยชน์จึงเป็นเรื่องที่สำคัญ แม้ว่าการเลือกชุดของสีมามาใช้ใน WebPage ค่อนข้างจะขึ้นอยู่กับความชอบของแต่ละคน อย่างน้อยควรมีความเข้าใจถึงหลักการใช้สีเบื้องต้น ที่จะช่วยในการเลือกใช้สีชุดใดชุดหนึ่งจากชุดสีพื้นฐานอื่น ๆ ได้ อย่างเหมาะสมกับลักษณะของ Web Site  อย่างไรก็ตามทฤษฎีเหล่านี้จะไม่ทำให้สามารถเลือกชุดสีได้ในทันทีทันใด แต่อย่างน้อยก็จะช่วยนำไปในทิศทางที่ถูกต้องได้
รูปแบบชุดสีพื้นฐาน (Simple Color Schemes)

1. ชุดสีร้อน (Warm Color Schemes) 

ชุดสีร้อนประกอบด้วยสีม่วงแกมแดง , แดง, ส้ม เหลือง และเขียวอมเหลือง สีเหล่านี้สร้างความรู้สึกอบอุ่นสบายและความรู้สึกต้อนรับแก่ผู้ชม ช่วยดึงดูดความสนใจได้ง่าย ในทางจิตวิทยาสีร้อนมีความสัมพันธ์กับความสุข สะดวกสบาย สีต่าง ๆ ในชุดสีร้อนมีความกลมกลืนอยู่ในตัวเองขณะที่อาจดูไม่น่าสนใจบ้าง เพราะขาดสีประกอบที่ตัดกันอย่างชัดเจน
2. ชุดสีเย็น (Cool Color Scheme)

ชุดสีเย็นประกอบด้วยสีม่วง , น้ำเงิน, น้ำเงินอ่อน, ฟ้า, น้ำเงินแกมเขียว และสีเขียว ตรงกันข้ามกับชุดสีร้อน ชุดสีเย็นจะให้ความรู้สึกสบาย องค์ประกอบที่ใช้ชุดสีเย็นเหล่านี้จะดูสุภาพเรียบร้อย และมีความชำนาญแต่ในทางจิตวิทยา สีเย็นเหล่านี้กลับมีความสัมพันธ์กับความซึมเศร้าหดหู่เสียใจ นอกจากนั้น ชุดสีเย็นมีความกลมกลืนโดยธรรมชาติ แต่อาจจะดูไม่น่าสนใจในบางครั้งเพราะขาดความแตกต่างของสีที่เด่นชัด เช่นเดียวกับชุดสีร้อน
3. ชุดสีแบบสีเดียว (Monochromatic Color Scheme)

รูปแบบของชุดสีที่ง่ายที่สุดก็คือชุดสีแบบสีเดียวที่มีค่าสีบริสุทธิ์เพียงสีเดียว ความหลากหลายของชุดสีนี้เกิดจากการเพิ่มความเข้มหรือความอ่อนในระดับต่าง ๆ ให้กับสีตั้งต้น ดังนั้น ชุดสีแบบเดียวกับสีแดงอาจประกอบด้วยสีแดงล้วน , สีแดงอิฐ, สีสตรอเบอรี่, สีชมพู ชุดสีแบบนี้ค่อนข้างมีความกลมกลืนเป็นหนึ่งเดียวกัน และมีประสิทธิภาพในการสร้างอารมณ์โดยรวมด้วยการใช้สีเพียงสีเดียว แต่ในบางครั้งรูปแบบที่มีสีเดียวนี้อาจดูไม่มีชีวิตชีวา เพราะขาดความหลากหลายของสี ซึ่งอาจทำให้ผู้อ่านขาดความสนใจ
4. ชุดสีแบบสามเส้า (Triadic Color Scheme)
วิธีการง่าย ๆ อีกแบบหนึ่งในการเลือกชุดสีมาใช้ก็คือ การนึกถึงสามเหลี่ยมด้านเท่าลอยอยู่เหนือวงล้อสี เช่น แดง, เขียว, น้ำเงิน จะเห็นว่าสีทั้งสามสีนี้มีการตัดกันอย่างรุนแรง แต่สามารถสร้างความสะดุดตาได้เป็นอย่างมาก มีชีวิตชีวา เป็นประโยชน์ในการนำเสนอข้อมูลในรูปแบบที่ชัดเจน แน่นอน แต่ในบางครั้งความสดใสดังกล่าวอาจมีลักษณะฉูดฉาดจนเกินไปจนรบกวนการสื่อความหมายที่แท้จริงได้
5. ชุดสีที่คล้ายคลึงกัน (Analogous Color Scheme)
ชุดสีที่มีรูปแบบง่ายอีกแบหนึ่ง ก็คือชุดสีที่มีความคล้ายคลึงกัน ซึ่งประกอบด้วยสี 2 หรือ 3 สีที่อยู่ติดกันในวงล้อสี เช่น แดงแกมม่วง, สีแดง และสีส้ม เนื่องจากชุดสีที่มีอยู่ในรูปแบบนี้มีจำนวนมากมายทำให้สามารถเลือกชุดสีแบบนี้มาใช้งานได้อย่างสะดวก และแม้สามารถเพิ่มจำนวนสีในชุดให้เพิ่มขึ้นเป็น 4-5 สีได้ แต่กลับมีผลทำให้ขอบเขตของสีมีความกว้างเกินไป ทำให้สีที่อยู่ตรงปลายทั้งสองของชุดไม่มีความสัมพันธ์กัน เป็นสาเหตุที่ทำให้ลักษณะการมีสีคล้ายคลึงกันลดลง
การจดทะเบียนโดเมนเนม (Domain Name)


โดเมนเนม หรือ ชื่อของ Web Site  ถือเป็นปัจจัยที่มีความสำคัญเป็นอย่างยิ่งในการทำ Web Site  ซึ่งสามารถใช้โดเมนเนมเป็นการบ่งบอกถึงตัวเองที่อาจจะอยู่ในฐานะผู้ผลิต ผู้ขายสินค้าหรือให้บริการต่าง ๆ หรือบ่งบอกถึงลักษณะของสินค้าหรือบริการ ตลอดจนลักษณะของ Web Site นั้น ๆ ก็ได้ การจดทะเบียนโดเมนเนมแบ่งออกเป็น 2 ระดับใหญ่ ๆ ได้แก่
1. Top Level Domain Name

Top Level Domain Name เป็นโดเมนเนมในระดับสากล อยู่ในความควบคุมดูแลของ www.internic.net ซึ่งโดเมนเนมในระดับนี้แบ่งนามสกุลออกเป็น 6 ประเภท ซึ่งแต่ละประเภทก็จะมีลักษณะการใช้งานที่แตกต่างกันไปดังนี้
.com

A Commercial Organization

.net

Network Access Providers

.org

Usually Nonprofit Organization

.edu

An Education Intuition

.gov

A Government (US Government Only)

.mil

U.S. Military Organization

2. Local Domain Name

Local Domain Name เป็นโดเมนเนมท้องถิ่นที่ในแต่ละประเทศก็จะมีโดเมนเป็นของตัวเอง สังเกตได้จากโดเมนเนมนั้นจะลงท้ายด้วยชื่อย่อของประเทศ เช่น .co.th ก็หมายถึงประเทศไทย  .co.jp หมายถึงประเทศญี่ปุ่น เป็นต้น Local Domain Name  ในประเทศไทยจะอยู่ในความดูแลของ www.thnic.net  ซึ่งจะแบ่งนามสกุลตามลักษณะการใช้งานได้ดังนี้
.co.th

company

.net.th

network

.ac.th

Academic

.or.th

Organization

.go.th

Government

.mi.th

Military

.in.th

Individual

การติดต่อระหว่าง Client และ Server


การติดต่อระหว่างข้อมูลต่าง ๆ ของ www ขึ้นอยู่กับระบบ Client – Server ซึ่งมีส่วนประกอบสำคัญ 
3 ส่วนคือ
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รูปที่ 1.6 ส่วนประกอบของการติดต่อระหว่าง Client และ Server

1. Clients

2. Server

3. Network

ในส่วนของ Client จะมีโปรแกรมที่ส่วนมากจะทำงานบนเครื่องของผู้ใช้ แต่ยังมีบางส่วนที่ติดต่อกับ Server เช่น Browser, โปรแกรม FPT เป็นต้น Software ในส่วนของ Client จะถูกออกแบบมาให้เข้ากันได้กับ Hardware ในแต่ละแบบ เช่น PC และ Macintosh จะมีความแตกต่างกันทั้งด้าน Hardware และ Software แต่โปรแกรมในส่วนของ Client เช่น Browser ทำหน้าที่แสดงผลที่ส่งมาจากฝั่ง Server โดยที่ไม่มีความแตกต่างกันมากนัก
ในการทำงานของระบบ Client / Server จะเริ่มจากการร้องขอข้อมูลจากเครื่องผู้ใช้ผ่านเครือข่ายไปยัง Server เมื่อ Server ได้รับคำร้องขอข้อมูลแล้วโปรแกรมทางฝั่ง Server มีหน้าจัดเตรียมและส่งข้อมูลผ่านเครือข่ายกลับมาเพื่อแสดงผลในฝั่ง Client การทำงานของระบบ Client / Server ที่ผ่าน Protocol TCP/IP จะไม่ต้องกังวลถึงความเข้ากันได้ของ Software และ Hardware ระหว่างเครื่อง Client และ Server เช่น Browser ของเครื่อง Macintosh สามารถที่จะติดต่อขอข้อมูลจาก Server ที่ Run ระบบปฏิบัติการ UNIX หรือ WINDOW 2000 ได้ 
ศัพท์เทคนิคเกี่ยวกับ Internet ที่ควรรู้


 Web Site
:   กลุ่มของ WebPage ในหน่วยงานเดียวกันที่เชื่อมโยงกันด้วยระบบ Hyper Link ใน 
    Web Site หนึ่ง ๆ จะประกอบด้วย WebPage หลาย ๆ หน้า
Home Page
: หน้าแรกของ Web Site ที่ผู้ใช้จะได้พบเมื่อเปิดเข้าไปใน Web Site หนึ่ง ๆ ด้วยการพิมพ์ที่   

  
  อยู่ของ Web Site ลงในBrowser

Web Page
: เอกสาร HTML ที่ใช้เป็นสื่อในการนำเสนอข้อมูลบนอินเทอร์เน็ต ซึ่งจะต้องอาศัย Browser
  ในการแสดงผล
HTML
: ภาษามาตรฐานที่ใช้ในการสร้าง Web เพื่อนำไปแสดงผลใน Browser ซึ่งจะประกอบด้วย
  ตัวอักษร , Graphic , Link ฯลฯ


URL
: ย่อมาจาก Universal Resource Locator มาตรฐานในการกำหนดที่อยู่ของ Web Site ใน
  เครือข่ายอินเทอร์เน็ต อาจเรียกอีกอย่างหนึ่งว่า Internet Address

บทที่ 2

Adobe Photoshop 7

โปรแกรม Photoshop เป็นโปรแกรมยอดนิยมในการจัดการงานเกี่ยวกับภาพ เนื่องจากใช้ในการสร้างภาพ และตกแต่งภาพ ได้อย่างมีประสิทธิภาพ ไม่ว่าจะเป็นงานในด้านสิ่งพิมพ์ นิตยสาร และงานด้านมัลติมีเดีย ซึ่งจากการที่ทุกท่านทราบว่าในงาน Web นั้น   ภาพเป็นสิ่งสำคัญของงาน Web อย่างหนึ่งนอกเหนือจากเนื้อหา หรือ Content ดังนั้นโปรแกรม Photoshop จึงเป็นเครื่องมือสำคัญอย่างหนึ่งของการทำงาน Web   โดยเฉพาะงานด้านออกแบบ และตกแต่งภาพของ Web Site ให้มีเอกลักษณ์หรือความความพอใจของผู้ทำ Webนั้นๆ
จากที่กล่าวมาในขั้นต้นว่าโปรแกรมที่ทุกท่านจะได้เรียนรู้และทำความเข้าใจนั้นเป็นการทำงานเกี่ยวกับ ภาพดังนั้นมาทำความรู้จักกับภาพบนคอมพิวเตอร์เสียก่อนว่าคอมพิวเตอร์นั้นมีการประมวลผลอ่านภาพได้ แบบใดบ้างซึ่งหลายๆ ท่านคงจะพอทราบกันแล้วว่าการประมวลภาพในคอมพิวเตอร์นั้นมีอยู่ 2 แบบแตกต่างกันคือ
1. การประมวลภาพแบบ Vector เป็นการประผลมวลแบบอาศัยหลักการคำนวณทางคณิตศาสตร์
2. การเก็บภาพแสดงผลแบบ Bitmap  เป็นการประมวลผลแบบอาศัยอ่านค่าสีในแต่ละพิกCell 

        (Pixel) ซึ่งโปรแกรม Photoshop ใช้วิธีนี้ในการประมวลผล ภาพเปรียบเทียบการแสดงผลแบบ
        Vectorและ Bitmap

เข้าสู่โปรแกรม Photoshop


ต่อจากนี้จะมาทำความรู้จักกับโปรแกรม Photoshop แต่ก่อนที่จะเริ่มทำงานใน Photoshop มารู้จักหน้าตาของโปรแกรมกันก่อน
ขั้นตอนการเข้าโปรแกรม
1. Click Icon    [image: image7.jpg]


    บน Desktop
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2. Clickปุ่ม  Start  > Program > Adobe PhotoShop

รูปที่ 2.1 การเรียกใช้โปรแกรม Photoshop

หน้าจอแรกของโปรแกรม  Photoshop

ประกอบด้วย องค์ประกอบด้วยส่วนต่างๆดังต่อไปนี้
1. สัญลักษณ์ของ Photoshop 

2. แถบเมนู (menu bar)

3. ปุ่มควบคุมการทำงาน
4. แถบกำหนดรูปแบบของเครื่องมือที่ใช้งาน (Tool Option Bar ) 

5. กล่องเครื่องมือ  ( Tool Palette)

6. Palette ที่รวบรวมคุณสมบัติของการทำงานต่าง  เช่น Navigator, Color, Layer, History เป็นต้น
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รูปที่ 2.2 หน้าหลักของโปรแกรม Photoshop

คำสั่ง  Menu Bar ทั้งหมด 9 คำสั่ง ขออธิบายโดยสังเขปดังนี้ 
· File 
เป็นคำสั่งการทำงานเกี่ยวกับไฟล์ เช่น การเปิดไฟล์ (open) ปิดไฟล์ (close) การบันทึก  

ไฟล์ (Save) เป็นต้น
· Edit 
เป็นคำสั่งเกี่ยวกับการปรับแต่งต่างๆ เช่น การตัด  ( Cut) คัดลอก ( Copy ) ปะ (Paste ) 


เติมสี (Fill) และเปลี่ยนขนาด (Transform ) รวมไปถึงคุณสมบัติต่างๆ 
· Image 
เป็นคำสั่งที่เกี่ยวกับการปรับภาพทั้งหมด เช่น สีของภาพ การทำภาพขาวดำ การเพิ่ม

ความสว่าง เป็นต้น
· Layer 
เป็นเมนูที่รวบรวมคำสั่งต่างๆเกี่ยวกับ Layer ไว้ เช่นการเรียงลำดับก่อนหลังของ Layer     
       
และความสัมพันธ์กันระหว่างแต่ละ Layer 

· Select 
เป็นแถบคำสั่งที่ทำงานเกี่ยวกับการจัดการพื้นที่ที่เลือก มักใช้ร่วมกับ  Tools palette 

· Fitter 
เป็นแถบคำสั่งที่เกี่ยวกับการปรับเปลี่ยนภาพ มีการใส่ effect ต่างๆ ให้กับภาพ โดยมี
  
ฟิลเตอร์ที่ติดมากับตัวโปรแกรมมีทั้งหมด 14 กลุ่ม มีการทำงานที่แตกต่างออกไป 
· View 
รวบรวมคำสั่งในการกำหนดมุมมองภาพในรูปแบบต่างๆ การย่อ-ขยาย รวมทั้งเรื่อง 

Grid, Guide และไม้บรรทัด
· Window 
รวบรวมคำสั่งที่เกี่ยวกับการจัดหน้าต่างแต่ละหน้าต่าง ที่ปรากฏบนจอรวมถึงหน้าต่าง    
   
Palette ด้วย
· Help
รวบรวมวิธีการใช้งาน  และคำแนะนำเกี่ยวกับโปรแกรม 
หลังจากที่แต่ละท่านทราบว่าแต่ละเมนูมีการทำงานเกี่ยวกับอะไร และก่อนที่จะทำการเริ่มใช้อุปกรณ์ต่างๆ ในการทำงานตกแต่ง หรือสร้างรูปภาพ มาเรียนรู้ Tip เล็ก ๆ หลักการ Design พื้นที่หน้าจอกันเสียก่อน 
จากแบบสำรวจในประเทศไทยพบว่า คนส่วนใหญ่ในปัจจุบันนั้นยังนิยมใช้การแสดงผลของจอภาพนั้น (Resolution) ที่ 800*600 ซึ่ง การออกแบบในหน้า Page ต้องคำนึงถึงเนื้อที่จริง ๆ ที่ออกแบบได้บน Brower เสียก่อน 
ซึ่งขนาดที่กำหนดหน้าจอสำหรับ 800 *600 นั้นจะออกแบบไว้ที่ 780*420 เนื่องจากติด Scrollbar และ Menu bar ของ Browser  

การเปิด File ใหม่ขึ้นทำงาน
1. Clickที่เมนู File 

2. คำสั่ง New  ( Ctrl + N)

3. เกิดหน้าต่าง NEW  

[image: image277.jpg]





รูปที่ 2.3 หน้าต่างของคำสั่ง File > New

Name 
:  
ชื่อ
Image size :  
ขนาดของ File ซึ่งเปลี่ยนแปลงตาม ขนาดและ Resolution

Width  
:  
ความกว้าง  ซึ่งมีหน่วย ต่างๆ  เช่น พิกCell  เซนติเมตร นิ้ว
Height 
:  
ความสูง  ซึ่งมีหน่วย ต่างๆ  เช่น พิกCell  เซนติเมตร นิ้ว
Resolution 
: 
ค่าความละเอียด (ซึ่งความละเอียดบนหน้าจอ  = 72 )

Mode 
:  
ใช้ Mode RGB Color  สำหรับการออกแบบWeb
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การกำหนดมุมมองใน Photoshop


การกำหนดการมองภาพทั้งหมดโดยใช้ Toolbox options   


เป็นการกำหนดมุมมอง  เพื่อจะมองเห็นภาพทั้งภาพอย่างชัดเจน โดยการ Click Mouse ที่ Palette Tool ซึ่งประกอบด้วย 3 รูปแบบดังนี้คือ
1. Standard Screen Mode    เป็นหน้าจอปกติของ Photoshop จะแสดงภาพทั้งหมดให้เห็นภายในกรอบหน้าต่าง
2. Full Screen Mode with Menu Bar ไม่มีกรอบหน้าต่าง รูปทั้งหมดจะถูกแสดงเต็มหน้าจอ แต่ยังเหลือเมนูบาร์
3. Full Screen Mode รูปทั้งหมดถูกเต็มจอ ไม่มี กรอบหน้าต่างไม่มีเมนูบาร์ และพื้นที่ที่เหลือของหน้าจอจะถูกแทนด้วยสีดำ
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Tip & Trick
ถ้าต้องการดูรูปอย่างเดียวโดยไม่มี Toolbar  และ Palette ต่างๆให้กดที่ ปุ่ม Tab  แล้วเมนู
 Toolbar และ Palette จะหายไป และกดปุ่ม Tab อีกครั้งเมนูต่างๆจะกลับมา
การย่อ-ขยายภาพ โดยใช้ Zoom Tool  

การย่อ-ขยายภาพ จะช่วยให้สามารถตกแต่งภาพได้ง่ายและมีความละเอียดมากขึ้นสามารถขนานภาพและตกแต่งภาพได้จนถึงส่วนที่ย่อยที่สุดของภาพ คือ พิกCellต่อพิกCell

Zoom Tool เป็นเครื่องมือหนึ่งที่อยู่ใน Toolbox มีรูปร่างเหมือนแว่นขยาย ใช้ในการย่อหรือขยายภาพ มีขั้นตอนการทำงานดังนี้ คือ
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1. Click Mouse ที่ไอคอน ใน Toolbar 

2. เมื่อเลื่อน Mouse เข้าไปบริเวณรูปภาพ ตัวชี้ Mouse จะเปลี่ยนไปเป็นรูป ในขั้นตอนมีวิธีใช้ที่แตกต่างกันดังนี้
2.1 เมื่อต้องการขยายภาพ ให้เลือกบริเวณที่ต้องการ ขยายแล้ว  Click Mouse ภาพบริเวณนั้นจะขยายออก  และเมื่อ Click Mouseไปเรื่อย ๆ ภาพก็จะขยายขึ้นเรื่อย ๆ
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เมื่อต้องการย่อภาพ ให้กดคีย์บอร์ดที่ปุ่ม Alt  ค้างไว้จะสังเกตเห็นว่าตัวชี้ Mouseเปลี่ยนเป็น    
         หลังจากนั้นเลือกบริเวณที่ต้องการย่อภาพ และ Click Mouse จะสังเกตเห็นว่าภาพบริเวณนั้นจะถูกย่อลง
กำหนดมุมองของภาพ  โดยการใช้ Hand Tool เลื่อนดูภาพ 
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ในกรณีที่ภาพมีขนาดใหญ่ ไม่สามารถมองเห็นทุกส่วนของภาพได้ในหน้าจอเดียว  สามารถเลื่อนภาพเพื่อดูภาพในทุกจุดได้  ภายในหน้าจอเดียวได้โดยไม่ต้องอาศัย   Scrollbar              อีกต่อไป ด้วยวิธีง่าย ๆ คือการใช้ Hand Tool ที่อยู่ Toolbox.

Navigator Palette ศูนย์รวมการกำหนดมุมมองภาพ
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รูปที่ 2.4 Navigator Pallette

จากหัวข้อที่ผ่าน ๆ มาก็ได้เห็นถึงการกำหนดมุมมองของภาพในรูปแบบต่าง ๆ ซึ่งความสัมพันธ์ระหว่างการใช้เครื่องมือเหล่านั้นกับภาพที่เห็นถูกรวบรวมไว้ด้วยกันที่  Navigator Palette ดังต่อไปนี้คือ
1. สามารถเรียกดู Navigator Palette ได้โดยการ  Click  Mouse ที่ Window > Show Navigator หรือถ้ามี Navigator Platte อยู่แล้วเพียงแต่ Click  Mouse ที่ Tab ที่มีชื่อว่า Navigator

2. สังเกตว่า  ภาพที่ใช้งานอยู่ ปรากฏใน Navigator Palette

3. กรอบสี่เหลี่ยมสีแดงสดพื้นทีภาพที่แสดงบนหน้าต่างภาพ
4. เมื่อเลื่อน Mouseไปที่กรอบสีแดง จะปรากฏ Click Mouse และลากเส้นกรอบสีแดงไปยังพื้นที่ที่ต้องการดู ใช้งานเหมือนคำสั่ง Hand Tool

5. บอกเปอร์เซ็นต์การขยายของภาพในขณะนั้น สามารถพิมพ์ตัวเลขกำหนดเปอร์เซ็นต์การขยายภาพเองได้ สังเกตว่า กรอบสีแดงจะเล็กลงเมื่ออัตราการขยายสูงขึ้นและภาพที่แสดงในหน้าต่างภาพก็จะมีขนาดใหญ่ขึ้นด้วย
6. Click Mouse เพื่อปรับเปอร์เซ็นต์การย่อเป็น  Step

7. แถบเลื่อนเพิ่ม-ลด อัตราการขยายของภาพ ทางขวาเพิ่ม ทางซ้ายลด
8. Click Mouse เพื่อปรับเปอร์เซ็นต์การขยายเป็น  Step

Selection เลือกพื้นที่เพื่อการแก้ไข และตกแต่งภาพ

ความหมายของการ Selection 


ใน Photoshop หากต้องการปรับแต่งภาพ แต่ไม่ได้เลือกพื้นที่อย่างเจาะจง ก็หมายความว่า กำลังปรับแต่งทั้งภาพ ซึ่งในความเป็นจริงแล้ว ภาพบางภาพต้องการปรับแต่งเฉพาะบางจุดเท่านั้น ดังนั้นการ Selection จึงนับว่าเป็นเรื่องจำเป็น 

การ Selection โดยใช้ Marquee Tool 
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Marquee Tool เป็นเครื่องมือที่ทำให้ทำการ  Selection แบบมีรูปแบบตายตัว เช่น การเลือกพื้นที่เป็นรูปสี่เหลี่ยม วงกลม ด้วยวิธีง่าย ๆ เพียงลาก Mouse ผ่านพื้นที่ภาพเท่านั้น Marquee Tool แบ่งตวามลักษณะการใช้งานเป็น 4 รูปแบบคือ
รูปที่ 2.5 เครื่องมือในส่วนของ Marquee Tool
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วิธีการใช้งาน Marquee Tool


ดังกล่าวมาแล้วข้างต้น Marquee Tool มี 4 ลักษณะ ในหัวข้อนี้  
วิธีการใช้ :  

1. เลือกรูปแบบของ  Marquee โดย Click Mouse ค้างไว้ จะปรากฏรูปทรงต่าง ๆ ของ Marquee Selection ที่ซ่อนไว้ เลื่อน Mouse ไปยังรูปแบบที่ต้องการแล้วปล่อย Mouse  แต่ถ้ารูปแบบที่ต้องการไม่ถูกซ่อนอยู่ ก็สามารถ Click Mouse ที่ไอคอนนั้นได้เลย หรือกดปุ่ม <M> ซึ่งเป็น short cut ของ Marquee Tool ในที่นี้เลือก Rectangular Marquee Tool

2. เลื่อนตัวชี้ Mouse ไปที่บริเวณภาพ ตัวชี้ Mouse จะเปลี่ยนเป็น + หลังจากนั้น Click Mouse และลากเพื่อเลือกพื้นที่ที่ต้องการ
3. เมื่อได้พื้นที่ที่ต้องการแล้วปล่อย Mouse จะปรากฏบริเวณที่เลือกขึ้น
Marquee Options
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สามารถกำหนดคุณลักษณะต่าง ๆ ของ Marquee Tool ได้โดย Click Mouse เลือกที่ Option Bar จะแสดงขึ้นดังรูป
รูปที่ 2.6 Option Bar ขณะทำงานที่ Marquee Tool

รายละเอียดของ Function ต่าง ๆ ใน Marquee Options

1. Feather  เป็นการกำหนดความฟุ้งเบลอของขอบที่เลือก มีค่าตั้งแต่ 1 ถึง 255 เป็นการสร้างเส้นขอบ Selection ให้มีความฟุ้งเบลอและลดความละเอียดของขอบที่ Selection ซึ่งจะเห็นการเปลี่ยนแปลงที่ชัดเจน  เมื่อมีการ Cut, Copy, หรือ Move พื้นที่ที่เลือกนั้น หากค่าของ Feather มาก ความฟุ้งเบลอจะมากตามด้วย
2. Style ของ Marquee Options แบ่งเป็น 3 ประเภท คือ
· Normal 
เลือกอิสระ ขนาดของพื้นที่เลือกจะเปลี่ยนแปลงไปตามตำแหน่งของ Mouse ที่เลื่อนไป
· Constrained Aspect Ration เลือกแบบกำหนดค่ายืนหยุ่นตามอัตราส่วนความกว้าง ความสูงที่ได้กำหนดไว้ เช่น กำหนดให้ Width = 1 และ Height  = 1 หมายถึงเมื่อลากMouse พื้นที่เลือกได้จะถูกบังคับให้เป็นอัตราส่วน 1  :  1

· Fixed Size   เลือกโดยกำหนดพื้นที่เลือกทั้งกว้าง และความสูงอย่างเจาะจงแน่นอน
การเลือกพื้นที่ใหม่ การเพิ่ม ตัด ลด และเคลื่อนย้ายพื้นที่ที่เลือก
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สามารถทำได้โดยใช้ Option ต่าง ๆ ที่อยู่ใน Tool Option Bar ดังนี้คือ
· [image: image287.jpg]S|




ในกรณีที่เลือกพื้นที่ภาพ กด 
    ตัวชี้ Mouseจะเปลี่ยนเป็นรูป  +  หลังจากนั้นให้ Drag Mouse ให้พื้นที่ที่ต้องการ
· [image: image288.jpg]


ในกรณีที่เพิ่มพื้นที่ที่เลือก กด  
  หรือ  ปุ่ม Shift ค้างไว้ ตัวชี้ Mouse จะเปลี่ยนเป็นรูป ++  หลังจากนั้นให้ Click Mouse ค้างไว้ และลาก Mouseไปบริเวณพื้นที่ที่ต้องการเพิ่ม
· ในกรณีที่ลดพื้นที่กด  
     หรือ  กดปุ่ม alt ค้างไว้ ตัวชี้Mouseจะเป็นเป็นรูป +-   หลังจากนั้นให้ Click Mouse ค้างไว้ และลาก Mouse ไปบริเวณพื้นที่ที่ต้องการลด
การ  Selection โดยใช้ Lasso Tool 
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รูปที่ 2.7 เครื่องมือในส่วนของ Lasso Tool
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เป็นการ Selection เป็นการเลือกพื้นที่การทำงานแบบอิสระ โดยการทำงาน คือ ลาก selection ตามพื้นที่ที่ต้องการ และจุดสิ้นสุดนั้นต้องบรรจบกลับที่จุดเริ่มต้นรูปแบบเครื่องมือ  Lasso Tool 

1. Lasso Tool 
เป็นการเลือกแบบ อิสระ คือเลือกโดยอิสระด้วยมือของ
การใช้   Clickเลือกเครื่องมือ จากนั้น Click Mouse และลากไปตามขอบพื้นที่ที่ต้องการเลือก และจุดสุดท้ายให้บรรจบที่จุดแรก
Lasso Option 
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Anti –aliased เป็นช่วยให้ขอบพื้นที่เลือกเรียบ ไม่ขรุขระ ทำให้งานดูเรียบร้อยมากขึ้น
รูปที่ 2.8 Option Bar ขณะทำงานที่ Lasso Tool

2. Polygonal  Lasso Tool  เป็นการเลือกแบบสร้างขอบเป็นเส้นตรงหลายเหลี่ยม
การใช้   เป็นเลือกพื้นที่แบบรูปหลายเหลี่ยม  โดยทำการClickที่จุดเริ่มต้น จากนั้นลากไปยังตำแหน่งที่ต้องการ จากนั้นแล้วClickตำแหน่งถัดไป ซึ่งจะเกิดพื้นที่ที่เลือกเป็นแบบหลายเหลี่ยม  จนกลับมายังจุกเริ่มต้นและClickที่ตำแหน่งเดิม จะเกิดเส้นประ Selection เกิดขึ้น
3. Magnetic  Lasso Tool เป็นเครื่องมือที่ทำงานเกาะขอบพื้นที่สีที่ใกล้เคียง 
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การใช้  เลือกเครื่องมือ จากนั้น ClickMouse ที่จุดเริ่มต้น จาก Mouse ลากไปบริเวณที่ต้องการ  เครื่องมือจะทำงานเลือกพื้นที่ในขอบเองโดยอัตโนมัติ การสิ้นสุดการทำงานโดยกลับไป Click จุดที่บรรจบกับจุดเริ่มต้นอีกครั้ง
Magic Wand Tool  

เป็นการเลือกพื้นที่อิงกับค่าสีของรูปเป็นสำคัญ  โดยโปรแกรมจะเลือกเฉพาะค่าสีที่ใกล้เคียงที่ Click 
ดังนั้นวิธีนี้เหมาะสมกับการเลือกพื้นที่ที่ไม่มีสีแตกต่างกันหรือเป็นสีเดียวจะดีมาก
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วิธีการ : 

1. เลือกเครื่องมือ      Magic Wand Tool 

2. กำหนดค่าต่างบน Option Bar ดังนี้ 
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รูปที่ 2.9 Option Bar ขณะทำงานที่ Lasso Tool

· Tolerance :  กำหนดค่าสี
· Anti-aliased : ทำให้ขอบเรียบไม่มีรอบขรุขระ
· Contiguous  :  เป็นการเลือกบริเวณสีที่ใกล้เคียงกันเฉพาะกลุ่มพิกCellที่ได้ Click Mouse เท่านั้น
3. Click  Mouse บนพื้นที่ที่เลือก จะเกิดเส้นประบนพื้นที่ที่เลือก
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การเคลื่อนย้ายภาพ
Move  Tool 


เป็นเครื่องมือในการเคลื่อนย้ายภาพหรือพื้นที่ที่ต้องการทำการเคลื่อนที่

วิธีการ : 

1. เลือกพื้นที่ (Selection) ที่ต้องการหรือรูปภาพที่ต้องการ
2. Click Mouse เลือกอุปกรณ์
3. Click Mouse ค้างลากพื้นที่ที่เลือกหรือภาพที่ต้องการ ไปวางยังตำแหน่งที่ต้องการปล่อย Mouse 

การเลือกสี
สามารถทำได้ หลายวิธี  
1. ใช้ที่ Color Palette  โดยการเลือกสีที่ต้องการ จากนั้น สีจะเกิดบนช่องสี Foreground 

2. [image: image296.jpg]


ใช้  Swatches Palette 

3. ใช้  Eyedropper Tool                 เป็นเครื่องมือดูดสี
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รูปที่ 2.10 Color Pallette

วิธีการใช้งาน

1. Click เลือกเครื่องมือ
2. Click Mouse เพื่อไปดูดสีตามที่ต้องการบนงานหรือพื้นที่ต้องการ
3. จากนั้นดูรูป บน Tool Palette จะเปลี่ยนที่ไปตามสีที่ดูดมา
การวาดและระบายสีภาพ
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รูปที่ 2.11 อุปกรณ์ Brush & Pencil Tool
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Brushes  

เป็นการระบายสี  ซึ่งบางทีอาจต้องมีการตกแต่งภาพ หรือใส่สี  ซึ่งสามารถทำการเลือกรูปแบบของพู่กัน และขนาดของพู่กันได้
วิธีการ :  

1. เลือกสีที่ต้องการ จากนั้น Click ที่แถบเครื่องมือ Paint Brush Tool

2. Drag Mouse ลากระบายสีตามที่ต้องการ  (หากต้องการลากเป็นเส้นตรงให้กดปุ่ม Shift ค้างไว้ )

Option ของ Paintbrush
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รูปที่ 2.12 Option Bar ขณะทำงานที่ Brush Tool

1. Mode : เป็นการกำหนดโหมดพิเศษของสี
2. Opacity  :  เป็นการกำหนดค่าโปร่งแสงของสี ยิ่งค่าน้อยเท่าไหร่ ยิ่งโปร่งแสงมาก
3. Wet Edges : เป็นการกำหนดเส้นขอบให้ดูเหมือนเปียกน้ำ
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Fade  :  เป็นการกำหนดค่าความเลือนของเส้น
5.           Airbrush Tool     เป็นเครื่องมือที่ใช้พ่นสี  จะมีความฟุ้งกระจาย มากกว่าการระบายด้วย Paint brush 

Pencil Tool  

        การทำงานเหมือน Paint brush  แต่เส้นที่เกิดขึ้นมีความคมชัดและมีขอบที่ชัดเจน
วิธีการ  เหมือน Paint brush 
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รูปที่ 2.13 Option Bar ขณะทำงานที่ Pencil Tool

Eraser   tool  

       เป็นเครื่องมือที่ใช้สำหรับการลบเหมือนชื่อ ซึ่งประกอบด้วยคำสั่งย่อย ๆ อีกคือ
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รูปที่ 2.14 อุปกรณ์ Eraser Tool
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Eraser tool

       วิธีการใช้  : 

1. Click ที่อุปกรณ์ จากนั้นไปที่ Option bar เลือกขนาดและรูปแบบของยางลบ
2. Click หรือ Drag Mouse ไปยังจุดหรือพื้นที่ที่ต้องการลบ
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Eraser Option

รูปที่ 2.15 Option Bar ขณะทำงานที่ Eraser Tool

Brush  

:  เป็นการเลือกกำหนดขนาดหรือลักษณะของยางลบ
Opacity 

:  เป็นการกำหนดความโปร่งแสงของภาพ
Eraser to History   
:  เป็นการเรียกส่วนที่ลบคืนมา
Brush Dynamics  
:  เป็นการให้ค่าสีใน Background ระบายลงไปแทน
Background Eraser Tool

       เป็นการลบค่าสีพิกCellบน Layer ที่ Drag Mouse ผ่าน ให้มีลักษณะโปร่งแสง
       วิธีการใช้  :  เหมือน Eraser Tool

History Brush Tool


เป็นการลบเฉพาะส่วนที่ทำเพิ่มเติมลงในภาพ  แต่จะไม่มีผลต่อภาพเดิม (background) เป็นอันขาด

วิธีใช้  :   Click เลือกอุปกรณ์ จากนั้น Drag Mouse ไปยังบริเวณที่ต้องการลบ
เครื่องมือเกี่ยวกับการเทสี
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รูปที่ 2.16 อุปกรณ์ที่เกี่ยวกับการเทสี (Gradient & Paint Bucket Tool)
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Paint  Bucket Tool   


เป็นการเทสีลงในภาพหรือพื้นที่ที่เลือก

วิธีการใช้ :  

1. Selection พื้นที่ที่ต้องการ
2. Click เลือกอุปกรณ์จากนั้น เลือกสีที่ต้องการจะเติม
3. Click บนพื้นที่ที่เลือก ( Alt + Delete เป็นเมนูลัด)
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Paint Bucket Tool Option bar

รูปที่ 2.17 Option Bar ขณะทำงานที่ Paint Bucket Tool

คำสั่ง Fill เป็นการเลือกสีที่จะเติมว่าจะเติมสีแบบใด
1. Foreground – สีของ Foreground

2. Pattern - เติมแบบภาพลวดลาย
3. Mode - กำหนดสีแบบพิเศษ
4. Opacity - กำหนดค่าโปร่งแสง
5. Tolerance - จำกัดขอบเขตในการระบาย
6. Anti-aliased – กำหนดให้ขอบของสีที่เทลงไปเรียบ
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Gradient Tool  


เป็นการไล่โทนสีจากสีหนึ่งไปอีกสีหนึ่ง โดยมีให้เลือกอยู่ 5 รูปแบบ

วิธีการใช้ : 

1. เลือกพื้นที่ที่ต้องการ
2. เลือกเครื่องมือ Gradient จากนั้นเลือกรูปแบบที่ต้องการบน Option bars
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รูปที่ 2.18 รูปแบบของการเทสีในลักษณะ Gradient

3. Drag Mouse ตามตำแหน่งที่ต้องการ
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Option Bar

รูปที่ 2.19 Option Bar ขณะทำงานที่ Gradient Tool

1. เลือกรูปแบบสีและการไล่สี ที่ต้องการ
2. Mode :  กำหนดค่าสีพิเศษ
3. Opacity : กำหนดค่าโปรงแสง
4. Reverse : การไล่โทนสีกลับด้าน
5. Dither : ความกลมกลืนของแถบสี
6. Transparency  : เป็นการปรับการโปร่งแสงและให้แสดงผลต่อหน้าจอ
การตกแต่งภาพด้วยเครื่องมือ ต่างๆเหล่านี้
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รูปที่ 2.20 อุปกรณ์ในส่วนของการตกแต่งภาพ (Blur, Sharpen & Smudge Tool)

Blur Tool


เป็นเครื่องมือที่ทำให้ส่วนที่ Cick เบลอ

วิธีการ   :

1. เลือกอุปกรณ์  จากนั้น Click or Drag Mouse ไปยังบริเวณที่ต้องการทำงาน
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กำหนดค่า Option Bar ซึ่งมีค่าที่น่าสนใจดังนี้
รูปที่ 2.21 Option Bar ขณะทำงานที่ Blur Tool

· Brush  :  เลือกรูปแบบของอุปกรณ์  ขนาด และความฟุ้ง  เลือกขนาดแปรง รูปแบบแปรง โดยการกดปุ่ม ลูกศร สามเหลี่ยม
· Strength  :   เป็นการกำหนดค่าน้ำหนักและความเข้มของอุปกรณ์
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Sharpen Tool  


ช่วยเน้นความเข้มของภาพ และเพิ่มความคมชัดโดยลดจำนวนสีในภาพลง
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วิธีการใช้  :  เหมือน Blur Tool

[image: image317.png]


รูปที่ 2.22 Option Bar ขณะทำงานที่ Sharpen Tool

Smudge Tool  


เป็นอุปกรณ์ใน การเกลี่ยสี  ทำให้สีภาพให้ดูเรียบเนียน และกลมกลืนขึ้น
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วิธีการใช้  :  เหมือน Blur Tool

รูปที่ 2.23 Option Bar ขณะทำงานที่ Smudge Tool

เครื่องมือการปรับสีโทนของภาพ
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รูปที่ 2.24 อุปกรณ์ในส่วนของการปรับโทนสีภาพ (Dodge, Burn & Sponge Tool)

Dodge Tool  


เป็นเครื่องมือที่ทำให้ภาพสว่างขึ้น

วิธีการใช้  :  โดยการ Click ลงบนพื้นที่ที่ต้องการ

การกำหนดค่า  Option Bar  ดังนี้
1. Brush :  เลือกขนาดแปรง รูปแบบแปรง โดยการกดปุ่ม ลูกศร สามเหลี่ยม
2. Range :  เป็นการเลือกรูปแบบการทำงาน   
·  Shadows :  เป็นการปรับแต่งสีแบบเงา
· Midtones :  เป็นการปรับแต่งสีให้ดูเป็นธรรมชาติ
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Highlights :  เป็นการปรับแต่งสีแบบฟุ้งๆ หรือเน้นพื้นที่ที่จะทำงาน  Highlights
รูปที่ 2.25 Option Bar ขณะทำงานที่ Dodge Tool
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Burn Tool 


ทำให้สีของภาพดูเข้มขึ้น
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วิธีการใช้  : เหมือน dodge tool
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รูปที่ 2.26 Option Bar ขณะทำงานที่ Burn Tool

Sponge Tool  


เป็นการปรับค่า Saturate ของสี ทำให้สีมีความเข้มและจางในระดับต่างกัน

วิธีการใช้  : เหมือน Blur Tool
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รูปที่ 2.27 Option Bar ขณะทำงานที่ Sponge Tool
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การทำสำเนาภาพ
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รูปที่ 2.28 อุปกรณ์ที่ใช้ในการทำสำเนาภาพ (Clone Stamp & Pattern Stamp Tool)

Clone Stamp Tool

เป็นเครื่องมือในการ Copy ภาพ บอลลูนอยู่หลายลูกในภาพ ต้องการเพิ่มอีกสักลูก 
ขั้นตอนการทำ 
1. เปิดรูปภาพที่ต้องการทำ 
[image: image9.jpg]



รูปที่ 2.29 ภาพตัวอย่างที่ใช้ในอุปกรณ์ Clone Stamp Tool

2. Click เลือกอุปกรณ์
3. นำ Mouse ไปวางบนภาพที่ต้องการ Copy จากนั้นกดปุ่ม Alt  ค้างไว้  แล้ว Click Mouse บนภาพ ซึ่งถือเป็นจุดเริ่มต้น
4. นำ Mouse ไปวางยังตำแหน่งบนพื้นที่ว่างที่จะทำการ Paste โดยการ Click  Mouse ค้างแล้วลาก จะปรากฏรูปภาพที่ Copy ขึ้นมา
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รูปที่ 2.30 การ Copy ภาพโดยใช้ อุปกรณ์ Clone stamp Tool

[image: image328.png]Looking for some. 1o do with your or school? Check.

E D I SO N out the latest happenings at the new Power Lab.

INTERNATIONAL ™

g EDISON
M!KNA’\' i

ER L
ﬁ Q A g

Write us!
=

®

Teachers Lounge
Edison
International
home page

FIORSSIL_ LA UM

Safer T [oorrey el
Race Gamel Eeniytara: G Uk S s





Pattern Stamp Tool 


เป็นเครื่องมือสำหรับการทำสำเนา Pattern โดยวิธีคร่าวๆ คือต้องสร้าง Pattern ก่อน

สร้าง Pattern

1. ทำ Pattern โดยการใช้  Marquee Select เลือกบริเวณ Selection ที่ต้องการให้เป็นสำเนาของภาพ หรือเลือก File ที่ต้องการทำ Pattern

2. เลือกคำสั่ง Edit -> Define Pattern

3. เกิดหน้าต่าง Pattern name ให้พิมพ์ชื่อ แล้วกดปุ่ม O.k.
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จากนั้น ไปยังหน้าต่างที่ต้องการ (อาจจะทำการทำพื้นที่ Selection ก็ได้) จากนั้นใช้เครื่องมือ               ก็เลือก ภาพที่ Option Bar  จากนั้นก็Click Mouse  บนภาพ
รูปที่ 2.31 Option Bar ขณะทำงานที่ Pattern Stamp Tool
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Healing Brush Tool    

รูปที่ 2.32 อุปกรณ์ Healing Brush & Patch Tool

เป็นเครื่องมือเหมือน Clone stamp แต่ที่ช่วยปรับค่าสีที่ กับ background หรือบน Layer ก่อนหน้ากลมกลืนกัน 
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วิธีการ  :  เหมือน Clone Stamp Tool

รูปที่ 2.33 Option Bar ขณะทำงานที่ Healing Brush Tool

การสร้างตัวอักษรลงในภาพ
[image: image332.png][ woman

L Best of July
Linen

Cropped Pants &
Shorts

Pants
Denim

Skirts & Dresses
Suits & Separates
Woven Shirts

Knit Tops
Sweaters
Outerwear
Petites

Shoes

Jewelry

Swimwear & Pareos

Bags, Bets &
Accessories

Sleepwear &
Personal Care

EIEI BANANA REPUBLIC

T4

Evelet acine ski Stretch piaue cropped
$68.00 martin
$68.00

Linen heniey turic: Linen cropped martin Streoh inertlend h\end

suoreing saa [

Page 1

Mother-of-neerltie bet
$3200

Wecloe espadrile





รูปที่ 2.34 อุปกรณ์ที่เกี่ยวกับการสร้างตัวอักษร (Type Tool)

การสร้างตัวอักษรใน Photoshop มีอยู่ด้วยกัน 2 แบบ คือ แบบตัวอักษรและแบบ Selection หรือแบบเจาะใส ซึ่ง

สามารถพิมพ์อักษรได้ทั้งแนวนอนและแนวตั้ง
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การสร้างข้อความโดยใช้เครื่องมือ Type Tool  


วิธีการ :  

1. [image: image334.png]


Click  เลือกอุปกรณ์ บน  tool box  
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Click  เลือกอุปกรณ์ บน  Option bar เพื่อพิมพ์ตัวอักษร  ( ถ้าเลือก               จะเป็น Selection )

3. Click  เลือกอุปกรณ์ บน Option bar เพื่อพิมพ์ตัวอักษรเป็นแนวนอน  (ถ้าเลือก                จะเป็นแนวตั้ง)

4. Click  Mouse ลงบนพื้นที่ที่ต้องการพิมพ์   จากนั้นปรับค่าที่ Option bar 
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รูปที่ 2.35 Option Bar ขณะทำงานที่ Type Tool
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กำหนดรูปแบบตัวอักษร  ขนาดและสีของตัวอักษร   เมื่อพิมพ์ก็ความเรียบร้อย กดปุ่ม Enter หรือClickที่ Icon                และถ้าไม่ต้องการให้กดปุ่ม 
Tip & Trick
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การพิมพ์ข้อความแบบ Selection ก็ใช้ขั้นตอนการทำงานเหมือนกันกับการพิมพ์อักษรธรรมดา
การแก้ไขข้อความ
1. ทำการปาดดำ หรือ Highlight ข้อความ 
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เลือกคำสั่ง Type tool  บน Toolbar  จากนั้นก็แก้ไขบน Option Bar หรือClickเลือก ตรงปุ่ม Palette จะปรากฏ Character Palette ออกมา
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พิมพ์ข้อความที่ต้องการแก้ไข  เมื่อพิมพ์ก็ความเรียบร้อย กดปุ่ม Enter หรือ Clickที่ Icon         

        และถ้าไม่ต้องการให้กดปุ่ม 
การใส่ข้อความในแนวต่างๆด้วยคำสั่ง Create Warped Text บน  Option Bar   
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Clickเลือกข้อความที่ต้องการหรือ Layer ที่ต้องการ
2. Clickที่    
บน Option toolbar 
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เกิดหน้าต่าง Warp  text 

รูปที่ 2.36 การทำงานของ Warp Text

· Style  เลือกลักษณะรูปทรงข้อความ   จากนั้นก็ปรับรูปทรงตามความต้องการ
4. [image: image344.png]


Clickปุ่ม O.k.

5. Clickที่ Icon              บน option Toolbar

ผู้แต่ง  อ. ฐิติยา  วิบูลย์กาญจน์







Email :: soam@netdesign.ac.th

Layer


ลักษณะการทำงานที่โดดเด่นของโปรแกรม Photoshop คือมีการทำงานแบบแบ่งเป็นชั้นโดยแยกส่วนต่างๆ ของภาพให้อยู่คนละชั้นกัน ชั้นงานนี้เรียกว่า layer บริเวณของ Layer ที่ไม่มีภาพจะสามารถมองทะลุเห็น Layer ด้านล่าง เปรียบเหมือนมีแผ่นใสหลายๆ แผ่น แต่ละแผ่นมีรูปอยู่ในตำแหน่งต่างๆ กัน แล้วเอามาซ้อนทับกัน ทำให้เห็นเป็นภาพที่สมบูรณ์ การแยกทำงานเป็นชั้น ๆ นี้ทำให้สามารถเลือกทำงาน และเปลี่ยนแปลงแก้ไขในแต่ละ Layer ได้ โดยไม่ส่งผลกระทบต่อ Layer อื่น ๆ 
[image: image11.png]MR




รูปที่ 2.37 เปรียบเทียบลักษณะการทำงานของ Layer

การใช้งาน Palette Layer
[image: image345.png]


Palette Layer เรียกขึ้นมาใช้งาน โดยเลือกแถบเมนู Window > Show Layer ใน Palette Layer จะมีคำสั่งที่ควบคุมลักษณะการใช้งานของ Layer ทั้งหมด
รูปที่ 2.38 การเลือก Palette Layer ขึ้นมาใช้งาน
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รูปที่ 2.39 Palette Layer

ตัวอย่างการทำงานเป็น Layer 

เมื่อใช้คำสั่ง File > New ที่ Palette Layer จะมีชั้น Layer 1 ชั้น คือชั้น Background ซึ่งจะไม่นิยมสร้างวัตถุที่ชั้นนี้   และชั้น Background นี้จะไม่สามารถเคลื่อนย้ายสลับตำแหน่งกับLayerอื่นได้
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รูปที่ 2.40 Layer ชั้น Background จะถูกสร้างอัตโนมัติ เมื่อสร้างงานใหม่
การสร้างLayerใหม่ (New Layer)

ก่อนที่จะสร้างภาพหรือวัตถุ ควรจะเตรียมชั้นงานขึ้นมาใหม่ โดยClickที่   [image: image14.png]


  มุมขวาบนของ Palette Layer เลือก New Layer  หรือ click ที่  [image: image15.png]


   ด้านล่างจะมีชั้นLayerใหม่เกิดขึ้น
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รูปที่ 2.41 การสร้าง Layer ใหม่
การเปลี่ยนชื่อLayer (Rename Layer)

เมื่อ New Layer ใหม่ขึ้นมาควรจะตั้งชื่อให้กับ Layer นั้นเพื่อความสะดวกในการเลือกทำงาน การตั้งชื่อ Layer ให้Click Mouse ขวาที่ชั้น layer นั้น เลือก Layer Propeties 
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รูปที่ 2.42 การเปลี่ยนชื่อ Layer
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รูปที่ 2.43 หน้าต่าง Layer Property สำหรับเปลี่ยนชื่อ
การเลือก Layer มาทำงาน
การทำงานซึ่งประกอบด้วย Layer หลายชั้น สามารถเลือกทำงานได้ทีละ Layer เท่านั้น Layer ที่กำลังทำงานอยู่ สังเกตได้จากที่ชั้นของ Layer นั้นจะมีแถบสีน้ำเงินปรากฏขึ้นมา ถ้าต้องการเปลี่ยนไปทำงานที่ Layerอื่น ก็ให้ Click เลือกที่ชั้น Layer นั้นๆ ได้เลย
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รูปที่ 2.44 การเลือก Layer ที่ต้องการทำงาน
การเปลี่ยนลำดับชั้นของ Layer

ตำแหน่งการเรียงของชั้น Layer ที่ Palette Layer เรียงจากชั้นล่างขึ้นบน ซึ่งมีความสัมพันธ์กับตำแหน่งของวัตถุที่อยู่บน Layer นั้น Layer ใดอยู่ชั้นบนสุด ภาพใน Layer นั้นก็จะปรากฏอยู่ด้านหน้าสุดด้วย สามารถปรับเปลี่ยนลำดับชั้น Layer ได้ โดย Click เลือก Layer ที่ต้องการเปลี่ยนตำแหน่ง แล้ว Drag Mouse ลาก Layer ไปวางไว้ในตำแหน่งใหม่ มีผลให้การจัดลำดับของภาพที่หน้างานถูกสลับไปด้วย
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รูปที่ 2.45 หน้างานก่อนการเปลี่ยนลำดับชั้น Layer
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รูปที่ 2.46 หน้างานหลังจากการเปลี่ยนลำดับชั้น Layer แล้ว
การซ่อน Layer
สำหรับการสร้างงาน 1 ชิ้นจะประกอบด้วยจำนวน Layer มากมาย บางครั้งเพื่อความสะดวกในการทำงานอาจต้องการซ่อนบาง Layer ไปชั่วคราว ซึ่งสามารถทำได้โดย
· Clickที่  [image: image22.png]


  เป็นการปิดตาชั้น Layer นั้น มีผลให้ภาพที่อยู่ใน  Layer นั้นถูกซ่อนไป
· ถ้าหากต้องการให้ชั้น Layer ที่ถูกซ่อนไปกลับมาแสดงผลในหน้างาน ให้ Click ที่ช่องเดิมจะมีดวงตาปรากฏขึ้นมาอีกครั้ง
[image: image23.png]5
3 Layers " Channels " Paths. D
e O 7 @ Ffioon 3 |
s CIE B
o [T
:
=
T A E— a
:
i B )





รูปที่ 2.47 แสดงการซ่อน Layer
การเชื่อมโยง Layer
การเชื่อมโยง Layer เข้าด้วยกันเรียกว่า การ Link Layer เป็นการเชื่อมโยง Layer ตั้งแต่ 2 Layer เพื่อความสะดวกในการเคลื่อนย้ายภาพที่ต้องการย้ายพร้อมๆ กัน รวมทั้งการปรับขนาดของภาพที่อยู่คนละ Layerให้มีการปรับเปลี่ยนขนาดพร้อมๆ กันด้วย
วิธีการ Link Layer

· Clickเลือก Layer ใด Layer หนึ่งที่ต้องการจะ Link 

· Clickที่  [image: image24.png]


  ซึ่งอยู่ถัดจาก  [image: image25.png]


  ของอีก Layer ที่ต้องการเชื่อมเข้าไว้ด้วยกัน จะมีสัญลักษณ์  [image: image26.png]


  ปรากฏขึ้น
· ถ้านำ Move Tool มาเคลื่อนย้ายภาพ ภาพใน 2 Layer จะถูกเคลื่อนย้ายไปพร้อม ๆ กัน
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รูปที่ 2.48 การ Link Layer

วิธีการยกเลิก Link 

ถ้าต้องการให้ Layer ที่ Link เอาไว้ด้วยกันทำงานเป็นอิสระอีกครั้ง สามารถทำได้โดย Click Mouse ที่ช่องเดิม รูปโซ่จะหายไป
การทำซ้ำLayer

ในกรณีที่ต้องการภาพหรือวัตถุที่มีลักษณะเหมือนวัตถุเดิมที่มีอยู่แล้ว สามารถใช้คำสั่ง Copy Layer โดย
1. Clickเลือกที่  [image: image28.png]


  เลือก Duplicate Layer
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รูปที่ 2.49 การ Copy Layer แบบที่ 1

2. Click Mouse ที่ Layer ที่ต้องการ Copy แล้ว Drag Mouse ลาก Layer ลงมาวางที่  [image: image30.png]


  ที่อยู่ด้านล่าง Palette
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รูปที่ 2.50 การ Copy Layer แบบที่ 2

การลบ Layer
ภาพหรือวัตถุที่สร้างขึ้นมาแล้ว ถ้าต้องการจะลบออกไป สามารถทำได้หลายวิธี 
1. Clickเลือกที่ชั้น Layer ที่ต้องการลบ แล้วClick [image: image32.png]


  เลือก Delete Layer 

2. Clickเลือกที่ชั้น Layer นั้นแล้ว Drag Mouse ลาก Layer ลงมาที่ (รูป)

ภาพที่อยู่บน Layer นั้นก็จะหายไป 
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รูปที่ 2.51 การลบ Layer

การรวมLayer
การมี Layer จำนวนมากเกินความจำเป็น จะทำให้ขนาดของไฟล์เพิ่มมากด้วย ซึ่งอาจทำให้ให้เครื่องทำงานช้าลง ในการทำงานนั้นถ้ามีการเปลี่ยนแปลงแก้ไขภาพจนเป็นที่พอใจแล้ว อาจจะรวมบาง Layer เข้าไว้ด้วยกัน เพื่อลดจำนวน Layer ลง (มีผลให้ขนาดไฟล์ลดลงด้วย)

การรวม Layer มีลักษณะการรวมอยู่หลายรูปแบบ
1. Merge Down เป็นการรวม Layer 2 Layer เข้าด้วยกัน โดยเมื่อใช้คำสั่งนี้ Layer ที่ทำงานอยู่จะลงมารวมกับ Layer ชั้นล่างที่อยู่ติดกันกลายเป็น Layer เดียว
· วิธีการ
1.1 Clickเลือก Layer ที่ต้องการ
1.2 Click  [image: image34.png]


  เลือก Merge Down 

1.3 Layer ที่ทำงานอยู่จะลงมารวมกับ Layer ชั้นล่าง
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รูปที่ 2.52 การรวม Layer ลักษณะ “Merge Down”

2. Merge Link เป็นการรวม Layer ทุก Layer ที่ Link ไว้ด้วยกันให้รวมเป็น Layer เดียว
3. Marge Visible เป็นคำสั่งที่ใช้รวม Layer ที่มองเห็นอยู่ (Layer ที่เปิดตาไว้) ทั้งหมดรวมเป็น Layerเดียว ถ้า Layer ไหนโดยซ่อนอยู่ก็จะไม่ถูกรวม
4. Flatten Image เป็นคำสั่งที่ใช้รวม Layer ทุก Layer ให้กลายเป็นชั้น Layer Background 

การใช้คำสั่งรวม Layer นั้น ไม่สามารถแยกแต่ละ Layer ออกจากกันได้อีก ก่อนที่จะเลือกใช้คำสั่งใดในการรวม Layer จึงควรพิจารณาให้ดีก่อน
ค่า Opacity 


คือ ค่าความทึบแสงของภาพ สามารถเลือกปรับได้ตั้งแต่ 0 – 100 % การปรับ ค่า Opacity ให้ต่ำ ๆ มีผลให้ภาพที่อยู่ใน Layer นั้นมีความโปร่งแสงมากขึ้น จนสามารถมองทะลุลงไปเห็นภาพที่อยู่ด้านล่างได้
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รูปที่ 2.53 การปรับค่า Opacity

Layer Style 


เป็นคำสั่งที่ใช้ในการกำหนด Style หรือ Effect ต่าง ๆ ให้กับวัตถุบน Layer นั้น ๆ สามารถเลือกใช้ได้โดย Click ที่สัญลักษณ์  [image: image37.png]


  จะปรากฏหน้าต่างของ Style ต่าง ๆ ให้เลือก ซึ่งมีอยู่หลากหลาย Style ดังนี้
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รูปที่ 2.54 การกำหนด Layer Style

[image: image39.jpg]



รูปที่ 2.55 ภาพต้นฉบับก่อนการใส่ Layer Style

· Drop Shadow 

เมื่อเลือกใช้ Style นี้จะเป็นการสร้างเงาให้กับวัตถุ ซึ่งเงาจะเกิดภายนอกวัตถุ ถ้าต้องการปรับเปลี่ยนลักษณะของเงา สามารถปรับได้ที่ Option ด้านขวา
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รูปที่ 2.56 การปรับค่าที่ Drop Shadow Style

· Inner Shadow 

เป็นการสร้างเงาให้กับวัตถุเช่นเดียวกัน แต่เงาจะเกิดภายในวัตถุ
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รูปที่ 2.57 การปรับค่าที่ Inner Shadow Style

· Outer Glow

เป็นการสร้างแสงเรือง ๆ ให้เกิดขึ้นรอบ ๆ วัตถุ การปรับขนาด หรือการเปลี่ยนสีของแสง สามารถปรับเปลี่ยนที่ Option 
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รูปที่ 2.58 การปรับค่าที่ Outer Glow Style

· Inner Glow 

เป็นการสร้างแสงเรืองๆ ให้เกิดขึ้นภายในวัตถุ
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รูปที่ 2.59 การปรับค่าที่ Inner Glow Style

· Bevel Emboss

เป็นการทำให้วัตถุมีความหนา นูน ทำให้ดูมีมิติมากขึ้น
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รูปที่ 2.60 การปรับค่าที่ Bevel Emboss Style

· Satin 
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รูปที่ 2.61 การปรับค่าที่ Satin Style

· Color Overlay

เป็นการเปลี่ยนสีให้กับวัตถุ
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รูปที่ 2.62 การปรับค่าที่ Color Overlay Style

· Gradient Overlay  :  เป็นการใส่สีแบบไล่โทนสีให้กับวัตถุ
[image: image47.png]Layer Style

Stytes

Blening Options: Default

Gradient Overlay
Gradient

Blend e [Normal v

[Jorop Shadow
[Jinner Shadow
[ Outer Glow
[inner Glow
[JBevel and Emboss
[ Contour
[ Texture.
[sstin
] Color Overlay.
[Pattern Overlay
[stroke

Opacity: %

Gradant ] Dlreverse

A

Preview




รูปที่ 2.63 การปรับค่าที่ Gradient Overlay Style

· Pattern Overlay  : เป็นการใส่ลวดลายรูปแบบ Pattern ให้กับวัตถุ
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รูปที่ 2.64 การปรับค่าที่ Pattern Overlay Style

· Stroke :  เป็นการใส่เส้นขอบให้กับวัตถุ
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รูปที่ 2.65 การปรับค่าที่ Stroke Style

บทที่ 3

การใช้งาน Pen Tool ,Menu Image และ Filter

การวาดภาพและเลือกพื้นที่โดยใช้ Pen Tool

การใช้ Pen Tool ในการวาดภาพจะประกอบด้วยคำสั่งต่าง ๆ โดยภาพที่ได้จากการใช้ Pen Tool ในการสร้างจะสามารถย่อ ขยาย ยืด หด และเส้นที่สร้างจะไม่สูญเสียรายละเอียดของภาพ 
· การวาดเส้น (Path)

ให้เลือกโหมดที่ Top bar ด้านบนเป็นโหมดที่ใช้สำหรับการวาด (Create new work Path) [image: image50.png](1



  จากนั้นใช้
 mouse เลือกที่ไอคอน ที่อยู่ใน Toolbox โดย Click ให้เชื่อมกันทีละจุด ผลลัพธ์ที่ได้จะปรากฏดังรูป
[image: image51.png]dobe Photoshop
Fie Edt Inage Layer Select Fier View Windon

R¢Eaoe o

Untitled-1, @ 100% (RGB),





รูปที่ 3.1 แสดงการใช้อุปกรณ์ Pen Tool

· การเพิ่มและลบรอยต่อของเส้น Path ด้วย Add (Anchor Point Tool)การเพิ่มรอยต่อของเส้นโดยการเลือกไอคอน [image: image52.png]


 แล้วClickเพิ่มไปยังเส้นเดิมก็จะเป็นการเพิ่มจุดรอยต่อและหากต้องการลบก็ทำในลักษณะเดียวกันแต่เปลี่ยนจากไอคอน  [image: image53.png]


  เป็นไอคอน [image: image54.png]


  ดังรูป
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รูปที่ 3.2 การเพิ่มและลดรอยต่อของเส้น Path

· การเคลื่อนย้ายจุดรอยต่อของเส้น Path ด้วย Direct Selection Tool

เลือกไอคอน  [image: image56.png]


  จากนั้นClick Mouse เลือกไปยังตำแหน่งที่ต้องการ 
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รูปที่ 3.3 การเคลื่อนย้ายจุดรอยต่อของเส้น Path

- การเปลี่ยน Path ให้เป็น Selection

การเปลี่ยน Path ให้เป็น Selection โดยเลือกที่ Palette Path จากนั้นเลือกลูกศรด้านข้างแล้วเลือก Make Selection หรือ จะเลือกที่ Menu Path ด้านล่างโดยตรงโดยที่ปุ่มเลือกจะเป็นลักษณะวงกลม เส้นประ
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รูปที่ 3.4 การทำ Selection จากเส้นPath

การจัดการเกี่ยวกับรูปภาพ
การย่อและขยายภาพโดยใช้คำสั่ง Edit > Transform > Scale 

หากต้องการย่อ,ขยายให้เท่ากันทุกด้าน สามารถทำได้โดยการ กด Shift ค้างไว้แล้วจึงย่อหรือขยาย ดังรูปที่ 3.5
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รูปที่ 3.5 เมนูคำสั่ง Edit >Transform > Scale
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รูปที่ 3.6 หลังจากขยายเสร็จแล้วก็เลือกเครื่องหมายด้านขวาบนเพื่อตกลงหรือ ยกเลิก
การหมุนภาพ โดยใช้คำสั่ง Edit > Transform > Rotate 

จะทำในลักษณะเดียวกันกับ การย่อและขยาย แต่จะทำการหมุนภาพแทน และยังมีคำสั่งที่สามารถใช้หมุนในลักษณะเป็นองศาได้อีกด้วย ดังรูป 3.7
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รูปที่ 3.7 การหมุนรูปภาพโดยใช้ คำสั่ง Edit >Transform > Rotate

การปรับ Mode ต่างๆ ของภาพ
ทำการเลือกที่ Menu Image>Mode เพื่อทำการเลือก Mode ของภาพที่ต้องการปรับเปลี่ยน ดังรูปที่ 3.7 โดยปกติในงาน Web จะทำการปรับ Mode ของภาพเป็นแบบ RGB Color แต่ถ้าต้องการเปลี่ยน ก็ให้ไปเลือกที่ชื่อของ Mode รูปภาพที่ต้องการเปลี่ยนได้เลย เมื่อเลือก Mode แล้วจะมีเครื่องหมายถูก อยู่ด้านหน้าชื่อของ Mode ที่ทำการเลือก
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รูปที่ 3.8 การปรับรูปแบบค่าสีต่างๆ ของภาพ
การปรับแต่งภาพโดยใช้ Menu Image  
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รูปที่ 3.9 การปรับภาพที่ Menu Image > Adjustments >…


- การปรับ ภาพโดยใช้ Menu Image > Adjustments > Levels…
ให้ทำการเลือกที่ Menu Image > Adjustments > Levels… แล้วจะปรากฏหน้าต่างสำหรับปรับแต่งงานของขึ้นมาดังรูปที่ 3.10
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รูปที่ 3.10 หน้าต่างปรับค่าของคำสั่ง Level

· การปรับภาพโดยใช้ Menu Image > Adjustments > Curves…

ให้ทำการเลือกที่ Menu Image > Adjustments > Curves… แล้วจะปรากฏหน้าต่าง สำหรับปรับแต่งงานขึ้นมาดังรูปที่ 3.11
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รูปที่ 3.11 หน้าต่างปรับค่าของคำสั่ง Curve

· การปรับภาพโดยใช้ Menu Image > Adjustments > Color Balance...

ให้ทำการเลือกที่ Menu Image Adjust Color Balance แล้วจะปรากฏหน้าต่าง สำหรับปรับแต่งงานขึ้นมาดังรูปที่ 3.12
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รูปที่ 3.12 หน้าต่างปรับค่าของคำสั่ง Color Balance

· การปรับภาพโดยใช้ Menu Image > Adjustments > Hue/Saturation…

ให้ทำการเลือกที่ Menu Image Adjust Hue/Saturation แล้วจะปรากฏหน้าต่าง สำหรับปรับแต่งงานขึ้นมาดังรูปที่ 3.13
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รูปที่ 3.13 หน้าต่างปรับค่าของคำสั่ง Hue/Saturation

- การปรับภาพให้เป็นโทนสีแบบขาว/ดำ 
จะใช้ Menu Image > Adjustments > Desaturate เมื่อทำการเลือกที่ Desaturate 
แล้วภาพที่ต้องการปรับก็จะกลายเป็นสีขาว/ดำ ทันที
- การกลับค่าสีของภาพ 

จะใช้ Menu Image > Adjustments > Invert ในการกลับค่าสี ให้ทำการเลือกที่ Invert แล้วภาพที่ทำงานอยู่ก็จะทำการกลับค่าสีทันที
- การปรับค่าสีของภาพ
ให้ทำการเลือกที่ Menu Image > Adjustments > Variations… ก็จะปรากฏหน้าต่าง สำหรับปรับแต่งภาพดังรูป 3.14
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รูปที่ 3.14 หน้าต่างปรับค่าของคำสั่ง Variations

- การทำการสำรองงาน
ให้ทำการเลือกที่ Menu Image > Duplicate… แล้ว โปรแกรม Photoshop ก็จะทำเปิดงานที่เหมือนกับงานที่กำลังทำงานอยู่ขึ้นมาอีกหนึ่งหน้าต่าง

- การทำการปรับ / ลด ขนาดของภาพ
ให้ทำการเลือกที่ Menu Image > Image Size… ก็จะปรากฏหน้าต่างสำหรับปรับแต่งภาพดังรูปที่ 3.15
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รูปที่ 3.15 หน้าต่างปรับค่าของคำสั่ง Image Size

- การเพิ่มพื้นที่ back groundให้กับงาน
ให้ทำการเลือกที่ Menu Image > Canvas size…ก็จะปรากฏหน้าต่างสำหรับปรับแต่งภาพดังรูปที่ 3.16
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รูปที่ 3.16 หน้าต่างปรับค่าของคำสั่ง Canvas Size

ฟิลเตอร์ (Filter)

ฟิลเตอร์ เป็นคำสั่งที่ใช้ในการตกแต่งภาพด้วยเทคนิคพิเศษและ ได้ผลลัพธ์ออกมาในเวลาที่รวดเร็ว
-  การใช้งานฟิลเตอร์ 

การทำงานของฟิลเตอร์จะประกอบด้วยส่วนหลักๆคือ ส่วนที่ใช้แสดงผล และ ส่วนของการปรับแต่ง การเลือกใช้งานฟิลเตอร์แต่ละตัวก็สามารถClickเลือกได้ที่ Menu > Filter ดังรูป
[image: image346.png]


รูปที่ 3.17 การยกตัวอย่างการใส่ฟิลเตอร์ Render > Lens Flare

- การใช้งานฟิลเตอร์สร้างลูกเล่นให้กับภาพ
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การใช้งานฟิลเตอร์แบบ Liquify เป็นฟิลเตอร์ที่ใช้ในการตกแต่งภาพ เช่นเดียวกับฟิลเตอร์ทั่วไปแต่จะแตกต่างกันที่ไม่ต้องตั้งค่าการปรับแต่ง การเลือกใช้งานก็สามารถClickเลือกได้ที่ Menu Filter > Liquify 

รูปที่ 3.18 การยกตัวอย่างการใส่ฟิลเตอร์ จากการปรับแต่งของคำสั่ง Liquify

ผู้แต่ง  อ. สุรกาญจน์  นิ่มอนงค์



                
  Email :: Webmaster@insidepattaya.com




                           อ. นิธิสิทธิ์    สุขแสง




            
  Email :: pop_ta@netdesign.ac.th
บทที่ 4

ความสำคัญของการออกแบบ Web Site

Web Site เป็นสื่อที่อยู่ในความควบคุมของผู้ใช้โดยสมบูรณ์ เพราะผู้ใช้มีโอกาสเลือกคลิกและไม่เลือกคลิกที่ใดก็ได้ตามต้องการ ผู้ใช้จึงมักไม่ค่อยมีความอดทนกับอุปสรรคและปัญหาที่เกิดจากการออกแบบที่ผิดพลาด ทุกคนชอบ Web ที่ออกแบบมาอย่างสวยงามและมีการใช้งานที่สะดวกมากกว่า Web ที่ดูสับสนวุ่นวายมีข้อมูลมากมายเต็มหน้าจอแต่หาอะไรไม่เจอหรือใช้เวลาแสดงผลแต่ละหน้านานจนไม่อยากรอ ถ้าเขาไม่สามารถมองเห็นประโยชน์จาก  Web Site ของคุณ หรือดูแล้วไม่เข้าใจว่าจะใช้งานอย่างไร ก็มักจะเปลี่ยนไปยัง Web Siteอื่นได้อย่างรวดเร็ว ดังนั้นคุณควรจะออกแบบ Web Site เพื่อให้เกิดประโยชน์สูงสุดต่อผู้ใช้และดึงดูดให้พวกเขาเข้ามาใช้บริการใน Web Site อยู่เสมอ
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รูปที่ 4.1   ตัวอย่างการออกแบบ Web Site ที่น่าสนใจ
การออกแบบ Web Site ที่ดี
การออกแบบ Web Site นั้นไม่ได้หมายถึงลักษณะหน้าตาของ Web Site เพียงอย่างเดียวแต่เกี่ยวข้องตั้งแต่การเริ่มต้นกำหนดเป้าหมายของ Web Site, กลุ่มเป้าหมาย, การจัดระบบข้อมูล, การสร้างระบบNavigation, การออกแบบหน้าWeb, รวมไปถึงการใช้ Graphic, การเลือกใช้สี, การจัดรูปแบบตัวอักษร
Web Site ที่ดูสวยงามหรือมีลูกเล่นมากมายนั้น อาจจะไม่นับเป็นการออกแบบที่ดีก็ได้ ถ้าความสวยงามและลูกเล่นเหล่านั้น ไม่เหมาะสมกับลักษณะของ Web Site แนวทางในการออกแบบของแต่ละ Web Site นั้นแตกต่างกันไปตามเป้าหมายและลักษณะของ Web Site  การออกแบบบางอย่างที่เหมาะสมกับ Web Site หนึ่งอาจจะไม่เหมาะสมกับอีก Web ก็ได้  Web Site บางแห่งอาจต้องการความสนุกสนาน บันเทิง ขณะที่อีก Webหนึ่งต้องการความถูกต้อง น่าเชื่อถือเป็นหลัก
อาจสรุปได้ว่า การออกแบบที่ดี คือการออกแบบให้เหมาะสมกับเป้าหมายและลักษณะของ Web Site โดยคำนึงถึงความสะดวกในการใช้งานของผู้ใช้เป็นหลัก
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รูปที่ 4.2 ตัวอย่าง Web Site ที่มีรูปแบบเป็นเอกลักษณ์และ สัมพันธ์กับผลิตภัณฑ์
การออกแบบของทั้งสอง Web Site นี้ ( รูปที่ 4.2 ) มีจุดเด่นในเรื่องของรูปแบบที่เป็นเอกลักษณ์และสัมพันธ์กับลักษณะของผลิตภัณฑ์    มีระบบ Navigation ที่เข้าใจง่าย ใช้งานง่าย แสดงถึงความถูกต้อง น่าเชื่อถือ
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รูปที่ 4.3

Web nike.com เป็นการออกแบบที่ แสดงถึงสนุกสนาน นำแอ็คชั่นต่างๆของคนมาใช้   แม้ไม่ใช้ภาพเคลื่อนไหว  แต่ก็ดูไม่หยุดนิ่ง
การออกแบบโครงร่างของหน้าWeb

1. แบ่งหน้าWebออกเป็น 3 ส่วน    
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2.  แบ่งหน้าWebออกเป็น 2 ส่วน  
[image: image350.png]top

Inspector
width Scale

menahinl
Height Scale
Name | under

under URL ome. il

Scroling [Auto
[Resize Frame

Browse 48 home.him!

lawluana

homeHinl




[image: image351.png]Inspector

Orentation

O Horzontal Rows

Columns

Bordersize [0

[eordercolor

BorderFrame [tia

Frame Set

f

AANTLAUTUIZITL

fmua Border Size = 0

uaz Border Frame = NO




3.  แบ่งหน้าWebออกเป็น 1 ส่วน  
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ความสำคัญของระบบNavigation

การนำทางที่ดีและเข้าถึงข้อมูลอย่างสะดวกเป็นหัวใจสำคัญของระบบ Navigation  การมีเนื้อหาในWeb ที่ดีจะเป็นสิ่งดึงดูดให้ผู้ใช้บริการอย่างสม่ำเสมอแต่เนื่อหานั้นไม่มีประโยชน์เลยถ้าผู้ใช้นั้นค้นหาสิ่งที่ต้องการไม่พบ ดังนั้นการออกแบบโครงสร้างข้อมูลที่ดีช่วยให้ผู้ใช้เข้าถึงข้อมูลได้ง่ายขึ้น และช่วยให้ผู้ใช้สามารถพึ่งพาระบบ Navigation ในการนำทางไปถึงที่หมายได้
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รูปที่ 4.4  ตัวอย่าง Web Site ที่มีระบบ Navigation ที่ดี
การออกแบบหน้าWeb

แนวคิดในการออกแบบหน้าWeb

· เรียนรู้จาก Web Site ต่างๆ  เป็นวิธีหนึ่งที่จะช่วยให้คุณมีไอเดียในการออกแบบหน้าWebของคุณ โดยการดูรูปแบบ และเทคนิคจากWebต่างๆซึ่งอาจจะเป็นWebคู่แข่งหรือWebที่อยู่ในกลุ่มเดียวกันก็ได้  และนำลักษณะที่ดีของWebนั้นมาประยุกต์ใช้
· ประยุกต์รูปแบบจากสิ่งพิมพ์ สามารถนำรูปแบบการออกแบบจากสิ่งพิมพ์มาใช้เช่น ลักษณะโทนสี การออกแบบGraphic ตัวอักษร มาใช้ได้
คุณสามารถออกแบบWebให้มีหน้าตาคล้าย โปสเตอร์ แมกกาซีนหรือแม้กระทั้งหน้าจอทีวี ได้ด้วยเทคนิคการออกแบบต่างๆโดยไม่จำกัด ลองพยายามศึกษา และสังเกตเทคนิคการออกแบบโดยเฉพาะทางGraphicดีไซน์จากสื่อต่างๆ ไม่ว่าจะเป็นหนังสือ, Magazine, โปสเตอร์, ทีวี และที่สำคัญที่สุดคือจาก Web Site อื่นๆด้วย
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รูปที่ 4.5  ตัวอย่างการออกแบบ Web Site โดยใช้เทคนิคจากสื่อต่าง ๆ
การสร้างลำดับขั้นความสำคัญขององค์ประกอบ
ลักษณะขององค์ประกอบต่างๆที่ควรคำนึงถึงมีดังนี้
1. ตำแหน่งและลำดับขององค์ประกอบ เพื่อเน้นให้เห็นว่าอะไรเป็นเรื่องสำคัญมาก  สำคัญรองลงไป  หรือสำคัญน้อยตามลำดับ ขนาดขององค์ประกอบต่างๆในหน้าWebจะช่วยสื่อความหมายถึงความสำคัญของสิ่งหนึ่งได้โดยองค์ประกอบที่มีขนาดใหญ่ยอมสามารถดึงความสนใจของผู้ใช้ได้ก่อน และนำมาจัดระเบียบองค์ประกอบให้เหมาะสม
2. สีและความแตกต่างของสี  สีที่เด่นชัดเหมาะสำหรับองค์ประกอบที่มีความสำคัญมาก ส่วนองค์ประกอบที่ใช้สีเดียวกันย่อมสื่อความหมายถึงความสัมพันธ์ที่ใกล้ชิด และความสำคัญที่เท่าเทียมกัน การใช้สีที่แตกต่างกันจะช่วยดึงดูดความสนใจให้ผู้ใช้มองเห็นและตอบสนองอย่างรวดเร็ว แต่การใช้สีที่หลากหลายเกินไปโดยไม่มีความหมาย กลับจะสร้างความสับสนให้กับผู้ใช้มากกว่า
3. ภาพเคลื่อนไหว ช่วยดึงดูดและสร้างความน่าสนใจได้เป็นอย่างดี แต่ต้องใช้อย่างจำกัดและระมัดระวัง เพราะถ้าใช้ภาพเคลื่อนในหน้าWebมากเกินไป จะสร้างความรำคาญให้กับผู้ใช้และผู้ใช้ตัดสินใจลำบากว่าสิ่งไหนสำคัญกว่ากัน
การสร้างรูปแบบ  บุคลิก  และสไตล์
รูปแบบของหน้าWebนั้นขึ้นอยู่กับเนื้อหาและเป้าหมายของ Web Site ว่าต้องการให้ความรู้ ข้อมูล ข่าวสาร โฆษณาหรือขายสินค้า  การออกแบบที่ดีควรจะประกอบด้วยรูปแบบ บุคลิก และสไตล์ที่สอดคล้องกับเนื้อหา ช่วยสร้างความชัดเจนในการสื่อสาร
1. รูปแบบ เลือกรูปแบบหน้า Web ที่เหมาะสม ช่วยสร้างบรรยากาศและความเข้าใจของผู้ใช้ได้เป็นอย่างดี เช่น Web เกี่ยวกับภาพยนตร์ ก็อาจจะออกแบบหน้า Web ให้คล้ายกับโรงหนังจริงๆ หรือ  Webเกี่ยวกับการท่องเที่ยวก็ออกแบบโดยนำภาพธรรมชาติมาใช้ตกแต่ง
2. บุคลิก   Webแต่ละประเภทมีบุคลิกลักษณะแตกต่างกันไป ขึ้นอยู่กับเนื้อหาและเป้าหมายในการนำเสนอ Webแต่ละแห่งสามารถให้ความรู้สึกสนุกสนาน, เชี่ยวชาญ, วิชาการ, ทันสมัย, ลึกลับ หรือเป็นทางการ เช่นถ้าออกแบบ Web เกี่ยวข้องกับเทคโนโลยี ก็ควรออกแบบให้แสดงถึงความทันสมัย ไฮเทค เช่นเดียวกับเนื้อหาภายใน Web

3. สไตล์ หมายถึงการจัดโครงสร้างของหน้า รูปแบบGraphic, ชนิดและการจัดตัวอักษร, ชุดสีที่ใช้  ไม่ควรสร้าง สไตล์ตามอำเภอใจโดยไม่คำนึงถึงความเหมาะสม สไตล์ของ Web Site ควรมีความสัมพันธ์กับเนื้อหาภายใน Web อย่างมีเหตุผลไม่ใช่ใช้เพียงเพื่อแสดงฝีมือว่าคุณสามารถตกแต่งGraphicโดยใช้เทคนิกแปลกๆได้
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รูปที่ 4.6 ตัวอย่างการออกแบบ Web site ตามเนื้อหาและเป้าหมายของ Web site

การเลือกใช้สีในการออกแบบหน้าWeb

สีสันในหน้า Web ช่วยดึงดูดและสร้างความน่าสนใจให้กับ Web Site  เป็นสิ่งกำหนดบรรยากาศและความรู้สึกโดยรวมของ Web Site  สามารถใช้สีได้กับทุกองค์ประกอบของ WebPage  ตั้งแต่ ตัวอักษร, รูปภาพ, Link, สีพื้นหลังและรูปภาพพื้นหลัง การเลือกใช้สีอย่างเหมาะสม จะช่วยสื่อความหมายและสร้างความสวยงามให้กับ Web นั้น
ประโยชน์ของสีใน Web Site ในรูปแบบต่างๆมีดังนี้
1. สีสามารถชักนำสายตาผู้อ่านให้ไปยังทุกบริเวณในหน้า Web การเลือกเฉดสีและตำแหน่งของสีอย่างรอบคอบจะเป็นประโยชน์อย่างมากเมื่อคุณต้องการให้ผู้อ่านให้ความสนใจกับส่วนใดส่วนหนึ่งในหน้า Web Site เป็นพิเศษ
2. สีช่วยเชื่อมโยงบริเวณที่ได้รับการออกแบบเข้าด้วยกัน เช่น ผู้อ่านจะมีความรู้สึกว่าบริเวณที่มีสีเดียวกันเป็นเรื่องเดียวกันหรือมีความสำคัญเท่ากัน
3. สีสามารถนำไปใช้ในการแบ่งบริเวณต่างๆออกจากกัน
4. สีสามารถใช้ในการดึงดูดความสนใจของผู้อ่านให้พวกเขาอยู่ใน Web Site ได้นานยิ่งขึ้น
5. สีสามารถสร้างอารมณ์โดยรวมของ WebPage กระตุ้นความรู้สึกตอบสนองจากผู้ชมได้
6. สีช่วยสร้างระเบียบให้กับข้อความต่างๆ เช่นใช้สีแยกส่วนระหว่าง หัวเรื่องกับเนื้อเรื่อง
การเลือกสีในการการออกแบบให้เหมาะสมช่วยส่งเสริมเอกลักษณ์ขององค์กร หรือหน่วยงานนั้นๆได้
การจัดระบบข้อมูล Graphic บน Web Server

File และ Folder

-   File งาน นามสกุลหลักๆที่ใช้ในการทำ Web Site  คือ .html, .gif, .jpg

การตั้งชื่อ File 

1.ห้ามใช้ภาษไทย
2.ควรใช้ตัวอักษรเป็นตัวพิมพ์เล็กในการตั้งชื่อทั้งหมด
3.ห้ามเว้นวรรค
4.ห้ามใช้อักขระพิเศษ เช่น      ,     /     -   %

การแบ่ง Folder    

 การ Crop File  การตัดภาพใน โปรแกรม Photoshop เพื่อ
1.ช่วยให้การโหลด File รูปภาพ เร็วขึ้น
2.สามารถทำ Image Link ได้
3.แบ่งลักษณะรูปภาพ . gif  ,   .jpg เพื่อให้ได้ file ภาพมีคุณภาพและขนาด file เล็กที่สุด
Graphic รูปแบบ Gif  มีสีสูงสุด 256 สี
การเลือก Save for Web เป็น file Gif ใช้ลดขนาด Graphic สำหรับรูปภาพที่มี สีน้อย สีพื้นๆไม่ซับซ้อน เช่น รูปโลโก้ ลายเส้น รูปการ์ตูน และรูปตัวอักษร
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รูปที่ 4.7 ตัวอย่างการ Save งาน เป็น File Gif

ถ้าต้องการทำให้บางบริเวณของรูปภาพมีลักษณะโปร่งใส (Transparent) จะต้องเลือกรูปแบบการ Save  เป็น .Gif  เป็น Graphic ชนิดเดียวที่มีคุณสมบัติโปร่งใสและใช้ได้กับทุกBrowser
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รูปที่ 4.8  ตัวอย่างการ Save File แบบ Gif ที่มีลักษณะ โปร่งใส (Transparent)

โดยทั่วไปแล้ว สามารถใช้ .Gif ได้กับรูปภาพทุกประเภท  โดยเฉพาะ รูปGraphic, รูปแผนภูมิ และGraphicที่ประกอบด้วยตัวอักษร แต่สำหรับภาพถ่ายหรือรูปที่มีโทนสีต่อเนื่อง มีสีเยอะ จะเหมาะกับแบบ .JPEG มากกว่า ซึ่งจะให้ภาพที่มีคุณภาพสูงกว่าและขนาด File จะเล็กกว่าอีกด้วย
การ Save for Web แบบ Gif
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รูปที่ 4.9  
ส่วน Graphic รูปแบบ JPEG ความละเอียดของสี 16.7 ล้านสี
เหมะสำหรับการบีบอัดรูปภาพ ประเภท ภาพที่มีสีเยอะ, รูปถ่าย, รูปเสมือนจริง
[image: image94.jpg]



รูปที่ 4.10 ตัวอย่างรูปในลักษณะ ของ JPEG
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รูปที่ 4.11 ตัวอย่าง Window optimize แบบ JPEG

การ Crop File 

คือการตัดภาพเป็นส่วนๆเพื่อเตรียมเป็น File วัตถุดิบ ก่อนจะนำไปประกอบในการจัด html

การ Crop File ภาพ แบบที่1    (ภาพทั้งผืนมาต่อกัน)  ใช้ Grid แบ่งภาพที่ออกแบบเป็นส่วนๆ แล้ว Crop ภาพเป็นชิ้นๆ แล้วจึงค่อยนำมาต่อกันในโปรแกรม Golive คล้ายการต่อ จิ๊กซอว์
การ Crop File ภาพ แบบที่ 2    (ตัดทีละส่วนและมี ภาพ background )

ใช้ Grid แบ่งภาพ และเลือก Crop เฉพาะบริเวณที่มีรูปภาพอยู่โดยไม่เอา background 

แล้วCrop ภาพเป็นชิ้นๆ แล้วจึงค่อยนำมาต่อกันในโปรแกรม Golive
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รูปที่ 4.12  ตัวอย่างในการ Crop file
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รูปที่ 4.13 หลังจากตัดไฟล์เป็นส่วนๆแล้ว
ขั้นตอนการ Crop File + Save for Web

1.  เลือกอุปกรณ์ Crop แล้วนำมา Crop File ภาพที่ต้องการ
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2.  ปรับขนาดให้พอดีกับภาพ (ถ้าต้องการยกเลิกกด ESC)

     กด Enter (ถ้าต้องการยกเลิกกด ESC)
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3.  ไปที่เมนู File เลือก Save for Web   เลือกรูปแบบการ save ตามลักษณะของรูปภาพ
[image: image100.png]Save For Web
[Grignal_(Optimized_ 2-Up “(a-lp. >
9 Save

sotogs [t
3 Y 50l
= Selective ¥ (0] Colors: & 64 v
v %] o100 )]
et 0

o Teaspre 18] At
Dlwwicss WebSonon 5

Cotor Table

righal: "bm._hemepagepsd” ar 10056 ditnar
08K 890 bytes Selective palete
Tsec @ 2asKts 4 colors.
100%  w|[R G B Apa o Hec  — hiec — -1





4.  Edit Step Backward เพื่อกลับไปยังรูปต้นฉบับ กลับไปเลือกอุปกรณ์
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ผู้แต่ง  อ. วีรวัลย์  เกษรศิริ







Email :: aom@netdesign.ac.th
บทที่ 5

การสร้างงาน HTML ด้วยโปรแกรม Adobe Golive 6 อย่างมีประสิทธิภาพ

จากเนื้อหาในส่วนของบทที่ 1 – 4 ที่ผ่านมาเป็นการอธิบายถึงการออกแบบหน้าตาของ WebPage ด้วยโปรแกรม Adobe Photoshop เพื่อเตรียมวัตถุ และรูปภาพ ในการจัดหน้า Homepage และ WebPage และในบทนี้จะนำวัตถุ และรูปภาพดังกล่าวมาจัดเรียงอย่างมีประสิทธิภาพ เป็นขั้นตอน และถูกหลักในการสร้าง  Web Site  โดยใช้โปรแกรม Adobe Golive 6 


โปรแกรม Adobe Golive 6 เป็นโปรแกรมประเภท Web Editor ที่มีประสิทธิภาพสูง และมีความสามารถที่โดดเด่นกว่า โปรแกรม Web Editor อื่นๆ ด้วยอุปกรณ์ Layout Grid ที่ช่วยเพิ่มอิสระในการออกแบบ  Web Site  อย่างที่ Web Editor ตระกูลอื่นไม่มี และการจัดการภาษา Dynamic HTML (DHTML) อย่างง่ายดาย ด้วย Timeline Editor และ Action ที่มีให้เลือกอย่างมากมาย เพื่อให้เหมาะกับการตกแต่งหน้า WebPage ของเปรียบเสมือน Webmaster มืออาชีพเลยทีเดียว

ในบทนี้จะได้ทราบถึงวิธีการใช้งานโปรแกรม Adobe Golive 6 เพียงแค่ความสามารถของอุปกรณ์ไม่กี่ตัวที่จะกล่าวถึงในบทนี้ ก็สามารถทำให้สร้าง  Web Site  ได้แล้ว
เนื้อหาของบทนี้ สามารถแบ่งออกเป็นหัวข้อหลักดังนี้ 
1. องค์ประกอบของโปรแกรม Adobe Golive 6 

· Tab อุปกรณ์พื้นฐาน
2. Main Tab

· Layout

· Frames

· Source

· Outline

· Preview

3. การสร้างเอกสาร .html

· ขั้นตอนและเทคนิคในการสร้าง Webpage 

องค์ประกอบของโปรแกรม Adobe Golive 6


หลังจากที่เปิดโปรแกรม Adobe Golive 6 ขึ้นมาแล้ว จะพบหน้าจอดังรูปที่ 5.1
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รูปที่ 5.1 หน้างานหลักของโปรแกรม Adobe Golive 6

จะสังเกตเห็นว่ามีหน้าต่างของเครื่องมือพื้นฐานอยู่ 2 กรอบ ซึ่งต่อไปนี้จะเรียกแฟ้มอุปกรณ์ในหน้าต่างนี้ว่า พาเลท (Palette) และสำหรับในบทนี้จะกล่าวถึง พาเลท Object, Color และพาเลท Inspector ซึ่งเป็นพาเลท ของอุปกรณ์พื้นฐานในการจัดการและควบคุมการสร้างหน้า Web ของ ซึ่งจะมีรายละเอียดดังนี้
- Palette Object
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รูปที่ 5.2 อุปกรณ์ต่างๆ ในพาเลท Object


ที่พาเลท Object จะแบ่งส่วนการทำงานออกเป็น 2 ส่วน คือ 
- Tab อุปกรณ์หลัก มีทั้งหมด 11 ชุด แต่จะขอกล่าวเพียง 5 ชุดแรกที่ใช้ในการสอนเท่านั้น ดังนี้ 

1. Tab Basic
เป็นชุดอุปกรณ์พื้นฐานที่ใช้ในการจัดการรูปแบบของ Webpage แต่ละหน้า
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รูปที่ 5.3 Tab Basic

2. Tab smart
เป็นชุดอุปกรณ์ ในส่วนของการตกแต่งและเพิ่มลูกเล่น เทคนิค ให้หน้า Webpage มีสีสันมากขึ้น
[image: image105.png]



รูปที่ 5.4 Tab smart

3. Tab forms
เป็นชุดอุปกรณ์ในการตกแต่งส่วนที่เป็นแบบฟอร์ม รับค่าต่างๆ
[image: image106.png]



รูปที่ 5.5 Tab forms

4. Tab Head
เป็นชุดอุปกรณ์สำหรับเพิ่ม Tag “<>” คำสั่งต่างๆ ที่ช่วงของ Tag Head 
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รูปที่ 5.6 Tab Head

5. Tab Frames
เป็นชุดอุปกรณ์ในการจัดการโครงสร้างของ  Web Site  ที่สร้าง ในรูปแบบของ Frames
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รูปที่ 5.7 Tab Frames

- Tab อุปกรณ์ย่อย จะเปลี่ยนแปลงไปตาม Tab อุปกรณ์หลัก โดยจะมีอุปกรณ์ที่ใช้งานจำแนกเป็นหมวดหมู่ ตาม Tab อุปกรณ์หลัก โดยจะขออธิบายที่ส่วนเนื้อหาของแต่ละช่วงของการทำงานเพื่อให้เข้าใจง่ายมากขึ้น
- Palette Color
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รูปที่ 5.8 อุปกรณ์ต่างๆ ในพาเลท Color

ที่พาเลท Color จะแบ่งส่วนการทำงานออกเป็น 2 ส่วนเช่นเดียวกันกับ พาเลทอื่นๆ โดยอุปกรณ์หลักที่ พาเลทนี้ จะเป็นการแยกประเภทการค้นหาสีที่ต้องการใช้ในแต่ละความต้องการ และความถนัด แบ่งได้ดังนี้
1. Tab Gray Slider
จะเป็นการไล่เฉดสีในส่วนของโทนสีเทา ใช้การเลือกเป็นแถบเลื่อน
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รูปที่ 5.9 Tab Grey Slider

2. Tab RGB Sliders
เป็นการไล่เฉดสีในลักษณะของ RGB Color ใช้การเลือกเป็นแถบเลื่อน
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รูปที่ 5.10 Tab RGB Sliders

3. Tab CMYK Sliders
เป็นการไล่เฉดสีในลักษณะของ CMYK Color ใช้การเลือกเป็นแถบเลื่อน
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รูปที่ 5.11 Tab CMYK Sliders
4. Tab HSB Wheel
เป็นการเลือกสีลักษณะแบบถาดสี
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รูปที่ 5.12 Tab HSB Wheel
5. Tab HSV Picker
เป็นการเลือกสีลักษณะที่เลือกโทนสีก่อน แล้วค่อยเลือกสี จากถาดสีตรงกลาง
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รูปที่ 5.13 Tab HSV Picker
6. Tab Palettes
เป็นการเลือกสีที่จัดไว้ให้ จะคล้ายกับการใช้งานที่ Palette Color ของโปรแกรม Adobe Photoshop 
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รูปที่ 5.14 Tab Palettes

7. Tab Web Color list

เป็นการเลือกสีในลักษณะที่มีการใช้งานที่บ่อยที่สุด และเหมาะสำหรับการทำงานในรูปแบบที่ต้องมีการกำหนดค่าสีที่แน่นอน สีที่อยู่ในแถบนี้จะเป็นสีที่ใช้ใน  Web Site  ได้โดยจะไม่มีการเพี้ยนของสี
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รูปที่ 5.15 Tab Web Color List
8. Tab Web Name List
คล้ายกับ Tab Web Color List แต่จะแสดงสีเป็นชื่อที่ใช้เรียกในWeb Site 
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รูปที่ 5.16 Tab Web Name List

9. Tab Site Color list

ในส่วนของแถบนี้ จะไม่นำมาใช้ในการเรียน จึงไม่ขอกล่าวถึง
- Palette Inspector


ในส่วนของ พาเลทนี้ มีหน้าที่ในการกำหนดลักษณะสภาวะการทำงานต่างๆ ที่เกิดขึ้นจากการสร้าง Web page ปุ่ม Tab จะเปลี่ยนตามลักษณะการทำงานที่เกิดขึ้น เป็นคุณสมบัติของอุปกรณ์ในแต่ละตัว มีความสำคัญเป็นอย่างมากกับการทำงาน
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รูปที่ 5.17 Palette Inspector

เตรียมพร้อมทำงานออกแบบหน้า Web page


ก่อนที่จะเข้าสู่เนื้อหาในการสร้าง Web Page จะขอแนะนำส่วนที่เป็น Main Tab ที่ต้องใช้งานตลอด 
- หน้าต่าง Layout (Layout Editor)

ใช้สำหรับออกแบบหน้า Webpage ซึ่งหน้า Webpage ที่ถูกสร้างขึ้นมานี้สามารถนำ Object ต่างๆ เข้าไปร่วมทำงานได้ 
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รูปที่ 5.18 หน้าต่าง Layout

- หน้าต่าง Frame (Frame Editor)

หน้าต่าง Frame มีหน้าที่สำหรับออกแบบหน้า Web page ที่มีการจัดโครงสร้างเป็นลักษณะของหน้าจอแบบเฟรม
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รูปที่ 5.19 หน้าต่าง Frame

- หน้าต่าง Source (Source Code Editor)

หน้าต่าง Source มีหน้าที่แสดงผลการทำงาน ออกมาในลักษณะโค้ด คำสั่งภาษา HTMLที่ถูกสร้างขึ้นมา 
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<meta name="generator’ content="Adobe GoLive 6"
<title>Welcome to Adobe GoLive G<title>
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รูปที่ 5.20 หน้าต่าง Source

- หน้าต่าง Outline (Outline Editor)

หน้าต่าง Outline จะแสดงโครงสร้างของโค้ดภาษา HTML ทำให้ดูง่ายมากขึ้น โดยสามารถ เพิ่มเติม ลบ หรือแก้ไขโค้ดภาษา HTML ได้
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รูปที่ 5.21 หน้าต่าง Outline
- หน้าต่าง Preview (Layout Preview)

หน้าต่าง Preview จะแสดงผลลัพธ์ ที่เกิดขึ้นจากการสร้าง Webpage ซึ่งเปรียบเสมือนกับ การแสดงผลบนโปรแกรม Browser
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Tip & Trick
แต่ละหน้าต่างจะมีความสัมพันธ์กัน โดยถ้ามีการแก้ไขเกิดขึ้น หน้าต่างอื่นๆจะมีผลกระทบตามไปด้วย

ขั้นตอนการเตรียมเอกสาร .html (Web page)

Workshop

หลังจากที่ได้ทำความรู้จักกับองค์ประกอบต่างๆ ของอุปกรณ์พื้นฐานในโปรแกรม Adobe Golive 6 กันมาบ้างแล้ว เนื้อหาต่อจากนี้จะเริ่มเข้าสู่กระบวนการทดลองทำหน้า Webpage อย่างง่าย รวมไปถึงการสร้างจุดเชื่อมโยง (Link) ให้กับ Webpage แต่ละหน้าอย่างมีประสิทธิภาพและไม่ซับซ้อน โดยจะแบ่งขั้นตอนในการสร้างหน้า Webpage ออกเป็น 4 ขั้นตอน ดังนี้
1. การสร้างหน้า Webpage (เอกสาร .html)

2. การพิมพ์ Text 

3. การสร้างจุดเชื่อมโยง (Link) ให้กับหน้า Webpage
4. การบันทึกงานอย่างถูกหลักก่อนทำการ Upload 

Step 1 : การสร้างเอกสาร .html

ในขั้นตอนนี้จะมาทดลองสร้างหน้า Webpage จากไฟล์งานตัวอย่างอ้างอิงที่ได้เตรียมเอาไว้ 2 หน้า 

ได้แก่ 
- หน้า Webpage ที่เป็นหน้า Homepage
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รูปที่ 5.22 หน้าตัวอย่างที่นำมาเป็น Home page

- และ หน้า Webpage ที่เตรียมใช้ทดสอบทำ Link 
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รูปที่ 5.23 หน้าตัวอย่างอีกหน้าหนึ่งนำมาเป็น Web page

1. เริ่มสร้างหน้า Homepage โดยเปิดไฟล์เอกสารใหม่โดยใช้คำสั่งจากเมนู File > New Page
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รูปที่ 5.24 สร้างเอกสารใหม่จากเมนู File

2. เริ่มต้นทำงานในแท็บ Layout ในส่วนของ Page Properties Click เลือกที่สัญลักษณ์รูปกระดาษพับมุม
       สีม่วง 
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รูปที่ 5.25 การเลือกทำงานที่ Page Properties
หลังจากนั้นให้สังเกตที่ Palettes Inspector ทำการเปลี่ยนชื่อ Title กำหนด Background ของหน้า Webpage ว่าต้องการให้เป็น Background Colors หรือ Background Image และทำการกำหนดค่าชิดขอบของวัตถุให้พอดีกับหน้าต่าง Layout ในส่วนของค่า Margin Width = 0 และค่า Margin Height = 0 

[image: image127.png]Inspector
Page ML\
Title ‘elcome to My first website|

Text Colars
Clvext M [actve Lk [m—
Clunk W [visted Uk [

Backyround

(e |-
[aE CO—]

Margin width [0 Height [0





รูปที่ 5.26 การกำหนดค่าเตรียมทำงานที่ Inspector Page Properties

3. นำอุปกรณ์ Layout Grid ที่อยู่ใน Palettes Basic มาวางที่หน้า Layout แล้วกำหนดค่าความกว้าง ความสูงตามที่ได้ออกแบบเอาไว้ใน Photoshop ในช่อง Width และ Height 
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รูปที่ 5.27 การจัดวางอุปกรณ์ และตั้งค่า Layout Grid
4. เปิด Palettes Tracing Image ในเมนู Window > Tracing Image 
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รูปที่ 5.28 เมนู Tracing Image

แล้ว Browse ภาพที่เป็นต้นแบบใน Photoshop ขึ้นมาเพื่อเป็นไกด์ในการจัด Layout ของตำแหน่งภาพแต่ละรูป โดยClickที่ช่อง Source แล้วClickที่แฟ้มสีเหลืองเพื่อ Browse ภาพที่ต้องการมา จากนั้นจะมีภาพต้นแบบปรากฏให้เห็นลางๆ ทางด้านหลังเป็นการอำนวยความสะดวกในการจัดวางรูปภาพลงบน Layout Grid ได้ตรงตามตำแหน่งที่ออกแบบเอาไว้ใน Photoshop
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รูปที่ 5.29 การตั้งค่าที่ เมนู Tracing Image
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Tip & Trick
การปรับค่า Opacity ที่ Palettes ของอุปกรณ์ Tracing Image เป็นการกำหนดค่าความเข้มจางของภาพ Background ซึ่งสามารถปรับค่าความเข้มของภาพ Background ได้ตามต้องการ
5. ขั้นตอนต่อมาก็คือการนำเอารูปภาพแต่ละรูปที่ได้ Crop มาเป็นชิ้นๆ จาก Photoshop มาวางประกอบกันบนพื้นที่งานที่ปูอุปกรณ์ Layout Grid เตรียมเอาไว้
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รูปที่ 5.30 วัตถุรูปภาพที่จัดเตรียมมาจาก Photoshop

โดยใช้อุปกรณ์ Image ที่อยู่ใน Palettes Basic มาวางแล้วClickที่แฟ้มสีเหลืองเพื่อ Browse ภาพขึ้นมา โดยในเริ่มต้นวางภาพจากมุมบนซ้ายมาทางด้านขวา และด้านล่าง เนื่องจากภาพที่ Browse ขึ้นมาจะดันตัวจากทางด้านซ้ายไปขวาเสมอ 
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รูปที่ 5.31 อุปกรณ์ Image ,Inspector ของ Image
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Tip & Trick
      การนำวัตถุมาจัดวางลงบน Layout Grid แล้วไม่สามารถจัดให้วัตถุแต่ละชิ้นติดกันได้        เนื่องมาจากวัตถุตัวนั้นถูกคำสั่งให้ Snap ติดอยู่กับ Layout Grid หากต้องการให้     การจัดวางวัตถุบน Layout Grid เป็นอิสระ ให้มาปรับค่า Snap ที่ Inspector  โดยการClickเครื่องหมายถูกที่ช่อง Snap ออกทั้งหมด ส่วนคำสั่ง visible หาก Click     เครื่องหมายถูกออกจะเป็นการซ่อนเส้น Grid 

หลังจากที่จัดเรียงรูปเสร็จแล้ว อาจมีความคลาดเคลื่อนของอุปกรณ์ Layout Grid เนื่องจากการวาง Image ไม่ตรงจุดในตอนแรก ทำให้ Layout Grid ถูกดันออกไป ให้เลือกที่อุปกรณ์ Layout Grid แล้วสังเกตที่แถบ Inspector ถ้าขนาดของ Layout Grid ไม่ตรงกับที่ตั้งไว้ตอนแรก ให้Clickเลือกที่ปุ่ม Optimize จะเป็นการลดขนาด Layout Grid เข้ามาชิดกับวัตถุที่อยู่นอกสุด
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รูปที่ 5.32 Inspector ขณะทำงานที่อุปกรณ์ Layout Grid
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Tip & Trick
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หากต้องการปรับขนาดของ Grid ให้มีขนาดเท่าเดิมให้ปรับค่าที่ Inspector Clickที่ Optimize ขนาดของ Grid จะย่อลงมาชิดกับวัตถุ แต่ถ้าหากมาปรับขนาดของ Grid โดยการพิมพ์ค่าลงไปในช่อง width กับ height ให้มีขนาดเท่าเดิมในบางครั้งเมื่อเวลาที่ preview อาจทำให้ Layout ของวัตถุที่วางลงไปกระจัดกระจายได้

ในขั้นตอนนี้ การออกแบบที่จัดไว้ในส่วนของรูปภาพก็เสร็จสมบูรณ์ ในส่วนต่อไปจะเป็นเกี่ยวการจัดเนื้อหา ข้อความต่างๆ ของ  Web Site 
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รูปที่ 5.33 แสดงผลของการจัดเรียงภาพที่เสร็จแล้วผ่านทาง Browser

[image: image374.jpg]You can walk
through our product
categories

Praf¥ou gus

company




      Tip & Trick

สรุปขั้นตอนการสร้างเอกสาร .html

1. เมื่อเลือกเมนูคำสั่ง File > New 

2. เตรียมเอกสารก่อนจัด Layout

2.1 เปลี่ยนชื่อ Title ที่ Page Properties

2.2 เลือกสี หรือใส่รูปภาพที่ Background

2.3 วางอุปกรณ์ Layout Grid ลงบนพื้นงาน
3. เริ่มจัด Layout รูปภาพด้วยอุปกรณ์ “Image”

4. บันทึกเอกสารหน้าแรก เป็นชื่อ index.html เพื่อใช้เป็นหน้า Homepage และคอยบันทึกงานเป็นระยะๆ ไปตลอด
Step 2 : การพิมพ์ตัวอักษร จัดข้อความ
นำอุปกรณ์ Layout Textbox มาวางลงที่หน้างาน แล้วพิมพ์ข้อความที่ต้องการลงไป จัดเรียงให้เรียบร้อย
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รูปที่ 5.34 อุปกรณ์ Layout Textbox
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รูปที่ 5.35 รูปแบบเมื่อจัดข้อความเรียบร้อยแล้ว

ในส่วนนี้ หากว่าต้องการพิมพ์ภาษาไทย ต้องเปลี่ยนให้ค่ามาตรฐานของ Webpage เป็นอักษร Unicode ก่อน (ใน Program Adobe Golive จะใช้ UTF-8) โดยเข้าไปเลือกที่ Menu File > Document Encoding > Unicode (UTF-8)
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รูปที่ 5.36 การเลือกค่าตัวอักษรเป็น UTF-8

Step 3 : การสร้างจุดเชื่อมโยง (Link)


หลังจากที่ได้ทำการจัดรูปแบบหน้า Layout ของ Webpage และพิมพ์ข้อความโดยใช้อุปกรณ์ Layout Text Box ไปแล้ว จำเป็นที่จะต้องให้หน้า Webpage แต่ละหน้านั้นมีความสัมพันธ์เชื่อมโยงถึงกันได้ โดยอาศัยหน้า Homepage เป็นตัวหลักในการเรียกใช้งาน ในขั้นตอนนี้จะเป็นการสร้างจุดเชื่อมโยง หรือที่เรียกว่า Hyperlink ให้หน้ากับหน้า Webpage แต่ละหน้าให้มีความเหมาะสมกับเนื้อหาที่ต้องการนำเสนอ โดยโปรแกรม Adobe Golive สามารถสร้างจุดเชื่อมโยงได้หลายๆ จุด และหลายลักษณะในการสร้างจุดเชื่อมโยง ซึ่งในขั้นตอนนี้จะขอยกตัวอย่างการสร้างจุดเชื่อมโยง หรือการทำ Link ที่มีลักษณะเป็น 2 รูปแบบเพื่อเป็นพื้นฐานในการทำความเข้าใจลักษณะการสร้างจุดเชื่อมโยงไว้ดังนี้ คือ 
1. การสร้างจุดเชื่อมโยงด้วยข้อความ ( Text Link )

การสร้างจุดเชื่อมโยงด้วย Adobe Golive นั้นจะกำหนดผ่านทางหน้าต่าง Inspector ซึ่งจะทำงานร่วมกับ Icon นั้นๆ ที่ได้กำหนดใช้งาน โดยเริ่มแรกนี้จะกำหนดการเชื่อมโยงอย่างง่ายๆ ดังนี้
1.1 เลือกข้อความที่ต้องการทำเป็น Link โดยการไฮไลท์เลือกที่ตัว Text 
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รูปที่ 5.37 การเลือกพื้นที่ทำ Link

1.2. หลังจากนั้นให้สังเกตที่ หน้าต่าง Palettes Inspector จะพบว่าลักษณะของคำสั่งใน Palettes Inspector จะเปลี่ยนไปเป็นคำสั่งของ Text ให้Clickที่โซ่ เพื่อทำให้ Text เป็น Link และในช่อง Empty Reference Clickที่แฟ้มสีเหลือง Browse หาไฟล์งานที่ต้องการให้ Link ไปหาขึ้นมา
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รูปที่ 5.38 Clickโซ่ Link แล้วเลือกไฟล์ที่ต้องการ
2. การสร้างจุดเชื่อมโยงด้วยรูปภาพ ( Image Link ) 

การใช้รูปภาพสำหรับการสร้างจุดเชื่อมโยงเป็นอีกวิธีหนึ่งที่ได้รับความนิยมในการนำเสนอWebไซด์ในปัจจุบัน เนื่องจากรูปภาพสามารถสื่อความหมายบางอย่างได้อย่างชัดเจนกว่าข้อความ รวมทั้งสามารถเพิ่มเติมแต่งลูกเล่นต่างๆ ได้อย่างมากมาย วิธีการสร้างจุดเชื่อมโยง Webpage ด้วยรูปภาพนั้นสามารถทำได้ดังนี้
2.1 Clickเลือกรูปภาพที่ต้องการทำเป็น Link 

2.2 หลังจากนั้นให้สังเกตที่ Palettes Inspector จะเปลี่ยนเป็นคำสั่งของ Image

ให้Clickเลือกทำงานที่ Tab Link ให้Clickที่โซ่ เพื่อทำให้ Text เป็น Link และในช่อง EmptyReference Clickที่แฟ้มสีเหลือง Browse หาไฟล์งานที่ต้องการให้ Link ไปหาขึ้นมา 
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รูปที่ 5.39 การเลือกรูปภาพเพื่อทำ Image Link

สำหรับการทำ Image Link นั้น รูปภาพหนึ่งรูปสามารถ Link ไปได้เพียงหนึ่งแห่งเท่านั้น แต่ถ้าหากว่าต้องการให้รูปภาพหนึ่งรูปสามารถทำ Link ไปได้หลายแห่งจะต้องสร้างจุดเชื่อมโยงแบบ Map Link ซึ่งลักษณะของรูปภาพที่เหมาะสมในการทำจุดเชื่อมโยงแบบ Map Link ได้แก่ รูปภาพแผนที่ซึ่งแบ่งเป็นภาคต่างๆ เป็นต้น
Map Link เป็นการทำ Link ที่ภาพ โดยสามารถกำหนดพื้นที่ Link ในภาพได้ และภายในภาพเดียวกันนั้นยังสามารถกำหนดได้หลายๆ พื้นที่ Link อีกด้วย วิธีการสร้างนั้นมีดังนี้
· Clickเลือกรูปภาพที่ต้องการทำเป็น Map Link
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รูปที่ 5.40 เลือกรูปที่ต้องการทำ Map Link

· กำหนดการทำงานที่ Palettes Inspector Clickเลือกทำงานที่ Tab More Clickเลือกที่ช่องของ Use Map เพื่อเป็นการบอกว่าจะใช้งานของ Map ในการกำหนดจุด Link 
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รูปที่ 5.41 Tab More ที่การทำงานของ Image Map

· Clickเลือกลักษณะรูปแบบของการกำหนดขอบเขตบริเวณของ Map Link 
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รูปที่ 5.42 Tool bar ในส่วนของ Image Map

· ลาก Mouse คลุมพื้นที่ที่ต้องการสร้าง Link

· เมื่อทำการกำหนดพื้นที่ของส่วนที่จะทำเป็น Link แล้วให้กลับมาที่ Inspector Clickเลือกที่ช่อง URL แล้ว Browse เลือกไฟล์งานที่ต้องการ Link ไปหาขึ้นมา

หากต้องการสร้างพื้นที่ Link เพิ่มให้Clickเลือกลักษณะการกำหนดรูปแบบขอบเขตบริเวณของ Link และทำซ้ำตามขั้นตอนข้างต้น
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รูปที่ 5.43 ลักษณะการทำ Image Map Link

รูปแบบของการสร้างจุดเชื่อมโยง 
1. การสร้างจุดเชื่อมโยงภายใน  Web Site  

การสร้างจุดเชื่อมโยงภายใน เป็นลักษณะของการทำ Link อยู่ภายใน  Web Site  ของเอง ซึ่งการ Link ภายในนั้นเป็นการทำ Link เพื่อเปิด file.html ซึ่งจะต้องสร้างข้อมูลเป็น file.html ขึ้นมาเก็บเอาไว้ภายใน folder แล้วทำการ Link เพื่อ Browse เอา file.html ที่ต้องการขึ้นมา
2. การสร้างการสร้างจุดเชื่อมโยงภายนอก หรือการสร้างจุดเชื่อมโยงไปหา  Web Site  อื่น
ทำได้โดยการ พิมพ์ URL ของ  Web Site  ที่ต้องการทำการ Link ไปหาที่ช่อง Empty Reference เช่น ถ้าต้องการทำ Link ไปหา Web yahoo ให้ พิมพ์ URL ที่ช่อง Empty Reference ดังนี้ คือ http://www.yahoo.com
3. การสร้างจุดเชื่อมโยงเพื่อส่ง Email

ทำได้โดยการพิมพ์ e-mail address ที่ต้องการลงในช่อง Empty Reference ดังนี้ คือ mailto: ตามด้วย e-mail address ที่ต้องการทำ Link ส่งจดหมายไปหา
4. การสร้างจุดเชื่อมโยงเพื่อการ Download

สำหรับการทำ Link เพื่อการ Download นั้นมีหลักการอยู่ว่า server จะรู้จักไฟล์เอกสารเพียง 3 ตัวเท่านั้น คือ ไฟล์ที่มีนามสกุล .html, .jpg และ .gif ดังนั้นถ้า Link ไปหาไฟล์นามสกุลอื่น เช่น ไฟล์นามสกุล .exe, .zip, ฯลฯ Browser จะขึ้นหน้าต่างให้ Download ไฟล์โดยอัตโนมัติ
Step 4


ขั้นตอนสุดท้ายของบทนี้คือการบันทึกงานที่ทำ เก็บไว้เพื่อเตรียมที่จะนำขึ้นไปใช้จริงที่ server มีหลักการที่ควรทำดังนี้

1. ควรเก็บงานไว้ลักษณะเดียวกับที่ต้องการจะไปเก็บไว้ใน server ในที่นี้จะขอใช้ชื่อ Folder เป็น Websample


2. นำงานเอกสารที่มีนามสกุลเป็น html บันทึกไว้ใน Folder Websample และพร้อมกับสร้าง Folder Image ขึ้นมาใน Folder นี้ด้วย

3. นำภาพที่เตรียมไว้ใช้เข้าไปเก็บไว้ที่ folder Image 


4. ตั้งชื่อ file เอกสารและรูปภาพแต่ละชนิดให้ถูกหลัก ดังนี้

4.1 กฎการตั้งชื่อให้กับ File และ Folder เพื่อใช้ในงาน Web

- ห้ามตั้งชื่อ File งานเป็นภาษาไทย
- ห้ามใช้อักขระพิเศษ เช่น! @  #  $  %  &  ?

- ห้ามใช้ตัวอักษรตัวใหญ่
- ห้ามเว้นวรรค หากจำเป็นควรใช้ เครื่องหมาย “_”



4.2 กฎการตั้งชื่อให้กับหน้าแรกของ  Web Site  


หน้าแรกของ  Web Site  เรียกว่า “Homepage” กฎการตั้งชื่อให้กับหน้า Homepage จะต้องตั้งชื่อว่า index.html เท่านั้น เนื่องจาก เมื่อทำการ Unload ไฟล์งานทั้งหมดของขึ้น server แล้วเมื่อ User พิมพ์ URL ของ server จะค้นหาไฟล์งานที่ชื่อว่า index.html ขึ้นมาแสดงผลเป็นหน้าแรก
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รูปที่  5.44  ลักษณะการตั้งชื่อ และการจัดเก็บ Folder เพื่อเตรียมนำไปใช้จริงบนอินเทอร์เน็ต
Summary


หลังจากที่ได้เรียนจบบทนี้แล้ว จะทำให้สามารถสร้าง Webpage ได้อย่างน้อย 1 หน้า ดังนั้นหมายความว่าเพียงเท่านี้ก็จะทำ  Web Site  ได้แล้ว แต่อาจจะดูเรียบง่ายไป ในบทที่จะเรียนต่อๆไป จะเป็นการจัดการ ตกแต่งให้  Web Site  ของมีประสิทธิภาพ สวยงาม และดึงดูดใจผู้ที่เข้ามาใช้บริการ  Web Site  ของ ด้วยอุปกรณ์อีกหลายๆอย่างที่ง่ายดายและ ไม่ซับซ้อน โดยอาศัยความสามารถของ โปรแกรม Adobe Golive 6



ผู้แต่ง  
อ.ปรกฤษฎิ์ สายหัสดี  






Email :
prite@netdesign.ac.th



อ.ปิยะนันท์ ไกลกล่อม






Email :
poo@netdesign.ac.th
บทที่ 6

การสร้าง Rollover


บางคนอาจจะเคยได้เห็นในบาง Web Site จะมีรูปภาพที่เป็น Link ซึ่งเปลี่ยนแปลงหน้าตาได้เมื่อนำ Mouse ไปวางเหนือ Link นั้น เรียกเหตุการณ์นี้ว่า Rollover ซึ่งหลักการทำก็คือจะมีภาพ 2 ภาพขนาดเท่ากันนำมาสลับกันภาพทั้งสองจะเปลี่ยนไปเมื่อใดก็ขึ้นอยู่กับเหตุการณ์ที่จะเกิดกับภาพนั้นโดยจะมีอยู่ 2 เหตุการณ์ คือ
· เหตุการณ์ปกติ เป็นเหตุการณ์ที่จะปรากฏอยู่ตลอดเวลาถึงแม้ว่าจะไม่ใช้งานใน Web ก็ตาม และเป็นเหตุการณ์ที่นำ Mouse ออกจากภาพอีกด้วย
· เหตุการณ์เมื่อนำ Mouse ไปวางเหนือรูปนั้น จะมีการเปลี่ยนแปลงรูปภาพเกิดขึ้น
การสร้าง Rollover ใน Golive 


เมื่อได้ทำการเตรียมภาพ 2 ภาพเรียบร้อยแล้วในโปรแกรม Golive จะมีอุปกรณ์ที่ทำเกี่ยวกับเรื่อง Rollover โดยตรงดังนี้
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Tip & Trick
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เวลาทำการตั้งชื่อรูปภาพ ถ้าชื่อตอนต้นเหมือนกันแล้วต่อท้ายด้วยคำว่า _over  เวลาทำการ Browse ไฟล์ แล้วมันจะดึงรูปภาพขณะ over ให้ด้วย ซึ่งทำให้ประหยัดเวลาในการ Browse ได้อีกด้วย
การปรับแต่งคุณสมบัติ
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	Name เป็นการตั้งชื่อรูปภาพ

	
	Image เป็นลักษณะเหตุการณ์ที่เกิดขึ้น

	
	Normal เป็นเหตุการณ์ปกติ 

	
	Over    เป็นเหตุการณ์เมื่อนำMouseเข้าไปวางเหนือรูปนั้น

	
	Down เป็นเหตุการณ์เมื่อนำ Mouse Clickลงไปบนรูปนั้น

	
	Brows เป็นการระบุภาพที่ต้องการ

	
	URL เป็นลักษณะเมื่อต้องการทำ Link

	
	Alt Text เป็นข้อความอธิบาย ภาพ

	
	Message เป็นคำอธิบายที่ status bar

	
	Width ความกว้างของรูปภาพ 

	
	Height เป็นความสูงของรูปภาพ

	
	


Tip & Trick
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โดยปกติแล้วการทำ Rollover นิยมทำแค่ 2 เหตุการณ์เท่านั้น คือ Normal และ Over เนื่องจากว่า

เวลาทำการ Clickแล้วก็จะไปยังหน้าอื่นซึ่งไม่ค่อยที่จะเป็นผลเท่าใดนัก อีกทั้งยังเป็นการทำให้ไฟล์

ขนาดใหญ่อีกด้วยเนื่องจากต้องใช้รูปถึง 3 รูปในการสลับ  
การสร้างและการใช้งานตาราง

ตาราง เป็นการแบ่งกรอบใส่ข้อมูลเป็นแนวนอนและแนวตั้ง ซึ่งเป็นเครื่องมือที่สำคัญอีกตัวหนึ่งที่ใช้ในการทำ WebPage โดยการนำตารางมาใช้เพื่อที่จะเป็นการจัดเรียงข้อมูลให้เป็นระเบียบเรียบร้อยและสวยงาม   
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องค์ประกอบของตาราง
ลักษณะของตารางจะประกอบไปด้วยแนวนอน เรียกว่า แถว (Row) และแนวตั้ง  เรียกว่า สดมภ์ (Colum) ช่องทีเกิดจากการแบ่งจากแนวนอนและแนวตั้ง เรียกว่า Cell (Cell)
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Tip & Trick
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เวลานำไปวางครั้งแรก ตาราง จะมีขนาด  3*3 จะต้องหาพื้นที่เพื่อที่จะสามารถให้วางตารางได้
การกำหนดคุณสมบัติ

การกำหนดคุณสมบัติของ ตาราง จะประกอบด้วย  3  ส่วนดังนี้ 

1.  แท็บ Table จะเป็น การควบคุมคุณสมบัติทั้งหมดของตาราง
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	Column = จำนวน สดมภ์ 

	
	Width = กำหนดความกว้างของ ตาราง

	
	Height = กำหนดความสูงของตาราง

	
	Border = กำหนดความหนาของเส้นขอบ

	
	Cell Pad = ระยะห่างระหว่างข้อความถึงขอบ Cell

	
	Cell Space = ระยะห่างระหว่างCell

	
	Color = การใส่สีให้กับ ตาราง

	
	Align = การจัดเรียงราราง

	
	Caption = เป็นลักษณะคำอธิบาย

	
	BgImage = การใส่ พื้นหลังเป็นรูปภาพ

	
	Import = การนำข้อมูลเข้ามาใส่ในตาราง

	
	Export = การนำข้อมูลออกจากตาราง

	
	Convert = การแปลงตารางให้เป็น  Layout Grid   
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2. แท็บ Row เป็นการกำหนดคุณสมบัติของ แถวซึ่งหมายความว่า ถ้าทำการปรับ คุณสมบัติของ แท็บ Row ทุก ๆ Cell ในแถวนี้จะถูกผลกระทบทั้งหมด
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	Vertical Alignment = การจัดเรียงแนวตั้ง

	
	Horizontal alignment = การจัดเรียงแนวนอน

	
	Color = เป็นการเปลี่ยนสีทั้งแถว

	
	Height = การปรับความสูงของ แถว
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Tip & Trick
กรณีที่ไม่สามารถปรับค่าใน แทบ Row ได้เนื่องจาก ไม่ได้เลือกการทำงานในช่อง Cell นั้น ๆ ก่อน
3.  แท็บ Cell เป็นการกำหนดคุณสมบัติของ Cell ซึ่งก็หมายความว่าจะถูกผลกระทบแค่ Cell ใด Cell หนึ่งเท่านั้น
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	Vertical Alignment = การจัดเรียงแนวตั้ง

	
	Horizontal alignment = การจัดเรียงแนวนอน

	
	Color = เป็นการเปลี่ยนสีทั้งแถว

	
	Row Span = เป็นการผสาน Cell แนวตั้ง 

	
	Column Span = เป็นการผสาน Cell แนวนอน

	
	Width =  กำหนดความกว้างของ Cell

	
	Height = กำหนดความสูงของ Cell

	
	BgImage =  การใส่พื้นหลังเป็นรูปภาพ

	
	Add Row/Column = เพิ่มจำนวนแถวและสดมภ์

	
	Delete Row/Column = ลบจำนวนแถวและสดมภ์
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การสร้างแบบฟอร์ม
เมื่อต้องการข้อมูลจากผู้ใช้งาน WebPage  การสร้างแบบฟอร์ม จึงมีบทบาทสำคัญในการรับค่าข้อมูลของผู้ใช้งาน และ ส่วนมากนำมาประยุกต์ใช้กับงานที่มีลักษณะการตอบโต้ กับ ผู้ใช้งาน เช่น การทำระบบสมาชิก (Membership) กระดานข่าว (Web board) หรือ สมุดเยี่ยมชม  (Guestbook) ซึ่งการที่แบบฟอร์มจะทำงานได้นั้นจะต้องอาศัยการเขียนโปรแกรมเข้ามารับค่าข้อมูลที่ผู้ใช้กรอกแล้วนำข้อมูลเหล่านั้น ไปทำการประมวลผลอีกครั้งหนึ่งดังนั้น การใช้งานแบบฟอร์มได้จะต้องมีการเขียนโปรแกรมควบคู่ไปด้วย  ยกตัวอย่างเช่น ASP (Active Server Pages),  PHP (Personal Home Pages), JSP (Java Servlet Pages) Perl  , CGI (Common Gateway Interface)   ภาษาโปรแกรมเหล่านี้เป็นภาษาที่ใช้ในงานWebโดยมีการรับค่าข้อมูลแล้วทำการประมวลผลข้อมูลอีกทีหนึ่ง ผลที่ได้อาจจะเก็บข้อมูลเข้าใน ระบบฐานข้อมูล(Database)  ก็ได้
การสร้างแบบฟอร์มจาก Adobe Golive 
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อุปกรณ์ที่ใช้ในการทำแบบฟอร์ม
1. Form เป็นอุปกรณ์ที่สำคัญมากถ้าจะทำแบบฟอร์มจะต้องนำอุปกรณ์ตัวนี้เข้ามาใช้งานเป็นอับดับแรกสุด แล้วอุปกรณ์อื่น ๆ จะต้องอยู่ภายใน Form  ด้วย
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การปรับแต่งคุณสมบัติ
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	Name  ตั้งชื่อให้กับแบบฟอร์ม

	
	Action เป็นการระบุไฟล์ที่ใช้ในการับค่าข้อมูลจากผู้ใช้งาน แล้วทำการประมวลผล

	
	Encode เป็นการเข้ารหัสข้อมูล

	
	Method  เป็นวิธีการในการส่งข้อมูลมีดังนี้

	
	Get จะปรากฏค่าข้อมูลต่อท้ายปะปนมากับ URL

	
	Post จะไม่เห็นข้อมูลที่ส่งมากับ URL ส่วนมากจะใช้กับ Form

	
	

	
	


2. Text Field 


เป็นอุปกรณ์ที่รับค่าข้อมูลต่าง ๆ ที่ User พิมพ์ มีลักษณะเป็นช่องรับข้อมูล ขนาดบรรทัดเดียว ใช้ในกรณีที่ต้องการรับข้อมูลแบบสั้น ๆ บรรทัดเดียว เช่น ชื่อ นามสกุล ที่อยู่
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การปรับแต่งคุณสมบัติ
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	Name  เป็นการตั้งชื่อให้กับอุปกรณ์

	
	Value  เป็นค่าข้อมูลของอุปกรณ์นี้

	
	Visible  กำหนดความกว้างของ text Field (หน่วยเป็นตัวอักษร)

	
	Max   เป็นการกำหนดจำนวนตัวอักษรสูงสุดที่สามารถพิมพ์เข้าไปได้

	
	Is Password Field เป็นการกำหนดให้แสดงผลข้อมูลแบบ Password 

	
	

	
	

	
	


3. Password 


เป็นอุปกรณ์ที่รับค่าข้อมูลต่าง ๆ ที่ User พิมพ์ มีลักษณะเป็นช่องรับข้อมูล ขนาดบรรทัดเดียวแต่เวลาพิมพ์ข้อความเข้าไปแล้วจะมี เครื่องหมาย  * แทนข้อความ  ใช้ในกรณีที่ต้องการรับข้อมูลแบบสั้น ๆ บรรทัดเดียวและเป็นความลับ เช่น รหัสผ่าน
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การปรับแต่งคุณสมบัติ
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	Name  เป็นการตั้งชื่อให้กับอุปกรณ์

	
	Value  เป็นค่าข้อมูลของอุปกรณ์นี้

	
	Visible กำหนดความกว้างของ อุปกรณ์ password (หน่วยเป็นตัวอักษร)

	
	Max   เป็นการกำหนดจำนวนตัวอักษรสูงสุดที่สามารถพิมพ์เข้าไปได้

	
	Is Password Field เป็นการกำหนดให้แสดงผลข้อมูลแบบ Password 

	
	

	
	

	
	

	
	


Tip & Trick
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4. Text Area 


เป็นอุปกรณ์ที่รับค่าข้อมูลต่าง ๆ ที่ User พิมพ์ มีลักษณะเป็นช่องรับข้อมูล ขนาดหลายบรรทัด  ใช้ในกรณีที่ต้องการับค่าข้อมูลจาก User เป็นจำนวนมาก ๆ เช่น Comment
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การปรับแต่งคุณสมบัติ
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	Name เป็นการตั้งชื่อให้กับอุปกรณ์

	
	Row   จำนวนแถวที่ให้แสดง

	
	Columns  จำนวนตัวอักษรที่ให้แสดง

	
	Readonly เป็นการกำหนดคุณสมบัติให้อ่านได้อย่างเดียวเท่านั้น

	
	Content เป็นข้อความที่จะพิมพ์เข้าไปไว้ก่อนได้

	
	

	
	

	
	


5. File Browser


เป็นอุปกรณ์ ที่ใช้ในการค้นหาไฟล์  ใช้ในกรณีที่ต้องการนำไฟล์จากในเครื่องส่งไปยังที่อื่นอย่างเช่น การส่งแนบไฟล์ไปทาง อีเมล์ หรือการ อัพโหลด 
[image: image420.png]Objects \_ Color
OosE86E®a

Mo ®




[image: image421.png]Inspector \\ View

‘webdesign training -
webdesign school

e schoal

ttraining

netdesign

nondesian

web design

Keywords




[image: image172.png]Objects _coor 0
QOEEE® 22480

EEEEEEEREE
) &) %) = E) 0] @ ) &)

o




   [image: image173.png]Browse.




การปรับแต่งคุณสมบัติ
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	Name เป็นการตั้งชื่อให้กับอุปกรณ์

	
	Visible  กำหนดความกว้างของ File Browser  (หน่วยเป็นตัวอักษร)

	
	

	
	

	
	

	
	

	
	

	
	

	
	


5. Label 


เป็นอุปกรณ์ที่ใช้เป็นข้อความกำกับฟิลด์ ใช้ในกรณีต้องการอธิบายอุปกรณ์ตัวอื่น เช่น Text Field , Password 
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    Label
การปรับแต่งคุณสมบัติ
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	Reference เป็นข้อความที่ให้ปรากฏ

	
	

	
	

	
	


Tip & Trick
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6. Radio

 
เป็นอุปกรณ์ที่ให้ User สามารถเลือก ได้แต่สามารถเลือกเพียงคำตอบเดียวเท่านั้น ใช้ในกรณีที่ต้องการคำตอบจาก User เพียงคำตอบเดียวเท่านั้น เช่น เรื่องเพศ ศาสนา
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การปรับแต่งคุณสมบัติ
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	Group เป็นการกำหนดกลุ่มที่จะให้เลือก

	
	Value  เป็นค่าข้อมูลของอุปกรณ์ตัวนี้

	
	Selected เป็นการเลือกอุปกรณ์ตัวนี้เอาไว้ก่อน

	
	

	
	

	
	

	
	

	
	


[image: image427.png]K Adobe GoLive - index.html.

Ml Gt Dpe Soedel Ste Daram Wove Vew Window o

B 7 T [nene v @ *

Nore v

Lyout L3 {5 5ource 0 G preview L3\

¢ AESERT 0 i

<htmi>

<head>

<ﬂﬂe>NetDes\in sim VDUYWai to Success</iitle>

<ihead>



Tip & Trick

7. Check Box


เป็นอุปกรณ์ที่ให้ User ทำการเลือกข้อมูล โดยที่  User สามารถเลือกได้กี่ตัวก็ได้ ใช้ในกรณี ถามเรื่องที่สามารถตอบได้หลายคำตอบ เช่น ความชอบ           
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Adobe Photoshop 
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Adobe Golive
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การปรับแต่งคุณสมบัติ
	[image: image184.png]Inspector  View

Name

value

e

checkbafiame.

checkboxvalue

™ 1ab [0 5] key [
I Disabled
I Selected

Form Check Bax





	Name  เป็นการตั้งชื่อให้กับอุปกรณ์

	
	Value  เป็นค่าข้อมูลของอุปกรณ์ตัวนี้

	
	Selected เป็นการเลือกอุปกรณ์ตัวนี้เอาไว้ก่อน

	
	

	
	

	
	

	
	

	
	

	
	


Tip & Trick


กรณีที่มีการตั้งชื่ออุปกรณ์เหมือนกัน ข้อมูลที่ส่งมาจะส่งในรูปแบบ name = value1,value2 จะมี , คั่นข้อมูล
8.List Box


เป็นอุปกรณ์ที่ให้ User ทำการเลือกข้อมูล โดยที่  User สามารถเลือกได้กี่ตัวก็ได้โดยที่มีข้อมูลให้ User ทำการเลือกค่อนข้างมาก
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การปรับแต่งคุณสมบัติ
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	Name เป็นการตั้งชื่อให้กับอุปกรณ์

	
	Row เป็นจำนวนแถวที่จะแสดงข้อมูล

	
	Multiple Selection สามารถเลือกตัวเลือกได้หลายตัว

	
	Lable  เป็นรายการทีจะโชวให้เลือก

	
	Value  เป็นค่าของข้อมูลที่ user เลือก

	
	New  เป็นการเพิ่มจำนวนรายการเข้าไป

	
	Delete เป็นการลบรายการที่ไม่ต้องการ

	
	


Tip & Trick


อุปกรณ์ตัวนี้ไม่ค่อยได้รับความนิยมเนื่องจากเวลาที่จะทำการเลือกหลายตัวเลือก จะต้องทำการ
กดปุ่ม Ctrl ก่อนถึงสามารถเลือกได้ซึ่งบาง User ไม่ทราบทำให้เห็นว่าเลือกได้ตัวเดียวเท่านั้น
9. Popup


เป็นอุปกรณ์ที่มีลักษณะการทำงานคล้ายกับ ตัว Radio คือสามารถที่จะเลือกคำตอบได้แค่คำตอบเดียว แต่จะประหยัดพื้นที่ได้เป็นจำนวนมากกว่า ใช้ในกรณีที่ต้องการคำตอบเพียงคำตอบเดียวแต่มีตัวเลือกให้เลือกมาก เข่น ประเทศ อำเภอ หรือจังหวัด
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การปรับแต่งคุณสมบัติ
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	Name เป็นการตั้งชื่อให้กับอุปกรณ์

	
	Row เป็นจำนวนแถวที่จะแสดงข้อมูล

	
	Multiple Selection สามารถเลือกตัวเลือกได้หลายตัว

	
	Lable  เป็นรายการทีจะโชวให้เลือก

	
	Value  เป็นค่าของข้อมูลที่ user เลือก

	
	New  เป็นการเพิ่มจำนวนรายการเข้าไป

	
	Delete เป็นการลบรายการที่ไม่ต้องการ

	
	


Tip & Trick


ถ้าอุปกรณ์ Popup ถูก Check ที่ Multiple Selection จะกลายเป็นอุปกรณ์ List Box ทันที ดังนั้นถ้าไม่ต้องการให้ User สามารถเลือกได้หลายคำตอบ ห้าม Check ที่ Multiple Selection

10. Hidden 


เป็นอุปกรณ์ที่ใช้ในการส่งข้อมูลไปยังไฟล์ที่จะประมวลผลแต่จะไม่ปรากฏให้เห็นบริเวณหน้างาน ใช้ในกรณีที่ต้องการส่งข้อมูลบางอยู่ไปให้ไฟล์นั้น ๆ โดยเฉพาะ
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การปรับแต่งคุณสมบัติ
	[image: image193.png]Inspector  View

Name [ Fiddentiame

e

vaue  [Fiddenvalue

T~ pisabled

Form Hidden





	Name เป็นการตั้งชื่อให้กับอุปกรณ์

	
	Value  เป็นค่าข้อมูลของอุปกรณ์ตัวนี้

	
	

	
	


อุปกรณ์ประเภทปุ่ม (Button)  แบ่งออกเป็น 4 ชนิดคือ
1. Submit

2. Reset

3. Button

4. Image

1. Submit Button 


เป็นปุ่มอีกชนิดหนึ่งเมื่อทำการกดแล้วจะทำการเริ่มทำการส่งข้อมูลตรงนี้ไปให้ไฟล์ทีระบุไว้ในส่วน Action ของ Form  เริ่มรับข้อมูลและประมวลผล
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การปรับแต่งคุณสมบัติ
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	Button เป็นตัวที่ใช้ในการกำหนดคุณสมบัติของปุ่ม (Submit)

	
	Name เป็นการตั้งชื่อให้กับอุปกรณ์

	
	Label  เป็นข้อความที่จะแสดงบริเวณปุ่ม

	
	

	
	

	
	


2. Reset Button


เป็นปุ่มอีกชนิดหนึ่งเมื่อทำการกดแล้วจะทำการลบข้อมูลให้เป็นค่า ปกติตามที่ทำการเปิดหน้าแบบฟอร์มขึ้นมาครั้งแรก
                          [image: image197.png]Reset
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	Button เป็นตัวที่ใช้ในการกำหนดคุณสมบัติของปุ่ม (Reset)

	
	Label  เป็นข้อความที่จะแสดงบริเวณปุ่ม

	
	

	
	

	
	

	
	


3. Button 


เป็นปุ่มอีกชนิดหนึ่งเมื่อทำการกดแล้ว จะไม่มีอะไรเกิดขึ้น โดยส่วนมากใช้ในการเขียนโปรแกรมเป็นส่วนมาก
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	Button เป็นตัวที่ใช้ในการกำหนดคุณสมบัติของปุ่ม (Normal)

	
	Name เป็นการตั้งชื่อให้กับอุปกรณ์

	
	Label  เป็นข้อความที่จะแสดงบริเวณปุ่ม

	
	

	
	


4. Image Button


เป็นปุ่มอีกชนิดหนึ่งที่ทำหน้าที่ตัวเดียวกันกับ ปุ่ม Submit แต่สามารถที่จะใช้รูปภาพเข้ามาแทนได้ ใช้ในกรณีที่ต้องการตกแต่งแบบฟอร์มให้สวยงามขึ้น
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	การปรับคุณสมบัติให้มาที่ แท็บ More  แล้วให้ทำการ check     Is Form  ให้เรียบร้อย เท่านี้ภาพนี้ก็มีคุณสมบัติเป็นอุปกรณ์ในการกดแทน submit button

	
	


การใช้งานอุปกรณ์เก็บข้อมูลของแบบฟอร์ม

ข้อมูลที่จะประมวลผลจากแบบฟอร์ม มิได้มาจากข้อความที่พิมพ์ลงไปหน้างาน ใน Layout แต่ได้มาจากการอุปกรณ์แต่ละตัวที่วางลงไปในหน้างาน โดยที่ 


Name หรือ Group หมายถึง ข้อความที่เป็นคำถาม

Value หมายถึง ข้อความที่เป็นคำตอบ
การเก็บข้อมูลนั้น จะแบ่งออกเป็นสองประเภท คือ 

1. ให้ User พิมพ์ข้อมูลที่เป็นคำตอบเอง ได้แก่ Text Field, Text Area และ Password  ในการกำหนดข้อมูลที่จะส่งไปประมวลผลนั้น ให้กำหนดแต่เพียง Name  ไม่ต้องกำหนด  Value เพราะ User จะเป็นผู้กำหนดคำตอบเอง ตัวอย่าง ใช้อุปกรณ์ Text Field   เก็บข้อมูล 

กำหนดใน  Inspector  


Name  คือ email


เมื่อ User  พิมพ์ contact@netdesign.ac.th  เป็นคำตอบลงไปในอุปกรณ์ Text Field จะได้รับข้อมูลที่ประมวลผลเป็น email=contact@netdesign.ac.th หมายความว่า email คือคำถาม และ contact@netdesign.ac.th เป็นคำตอบของ User


2. กำหนดเป็น Choice  ให้ user เลือกข้อมูลที่เป็นคำตอบเท่านั้นไม่ต้องทำการพิมพ์ข้อมูล ได้แก่ Check box , Radio Button, popup, List Box ให้กำหนดทั้ง name และ value  ตัวอย่างเช่น ใช้อุปกรณ์ Check Box เป็นอุปกรณ์เก็บข้อมูลเกี่ยวกับBrowser ที่ใช้อยู่ โดยมี 2 คำตอบให้เลือก คือ 
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 Internet Explorer   

      
Name = browser 

       
Value = ie

[image: image207.png]


 Netscape Navigator   

       
Name = browser 

      
Value = nn


หาก User เลือก ทั้ง 2 ตัว ข้อมูลที่ส่งมา ก็จะ เป็น Browser = ie , nn
ขั้นตอนการทำงานของ Form Mail 



ขั้นตอนการทำงานของแบบฟอร์มก็คือเมื่อ User ทำการกรอกข้อมูลใน Web เรียบร้อยแล้วก็จะทำการกดปุ่ม Submit ดังนั้นข้อมูลก็จะถูกส่งไปให้ ไฟล์  ที่จะทำการรับค่าข้อมูลที่ ที่ User กรอกมา เพื่อทำการประมวลผล ซึ่งเป็นไฟล์ที่จะต้องมี ระบบที่มีการเขียนโปรแกรมด้วยภาษาโปรแกรมชนิดใดชนิดหนึ่งเข้ามาช่วย เช่น ASP , PHP ,JSP , Perl ,CGI เมื่อทำการรับค่าข้อมูลเรียบร้อยแล้วก็จะเริ่มทำการประมวลผลเสร็จเรียบร้อยผลที่ได้ก็จะขึ้นอยู่กับว่าต้องการให้ทำอะไรกับข้อมูลนั้นคือจะมีอีเมล์ส่งไปยังผุ้เป็นเจ้าของ  Web Site  นั้น ๆ 
ตัวอย่างการทดลองส่งแบบฟอร์ม

การที่แบบฟอร์มจะทำงานได้สมบูรณ์นั้นจะต้องมีการประมวลผลจากโปรแกรมที่ได้เขียนขึ้น ซึ่งจะมีตัวอย่างให้ทดลองส่งข้อมูล โดยผ่านไปยังไฟล์ซึ่งทางโปรแกรมเมอร์ของ  Netdesign ได้ทำการเตรียมไว้ จะต้องกำหนดค่าดังนี้
Action   http://www.netdesign.ac.th/mail.asp
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1  


Name = mailto


Value = (email address ของแต่ละคน)

[image: image209.png]



2


Name = subject


Value = เป็นหัวเรื่องของ email ที่จะส่งไป
[image: image210.png]



3


Name = Web 


Value = http://www.netdesign.ac.th/thanks.html (หรือ URL ของ Web page ที่เป็นหน้าที่โชว์ขึ้นมาหลังจากประมวลผลเรียบร้อยแล้ว








ผู้แต่ง  อ. พงศ์เพชร  มีทรัพย์







email :: oaun@netdesign.ac.th
บทที่ 7

เฟรมและภาพเคลื่อนไหว

ในการสร้าง  Web Siteผู้ผลิตสามารถใช้เครื่องมือในการจัดรูปแบบของ  Web Site ได้ หลายชนิด เช่น Grid หรือ Table  แต่ยังมีรูปแบบในการสร้าง  Web Site อีกหนึ่งชนิด ที่เป็นที่นิยมใช้กันอย่างแพร่หลาย เครื่องมือชนิดนี้เรียกว่า “เฟรม”


ลักษณะเด่นที่เห็นได้ชัดจากการสร้าง  Web Site  ด้วยการใช้เฟรมก็คือ พื้นที่หน้าจอของ  Web Site  จะมีการแบ่งพื้นที่แยกออกจากกัน เป็น 2 หรือ 3 ส่วน โดยลักษณะ ของการแบ่งพื้นที่แยกออกจากกันที่พบเห็นบ่อย ๆ ในการทำ  Web Site  เช่น SHAPE  \* MERGEFORMAT 



ตัวอย่าง  Web Site  Site ที่ใช้เฟรมในการออกแบบ





โครงสร้างของ  Web Site  Site ที่ใช้เฟรมในการออกแบบ
จากบทที่ผ่าน ๆ มาจะทราบว่าในการผลิต Web Site ขึ้นมาหนึ่งหน้า (ไฟล์  .html หนึ่งไฟล์) จะสามารถนำไปเปิดแสดงผลผ่าน Browser  แล้วเห็นได้หนึ่งหน้าเช่นกัน  แต่การสร้าง Web Site ด้วยการใช้เฟรมนั้น การมองเห็นรูปแบบของ Web Site ที่เป็นเฟรม แบบสองส่วนนั้น จำนวนไฟล์ที่ใช้ในการสร้างนั้นจะต้องมีจำนวนอย่างน้อย ถึง  3 ไฟล์ด้วยกัน


Adobe Golive



        Browser

[image: image212]


1 ไฟล์ (.html)


           1 หน้า ( Web Site)

1. โครงเฟรม
2. เมนู

3. เนื้อหา
             รวม 3 ไฟล์
จะเห็นได้ว่าการที่จะสร้าง Web Site ที่ใช้เฟรมในการออกแบบนั้น จะมีไฟล์หลัก 1 ไฟล์ ที่ใช้เป็นตัวกำหนดโครงสร้างหรือกำหนดรูปแบบของเฟรมที่ต้องการจะใช้ โดยที่ไฟล์นี้จะเป็นไฟล์ที่ไม่มีเนื้อหาปรากฏในหน้า Web Site แต่อย่างใด เรียกไฟล์ นี้ว่า “โครงเฟรม” และส่วนที่เป็น หมายเลข 1  และหมายเลข 2 นั้นก็จะหมายถึง ส่วนของ Web Site ที่จะต้องสร้างแยกออกมาอีก 2 ไฟล์ เพื่อที่จะนำไปใส่ไว้ในไฟล์โครงเฟรม เพื่อให้ Web Site เฟรมนี้แสดงผลได้อย่างสมบูรณ์ นั่นก็หมายความว่า ในขณะที่กำลังดู Web Site ที่เป็นเฟรมอยู่นั้นกำลังมองเห็น Web Site พร้อมๆ กัน 2 หน้า ในหน้าจอคอมพิวเตอร์นั่นเอง (ในกรณีที่ Web Site นั้นมีการแบ่งเฟรมออกเป็น 2 ส่วน)

แต่ในการออกแบบ Web Site เฟรมจริงๆ แล้วนั้น ไม่ได้มีการผลิตขึ้นมาเพียงแค่หน้าเดียว แต่จะเห็นว่า ในส่วนที่เป็น หน้าเมนู นั้น จะมี เมนูย่อยๆ อยู่อีกหลายเมนูเพื่อที่จะทำการคลิ๊กเข้าไปดูเนื้อหาในส่วนอื่นๆ ด้วย ดังนั้นการทำ Web Site ด้วยเฟรมนั้นจึงไม่ได้สร้างขึ้นมาเพียงแค่ 3 ไฟล์ แต่จะต้องมีมากกว่านี้ตามจำนวนเมนูที่ต้องการ
ขั้นตอนการทำ Web Site เฟรม ด้วยโปรแกรม Adobe Golive 6.0

ขั้นตอนที่ 1  สร้างส่วนโครงเฟรม ( ส่วนที่ 1 )
1. File > New Page

2. เปลี่ยนชื่อ  Title ที่ Tab Layout

3. เลือกทำงานที่ Tab Frame Editor (ใช้สร้างไฟล์โครงเฟรมเท่านั้น)


4. กำหนดรูปแบบเฟรมที่ต้องการ 
จาก Tab Frame  ใน Palette 

Object (ใน บ.ฝ. นี้จะเลือก
ใช้แบบที่ 3) 

โดยหลังจากเลือกรูปแบบเฟรมที่ต้องการได้แล้วให้ลาก อุปกรณ์ตัวนั้นลงไปวางบนพื้นงาน
(ที่ได้เลือกทำงานใน Tab Frame Editor แล้ว) จะได้ผลลัพธ์ดังรูป
[image: image213.png]



5. กำหนดชื่อให้กับเฟรมทั้ง 2 (ใน บ.ฝ. นี้จะใช้ชื่อเฟรมบนเป็น Top  และเฟรมล่างเป็น Under)

โดยการกำหนดชื่อให้เฟรมบน ให้คลิ๊กในพื้นที่ เฟรมบน จะทำให้ Inspector แสดงผลดังรูป
และให้กำหนดชื่อเฟรม ลงไปในช่อง Name  (เฟรมล่างก็ให้ทำในลักษณะเดียวกัน)


6. กำหนดขนาดให้กับพื้นที่เฟรม โดยในการกำหนดขนาดเฟรมนี้จะทำการกำหนดให้กับพื้นที่เฟรมบนเท่านั้น ส่วนพื้นที่เฟรมล่างจะถูกกำหนดให้เป็นพื้นที่ที่เหลืออยู่โดยอัตโนมัติโดยการกำหนดพื้นที่เฟรมบนให้คลิ๊กทำงานในพื้นที่เฟรมบนแล้วกำหนดขนาดเฟรมในช่อง Height (ใน บ.ฝ. นี้จะกำหนดให้พื้นที่
เฟรมบน เท่ากับ 120)


หมายเหตุ :  ในการกำหนดขนาดพื้นที่เฟรมนั้น ในการทำงานจริงจะต้องกำหนดขนาดเฟรมให้เท่ากับขนาดงาน Graphic ที่ได้สร้างไว้จากโปรแกรม Photoshop เพื่อจะนำมาใช้ในการสร้าง Web Site สำหรับเฟรมบนด้วย ซึ่งรายละเอียดในส่วนนี้จะอธิบายในห้องเรียน
7. กำหนดคุณสมบัติในการเกิด Scroll Bar ให้กับทั้ง 2 เฟรม โดยการกำหนดจะกำหนดให้เฟรมบนมีค่า Scrolling เป็น No  ส่วนเฟรมล่าง มีค่าเป็น Auto


8. Save file เก็บไว้ก่อน ใน บ.ฝ. นี้ จะกำหนดชื่อเป็น index.html  โดยยังไม่ต้องปิดไฟล์ และเลือก Tab ไว้ที่ Frame Editor

ขั้นตอนที่ 2  สร้างส่วนเนื้อหา
หมายถึง การสร้าง Web Site ในส่วนที่เป็นเนื้อหาของในแต่ละเมนูที่สร้างไว้ (ใน บ.ฝ. นี้จะมีไฟล์ส่วนนี้อยู่ 3 ไฟล์ ได้แก่ home.html , product.html , contact.html  จาก c:\sample\sample_Frame) โดยไฟล์ที่เป็นส่วนเนื้อหาเหล่านี้จะทำการสร้างจาก Tab Layout ตามวิธีการสร้าง Web Site แบบปกติ ตามบทที่ 5 

ในการเรียนจะนำไฟล์ตัวอย่างที่เตรียมไว้ให้มาใช้ในการเรียนเลย

ขั้นตอนที่ 3 สร้างส่วนเมนู
1. สร้าง Web Site หน้าเมนู ที่ Tab Layout  เหมือนการสร้าง Web Site แบบปกติตามบทที่ 5 เพียงแต่ขนาดความสูงของ Grid จะสูงเท่ากับขนาดของเฟรมบนที่กำหนดไว้ในไฟล์โครงเฟรมเท่านั้น (ใน บ.ฝ. นี้จะกำหนดให้สูงเท่ากับ 120 pixels และกว้าง 800 pixels ) และให้มี 3 เมนู ได้แก่ Home  Product  และ Contact โดยอย่าลืมปรับ Grid ให้ชิดขอบด้วย

2. สร้าง Link และกำหนด Target
สร้าง Link ให้กับ Icon Home โดย Link ไปยัง ไฟล์ home.html  และกำหนด Target เป็น Under เพื่อให้การ Link ไปยังไฟล์ home.html ทำให้หน้านี้ไปปรากฏที่เฟรม Under


สร้าง Link ให้กับ Icon Product โดย Link ไปยังไฟล์ Product.html และสร้าง Link ให้กับ Icon Contact โดย Link ไปยังไฟล์ Contact.html และกำหนด Target เป็น Under เช่นเดียวกับการ Link  ของไฟล์ home.html

ขั้นตอนที่ 4 สร้างส่วนโครงเฟรม ( ส่วนที่ 2 )

1. กลับมาสร้างส่วนโครงเฟรมต่อเพื่อที่จะนำไฟล์ ส่วนเมนูและส่วนเนื้อหา มากำหนดให้กับพื้นที่เฟรมบน และเฟรมล่าง โดยให้ Browse ไฟล์ Menu.html ใส่เฟรม Top และ Browse ไฟล์ Home.html ใส่เฟรมล่าง (เฟรมล่างจะกำหนดเฉพาะไฟล์ที่จะให้ปรากฏพร้อมกับการเปิดแสดงผล Web Site เฟรมหน้าแรก ซึ่งใน บ.ฝ. นี้กำหนดให้เป็นไฟล์ Home.html)


2. กำหนด Frame Set เพื่อทำให้เส้นกั้นระหว่างเฟรมหายไปโดยทำการคลิ๊กที่เส้นกั้นระหว่างเฟรมจะทำให้ Frame Set Inspector ปรากฏขึ้น ดังรูป และกำหนดค่าต่างๆ โดยให้ Border Size = 0 และ Border Frame = NO 


เมื่อกำหนดค่าทุกอย่างเสร็จเรียบร้อยแล้วให้ Save ไฟล์ index.html อีกครั้งแล้วเปิดแสดงผลผ่าน Browser จะได้ผลลัพธ์เป็น Web Site เฟรมดังรูป


การสร้างภาพเคลื่อนไหว และ ป้ายโฆษณาด้วยโปรแกรม Animagic Gif


ในการสร้าง Web Site ให้มีความน่าสนใจแก่ผู้ใช้ วิธีการหนึ่งที่นิยมใช้คือ การนำเอาภาพเคลื่อนไหวเข้ามาใส่ไว้ในหน้า Web Site ด้วย โดยอาจจะอยู่ในรูปของ ข้อความกระพริบ ภาพการ์ตูนเคลื่อนไหว หรือป้ายโฆษณา

โดยในการสร้างภาพเคลื่อนไหวในบทนี้จะใช้วิธีการ สร้างภาพนิ่งขึ้นมาเป็นเฟรม ๆ ให้มีลักษณะการเคลื่อนที่อย่างต่อเนื่อง และจะนำเอาภาพนิ่งที่ได้จากการสร้างในโปรแกรม Photoshop ไปสร้างเป็นภาพเคลื่อนไหวในโปรแกรม Animagic Gif  หลังจากนั้นจึงค่อยนำเอาไฟล์ภาพเคลื่อนไหวที่ได้จากโปรแกรม Animagic Gif  ไปใช้สร้าง Web Site ในโปรแกรม Adobe Golive ต่อไป

ขั้นตอนการสร้างภาพเคลื่อนไหว โดยสรุป
1. สร้างภาพนิ่งเป็น เฟรมๆ จากโปรแกรม Photoshop จนได้จำนวนเฟรมตามต้องการ

(ใน บ.ฝ. นี้จะนำไฟล์ตัวอย่างมาจาก c:\sample\sample_Animation)



ไฟล์เหล่านี้เป็นไฟล์ที่จะนำมาใช้เพื่อการสร้างภาพเคลื่อนไหวเท่านั้นยังไม่ใช่ไฟล์ที่จะนำไปทำ Web Site  ดังนั้นเมื่อสร้างไฟล์เหล่านี้จากโปรแกรม Photoshop แล้ว ให้ save เก็บแยกไว้ต่างหากไม่ต้องนำไปเก็บไว้ในโฟลเดอร์ image 

2. นำไฟล์เหล่านี้ไปสร้างภาพเคลื่อนไหวในโปรแกรม Animagic Gif โดยใช้คำสั่ง File > Insert Frame เพื่อนำเอาไฟล์ภาพนิ่งเข้าไปใส่ใน Frame List โดยเรียงตามลำดับดังรูปที่ 1 และเมื่อใส่เฟรมภาพนิ่งใน Frame List เรียบร้อยแล้วจะได้ดังรูปที่ 2








3. ทำการทดสอบภาพเคลื่อนไหวด้วยการกดปุ่ม Play          บน Tool Bar จะเห็นการเคลื่อนไหวของภาพนิ่งแบบต่อเนื่องทันที แต่จะเห็นว่าทุกภาพยังเคลื่อนที่ด้วยความเร็วที่เท่ากันหมดทุกเฟรม
4. ทำการปรับอัตราการเคลื่อนที่ของภาพนิ่ง ด้วยคำสั่ง Animation > Frame Rate ดังรูปที่ 3 จะทำให้หน้าจอเป็นดังรูปที่ 4


สำหรับรายละเอียดในการปรับแต่งอัตราความเร็วจะอธิบายในห้องเรียน
5. เมื่อปรับแต่งอัตราความเร็วได้ตามความต้องการเรียบร้อยแล้ว การ Save file เพื่อให้เป็นไฟล์ภาพเคลื่อนไหวให้ใช้คำสั่ง File > Save as และนำไฟล์นี้ไป Save เก็บไว้ในโฟลเดอร์ image เพื่อเตรียมไว้ใช้ทำ Web Site ต่อไป
6. นำภาพเคลื่อนไหวที่ได้จากโปรแกรม Animagic Gif ไปใช้ในโปรแกรม Adobe Golive โดยนำเข้าไปใช้ด้วยอุปกรณ์ Image          และทำการจัด Layout เหมือนวิธีการในบทที่ 5 ที่ได้เรียนผ่านมาแล้วนั่นเอง
ผู้แต่ง  อ. ชนพิพัฒน์  อร่ามกุล
Email :: unn@netdesign.ac.th
บทที่ 8

DHTML และ Action

DHTML

DHTML หรือ Dynamic HTML  คือ ภาษา HTML Version  ล่าสุด ที่สามารถสร้าง Animation ขึ้นมาในโครงสร้างของภาษา HTML และยังอนุญาตให้ทั้งผู้ออกแบบ และ ผู้เข้าชม  Web Site สามารถเลื่อนวัตถุไปมาอย่างอิสระ รวมทั้งสั่งให้ซ่อน หรือ แสดงวัตถุตามที่สั่งได้อีกทั้งยังสามารถนำวัตถุต่าง ๆมาทับกันเป็นชั้น ๆ ได้ โดยที่ไม่สามารถทำได้ใน HTML Version  ก่อนๆ แต่ข้อจำกัดของ DHTML นั้นอยู่ตรงที่ว่ามันจะสามารถแสดงผลได้บน Browser Version  4 ขึ้นไปเท่านั้น ( IE ver.4+, Netscape ver.4+ )

































































ความสามารถของ Floating Box และการนำไปใช้ประโยชน์
1. สามารถนำ Floating Box หลาย ๆ ตัวมาซ้อนทับกันได้



2.  สามารถทำ Animation ให้กับ Floating Box แต่ละตัวได้

ลองไปที่ Tab Preview หรือ Show In Browser ( บทที่ 5 ) เพื่อทดสอบการทำงานของ Animation














สามารถจะปรับการทำงานของ Animation ที่  Timeline Editor พร้อมกับดูหน้า Layout และผลของ Animation ที่หน้างานไปด้วยก็ได้ ให้ไปที่ Menu window > Cascade and Tile > Tile Horizontally จะเป็นการแบ่งหน้าต่าง Layout กับ Timeline เป็น 2 ส่วน

ในหน้าต่าง Timeline Editor นี้ยังสามารถปรับค่าต่าง ๆ ของ Animation ได้อีกเช่น การเพิ่ม หรือ ลดความเร็ว , การสั่งให้วน loop หรือ ถอยหลังกลับ  ฯลฯ


























































หลังจากที่สร้าง Animation ก็สามารถมาปรับตำแหน่งได้อีกครั้งโดย Click ที่ Key Frame แล้วไปดูที่ Inspector สามารถปรับตำแหน่งค่า Left และ Top ที่ Key Frame นั้น ๆ ได้



จะเห็นได้ว่า Dynamic HTML มีความสามารถในการทำ Animation ค่อนข้างมาก ทำให้  Web Site ดูน่าตื่นตาตื่นใจและมีการตอบโต้กับผู้ใช้มากขึ้น แต่ทั้งนี้ยังต้องคำนึงถึงกลุ่มเป้าหมายของด้วย ว่าเป็นกลุ่มที่รับเทคโนโลยี DHTML ของได้หรือเปล่าไม่อย่างนั้นสิ่งที่ทำไปก็จะสูญเปล่า และทำให้กลุ่มเป้าหมายของหันไปใช้บริการของ  Web Site  อื่น ๆ ซึ่งสิ่งที่ยังต้องคำนึงเป็นหลักก่อนก็คือ สิ่งที่นำเสนอ  , สิ่งที่จะเป็นประโยชน์กับผู้เข้าชม แล้วค่อยใช้เทคโนโลยีต่าง ๆ มาช่วยเติมแต่งให้  Web Site ดูน่าสนใจมากขึ้น น่าจะเป็นแนวทางที่ดีกว่า


Action หรือ Action Script

โดยปกติแล้วคงจะเคยพบเห็นการใช้ Action กับหน้า  Web Site ต่าง ๆ กันเป็นประจำอยู่แล้ว อย่างเช่น อาจจะเปิด   Web Site หนึ่งขึ้นมาแล้วปรากฏว่ามีหน้าต่าง Browser อีกหน้าต่างหนึ่งเปิดขึ้นมาอัตโนมัติ โดยที่ไม่ได้ Click ที่ไหนเลย หรือว่าอาจจะเคย Click ที่รูปภาพเพื่อจะดูรูปภาพรูปนั้นเป็นรูปใหญ่ปรากฏว่าหน้าต่าง Browser ที่เปิดขึ้นมานั้นมีรูปภาพรูปใหญ่ขึ้นมาแต่หน้าต่าง Browser นั้นพอดีกับรูปภาพ และอาจจะอยู่ตรงกึ่งกลางหน้าจอด้วย ซึ่งการกระทำลักษณะแบบนี้ในภาษา HTML ธรรมดาไม่สามารถจะทำได้ จึงต้องมีการเขียนโปรแกรมเพิ่มเติมเข้ามา ซึ่งถ้าผู้ใช้มีความสามารถในการเขียนโปรแกรมเหล่านั้น ก็สามารถจะทำให้หน้า  Web Site ดูมีสีสรรค์มากขึ้นนั่นเอง รวมทั้งยังสามารถทำให้ผู้ใช้เกิดความสะดวกมากขึ้นอีกด้วย
Action กับ Adobe Golive 6 

เนื่องจาก Golive เป็นโปรแกรมที่ช่วยให้ Designer ทำงานได้ง่ายขึ้นโดยไม่ต้องยุ่งกับส่วนของการเขียนโปรแกรมมากนัก มันจึงมีเพิ่มความสามารถในการที่จะทำให้สามารถทำ Action ต่างๆมากมายโดยที่ไม่ต้องมีความรู้ด้านการเขียนโปรแกรมเลยก็ได้ โดย Golive ได้เตรียมชุดคำสั่งการทำ Action เอาไว้มากมายให้เอาไปใช้ได้ทันที  เป็นชุดคำสั่งที่สามารถเข้าใจได้อย่างง่ายดาย และมีการอธิบายไว้ชัดเจน
Action แบ่งเป็น 2 ชนิด
1. Action ที่ Link ( Text Link , Image Link ) 

จะเกิด Action ก็ต่อเมื่อมีการกระทำกับ Link นั้นๆ อย่างเช่น กดที่ปุ่มปุ่มหนึ่งแล้วมีการใส่ Action สั่งให้เปลี่ยนสี Background แบบนี้จะเรียกว่า Action ที่ Link สามารถใส่ Action ให้กับรูปภาพ หรือ Text ก็ได้แต่ รูปภาพ หรือ Text นั้น ๆ จำเป็นจะต้องทำ Link ไว้ก่อน ไม่อย่างนั้นแล้วจะไม่สามารถกดลงไปที่ตัวรูป หรือ Text เพื่อจะทำ Action ให้มันได้ แต่ทั้งนี้จะทำ Link ไปที่ไหน ถ้าทำ Link ไปที่หน้า  Web Site อื่นๆ ก็จะไม่เห็น Action ที่ใส่ลงไป เพราะว่ามีการเปลี่ยนหน้าไปเรียบร้อยแล้ว ดังนั้นจึงต้องรู้จักการทำ Link หลอกเอาไว้ โดยให้ทำ Link แบบปกติแต่แทนที่จะ Link ไปหน้า  Web Site ให้ใส่ # ลงไปแทน

เมื่อทำ Link เรียบร้อยแล้วให้ไปที่ menu window > Actions เปิด palette Actions ขึ้นมาซึ่งตอนนี้จะมีคำสั่งให้เลือกใช้ ( ถ้าไม่ได้ทำ Link คำสั่งเหล่านี้จะไม่ขึ้น )


Event – เหตุการณ์ หรือ สถานะของการเกิด Action

การทำ Action กับ Link นั้นจำเป็นจะต้องกำหนดเหตุการณ์ของ Action ก่อน เช่น ถ้าใส่ Action เปลี่ยนสี Background ต้องกำหนดเหตุการณ์ก่อนว่าจะให้ Click ที่ Link แล้วเปลี่ยนสี Background หรือ อยากจะให้ Double Click แล้วถึงเปลี่ยนสี Background หรืออาจจะแค่แตะที่ Link เท่านั้นแล้วสามารถเปลี่ยนสี Background ได้ โดยที่สามารถกำหนดแบบไหนก็ได้ ซึ่งก็ควรจะเลือกใช้ให้เหมาะสมกับงานด้วย
ชนิดของ Events

Mouse Click   เกิด Action เมื่อ Click ที่ Link 

Mouse Enter   เกิด Action เมื่อแตะที่ Link 

Mouse Exit     เกิด Action  เมื่อลาก Mouse ออกจาก Link

Double Click  เกิด Action  เมื่อทำการ Double Click

Mouse Down  เกิด Action   เมื่อมีการ Click ลงไปที่ Link ในขณะที่ pointer วางอยู่บน Link

Mouse Up      เกิด Action   เมื่อมีการปล่อยปุ่มที่ Mouse ในขณะที่ pointer วางอยู่บน Link

Key Down และ Key Press  เกิด Action   เมื่อมีการ Click ลงไปที่ Link แล้วกดปุ่มที่ Keyboard 

Key Up           เกิด Action   เมื่อมีการ Click ลงไปที่ Link แล้วปล่อยปุ่มที่ Keyboard


































2. Action ที่ส่วน Head ของ HTML




จะมี Exec ให้เลือก 4 แบบ
· On Load มีความหมายว่า Action จะเกิดขึ้นทันทีที่มีการ Load หน้า  Web Site หน้านี้
· On Unload มีความหมายว่า Action จะเกิดขึ้นก็ต่อเมื่อมีการปิดหน้า  Web Site หน้านี้
· On Parse มีความหมายว่า Action จะเกิดขึ้นเมื่อ Browser มีการอ่าน Source Code ที่ส่วนนี้
· On Call  มีความหมายว่า Action จะเกิดขึ้นเมื่อมีการเรียกใช้ Call Action


การนำ Action ไปใช้งาน
อย่างที่ได้ทราบไปแล้วว่า Action มี 2 แบบคือที่ Link และ ที่ส่วนหัวของ HTML และยังเป็น Action ชุดเดียวกันอีกด้วย ดังนั้นจึงต้องลองใช้งานดูว่า Action ตัวไหนบ้างที่เหมาะกับ Action ที่ Link Action ไหนบ้างเหมาะกับการใส่ที่ส่วน Head

ตัวอย่างของการใส่ Action ที่ Link

Action “ Open Window “   เป็น Action ที่ใส่ให้กับปุ่มหรือ Link เพื่อต้องการให้เวลา Click แล้วเปิดหน้าต่าง Browser ขึ้นใหม่โดยที่สามารถกำหนดขนาดที่ต้องการ รวมทั้งสามารถเลือกได้ด้วยว่าต้องการ Function ตัวไหนบ้างของ Browser


ก่อนจะไปทำ Action Open Window จำเป็นต้องเตรียม  Web Site หน้าที่จะเปิดขึ้นมาให้พร้อมไว้ก่อน โดยการสร้าง  Web Site ที่มีขนาดที่ต้องการ ( ชิดมุมบนซ้าย ) แล้ว Save เก็บเอาไว้ก่อน










































ทดลองพิมพ์ตัวหนังสือขึ้นมา แล้วทำ Link ( ใส่ # ) เอาไว้แล้วเรียก Palette Action ขึ้นมา เลือก Event เป็นแบบ Mouse Click 





































ลองทดสอบผลดูผ่าน Browser


 
ให้ลองใช้ Action เดียวกันนี้กับส่วนหัวของ html บ้างเพื่อให้เห็นความแตกต่าง




ลอง Preview หรือ Show In browser เพื่อทดสอบ
จะเห็นว่าไม่ต้อง Click Link ก็มี Browser เปิดขึ้นมาอัตโนมัติ เพราะว่าสั่ง Action ไว้เป็น Onload นั่นก็คือถ้ามีการ Load หน้านี้ก็จะสั่ง Open Window ทันที  ยกตัวอย่าง Action ที่น่าสนใจ จาก   Web Site ของ TOYOTA ( www.toyota.com ) Action “ Set image URL”






























ลองมาทำ Action ลักษณะนี้บน Golive กันดู
เตรียมหน้า  Web Site ลักษณะนี้ขึ้นมา






































เมื่อเสร็จแล้วให้ใส่ Action ลักษณะเดียวกันนี้กับปุ่มที่เหลือ แค่เปลี่ยนภาพที่ Link ไปหาเท่า
ก่อนที่จะแตะที่ Link นั้น รูปตรงกลางจะเป็นรูปหลักของก่อนนั้น แล้งลองไป Preview เพื่อทดสอบดู
แต่พอแตะที่ Link แล้วตอนนี้รูปตรงกลางจะเปลี่ยนไปเป็นรูปที่ต้องการและพอเลื่อน Cursor ออกจากตัว Link รูปตรงกลางจะต้องกลับมาเป็นภาพหลักด้วย
Action กับ DHTML

การทำ Action นั้นไม่ได้เกี่ยวข้องกับ Dynamic HTML โดยตรง เพียงแต่ว่ามี Action บางตัวที่จะต้องทำงานควบคู่กับ Floating Box ทำให้ Action เหล่านั้นเป็น Action ที่จะต้อง Support เทคโนโลยี DHTML ไปโดยปริยายนั่นเอง ในช่วงนี้จะยกตัวอย่างการใช้ Action กับ DHTML ให้ลองทำกันดู
Action “ Show / Hide “ ( Floating Box )

Action นี้เป็นคำสั่งที่ทำให้สามารถซ่อน หรือ แสดง Floating Box ตามที่ต้องการได้ ลองดูตัวอย่างการใช้งานจาก   Web Site ของ Distar ( www.distar.net )

ที่หน้าแรกของ Distar.net มีการสร้าง menu เป็นลักษณะ Javascript Rollover ( บทที่ 6 )  คือตอนแรกเป็นรูปภาพ พอ Cursor แตะก็จะเปลี่ยนเป็นรูปวงกลม แต่ที่น่าสังเกตคือ เมื่แตะที่ปุ่มแล้วปรากฎว่ามีข้อความแสดงขึ้นมาทางด้านบน เป็นลักษณะอธิบายว่า Link นี้จะพา User ไปที่ไหน ไปเจออะไรบ้าง ซึ่งลักษณะการทำ Action อันนี้ก็คือ Action ที่เรียกว่า Show Hide นั่นเอง
ลองเตรียมหน้า  Web Site ลักษณะดังรูปเพื่อลองทำ Action นี้ดู


จากนั้นให้วาง Floating Box ลงมา 3 กล่อง แล้วใส่รูปภาพลงไปกล่องละรูป












ตั้งชื่อให้กับ Floating Box ด้วย โดยให้ Click ที่ขอบของ Floating Box แต่ละตัวแล้ว
ไปตั้งชื่อตรงช่อง Name ของ Inspector

จากนั้นให้เลือกที่ Link ตัวแรกก่อน ไปที่ Palette Action เลือก Events เป็น Mouse Enter แล้วไปเลือก Action หัวข้อ Multimedia > ShowHide




ที่ช่อง Mode ให้เลือกเป็น Show เนื่องจากต้องการแตะ ( Mouse Enter )แล้ว แสดง Floating Box ที่ใส่รูปภาพของไว้ ที่ช่อง Floating Box ให้เลือกชื่อ Floating Box ที่ต้องการจะให้แสดงตอนที่แตะลงไปที่ Link



ตอนนี้เมื่อแตะแล้วสามารถแสดง Floating Box ได้ แต่ว่าเมื่อเอา Cursor ออกจะต้องซ่อน Floating Box ตัวนี้ไปด้วย ดังนั้นเลือก Events เป็น Mouse Exit แล้วใส่ Action > Multimedia > Show Hide อีกครั้ง
คราวนี้ให้เลือก Mode เป็น Hide บ้าง ส่วน Floating Box ก็เลือกตัวเดิม ลองใส่ Action ให้ 
Link ตัวอื่นในลักษณะเดียวกันด้วย เมื่อใส่ครบแล้วลอง prreview เพื่อทดสอบดู
เมื่อยังไม่ได้แตะจะมองไม่เห็นภาพที่อยู่ใน Floating Box

เมื่อแตะที่ Link ที่ใส่ Action แล้วจึงจะแสดง Floating Box ให้เห็น
DHTML กับ Head Action

มี Action หลาย ๆ ตัวที่สามารถทำกับ FloatingBox และเป็น Action ที่ส่วน head ของ HTML ในบทนี้จะยกตัวอย่างให้ดู 2 Action เพื่อให้สามารถไปประยุกต์ใช้กันดู Action “ Drag Floating Box “ และ “ Mouse Follow “ Action Drag Floating Box นั้น อนุญาติให้ User สามารถที่จะ Click ลากวัตถุที่วางอยู่ใน Floating Box ของอย่างอิสระ ส่วน Action Mouse Follow นั้นทำให้วัตถุที่อยู่ใน Floating Box ที่กำหนดไว้นั้น เคลื่อนที่ตาม Mouse ของ User ได้ตลอดเวลา ซึ่ง Action ทั้ง 2 ตัวนี้ก็เป็น Head Action ทั้งคู่ เนื่องจากว่าเป็นการสั่ง Action ตั้งแต่เริ่มงานนี้ทันที




















ให้ลองเลือก Action > Multimedia > Drag Floating Box


พอ Preview แล้วจะสามารถ Click ค้างไว้แล้วลาก ( Drag ) Floating Box ไปไหนก็ได้ในหน้างาน

แต่ถ้าใส่ Action > Multimedia > Mouse Follow


พอไป Preview แล้วจะเห็นว่า Floating Box ตัวที่กำหนดจะติดไปกับ Cursor











จะเห็นได้ว่าความสามารถของ DHTML และการทำ Action นั้นมีมากมายและหลากหลาย ซึ่งน่าจะเป็นส่วนเพิ่มเติมที่ทำให้   Web Site ของดูน่าสนใจมากขึ้น แต่ถึงแม้ว่ามันจะทำให้   Web Siteของดูมีสีสรรค์มากขึ้น ก็ไม่ควรจะให้มันบดบังจุดประสงค์ในการนำเสนอเนื้อหา สาระสำคัญ ของ   Web Site ด้วย เพราะว่าการใส่เทคนิคพิเศษมากจนเกินไป ก็จะทำให้ User นั้นหาสาระสำคัญจริงๆของ   Web Site ไม่เจอ ในที่สุดก็จะไม่กลับมาอีก ดังนั้นจึงควรเลือกใช้เทคนิคให้เหมาะสมกับงานด้วย จึงจะเรียกได้ว่าเป็นผู้ที่ออกแบบ   Web Site ได้ดีเยี่ยม ไม่ใช่ผู้ที่สร้าง   Web Site ได้ เท่านั้น
                                         ผู้แต่ง   อ. อัศวิน  โอกาด้า
                                           email :: okada@netdesign.ac.th

บทที่ 9
Domain Name,  Web Site  Hosting, การตรวจสอบข้อผิดพลาดภายในหน้า Web Site และการ Upload


เมื่อทำหน้า Web Site เสร็จเรียบร้อยแล้ว การที่จะเอาหน้า Web Site แต่ละหน้าของขึ้นออนไลน์ในระบบอินเทอร์เน็ต เพื่อให้ผู้คนสามารถเข้ามาเปิดชมได้นั้น จะต้องมีส่วนประกอบที่สำคัญ 2 ส่วน ก็คือ 
1. Domain Name และ   2. Hosting


Domain Name หรือ “ชื่อโดเมน” เปรียบเสมือนบ้านเลขที่บอกตำแหน่ง เพื่อให้คนที่จะมาเยี่ยมชมสามารถเข้ามาได้อย่างถูกต้อง ส่วน Hosting เปรียบเสมือนเนื้อที่ของบ้าน
Domain Name


ชื่อโดเมนเกิดขึ้นมาจากที่ตอนแรกเริ่มระบบอินเทอร์เน็ต  การแยกแยะเครื่องคอมพิวเตอร์ที่อยู่ภายในเครือข่ายหรือโฮสต์ (Host) แต่ละเครื่องออกจากกันนั้น จะใช้การอ้างอิงด้วยตัวเลขไอพี (IP : Internet Protocol) ซึ่งเป็นตัวเลขชุดขนาด 32 บิต โดยจะแบ่งออกเป็น 4 กลุ่ม กลุ่มละ 8 บิต หรือเป็นตัวเลขได้ตั้งแต่ 0-255 โดยคั่นระหว่างชุดด้วยจุด เช่น 213.55.170.10 โดยที่เครื่องคอมพิวเตอร์หรือโฮสต์ จะมีไอพีประจำของแต่ละเครื่อง โดยที่ไม่ซ้ำกันเลย (ปัจจุบันตัวเลขไอพีแบบ 32 บิตนั้น อ้างอิงเครื่องคอมพิวเตอร์หรือโฮสต์ได้ประมาณ 4.3 พันล้านเครื่อง ซึ่งจำนวน
ดังกล่าวค่อนข้างจำกัดเมื่อเทียบกับการใช้งานปัจจุบัน ดังนั้นจึงมีแนวคิดที่จะขยายการใช้งานเลยไอพีไปสู่มาตรฐานใหม่ที่เรียกว่า Ipv6 แทน Ipv4 ที่ใช้อยู่เดิม โดยจะอ้างอิงด้วยชุดตัวเลขขนาด 128 บิต ซึ่งในปัจจุบันได้เริ่มมีการติดตั้งระบบเพื่อรองรับมาตรฐานใหม่นี้บน Root Server ทั่วโลกแล้ว คาดว่าจะสามารถเปลี่ยนมาใช้งานได้ในอนาคตอันใกล้นี้) แต่เนื่องจากเลขไอพีเป็นชุดตัวเลขที่ยากแก่การจดจำ จึงได้มีการนำเอาชื่อโดเมนมาใช้ เพื่อให้ง่ายต่อการจัดการและการจดจำ เช่น yahoo.com, hotmail.com, netdesign.ac.th แต่โดยส่วนมากผู้ใช้ส่วนใหญ่ยังเข้าใจผิดอยู่ โดยมักหมายรวมเอาชื่อของโฮสต์ (ซึ่งส่วนใหญ่นิยมตั้งเป็น www) เข้าไว้เป็นส่วนหนึ่งของชื่อโดเมนด้วย เช่น www.yahoo.com ซึ่งโดยความเป็นจริงแล้ว www.yahoo.com เป็นเพียงการอ้างอิงถึงโฮสต์ชื่อ www ที่อยู่ภายใต้โดเมน yahoo.com เท่านั้น สำหรับชื่อโดเมนจะต้องทำการลงทะเบียนก่อนการใช้งาน เพื่อเอาชื่อที่ได้มาจับคู่กับตัวเลขไอพี เวลาใช้งานจะได้ไม่ต้องจำเลขไอพี แต่ใช้จำชื่อโดเมนแทน การจดโดเมนจะใช้หลักการ “จดก่อนได้ก่อน” (First-come, First-served) ซึ่งใช้กันเป็นสากลในการจดโดเมนทั่วโลก  สำหรับการตรวจสอบว่าชื่อโดเมนยังว่างอยู่หรือไม่ สามารถเข้าไปเช็คได้ที่ www.internic.net/whois.html หรือที่ www.checkdomain.com

การแบ่งประเภทของชื่อโดเมน สามารถทำได้ 2 ลักษณะใหญ่ ๆ คือ
1. แบ่งตามรูปแบบในเชิงเทคนิค
ในเชิงเทคนิคนั้น มีการแยกย่อยชื่อโดเมนออกเป็นหลายระดับขึ้น โดยชื่อโดเมนระดับบนสุดจะถูกเรียกว่า Top-Level Domain Name หรือ TLD ซึ่งจะอยู่ตำแหน่งขวามือสุดของชื่อ เช่น .com, .net, .org , .th, .uk ส่วนชื่อที่ถัดจาก TLD มาทางซ้ายมือ เรียกว่า Second-Level Domain Name หรือ SLD เช่น yahoo.com, hotmail.com ส่วนตำแหน่งที่ถัดจาก SLD มาทางซ้ายมืออีกที เรียกว่า Third-Level Domain Name เช่น netdesign.ac.th, nector.or.th ซึ่งในแบ่งย่อยนี้สามารถแบ่งไปได้เรื่อย แต่โดยปกติมักนิยมแบ่งไม่เกิน 4 ระดับ
2. แบ่งตามลักษณะการใช้งานและขอบเขตทางภูมิศาสตร์
แนวทางการจัดแบ่งลักษณะและประเภทของชื่อโดเมนอีกแนวทางหนึ่ง คือ การจัดแบ่งตามลักษณะการใช้งาน ซึ่งปรากฏให้เห็นในการจัดแบ่งชื่อโดเมนประเภทที่เรียกว่า ชื่อโดเมนสากล หรือ gTLD (generic Top-Level Domain Name) และการจัดแบ่งตามขอบเขตทางภูมิศาสตร์ ซึ่งปรากฏให้เห็นในการจัดแบ่งชื่อโดเมนประเภทที่เรียกว่า ชื่อโดเมนประจำสัญชาติ หรือ ccTLD (country code Top-Level Domain Name) 

กลุ่มของชื่อโดเมนประเภท gTLD

กลุ่มที่เปิดกว้างให้บุคคลหรือหน่วยงานทั่วโลกจดได้โดยอิสระ

.com (Commercial) กำหนดให้ใช้สำหรับกลุ่มธุรกิจการค้าทั่วไป เช่น บริษัทต่างๆ 

.net (Networking) กำหนดให้ใช้สำหรับกลุ่มผู้ดูแลระบบเครือข่ายคอมพิวเตอร์ หน่วยงานรับจดทะเบียนชื่อโดเมนและกลุ่มให้บริการด้านเครือข่ายอื่น ๆ

.org (Organization) กำหนดให้ใช้สำหรับกลุ่มองค์การ ซึ่งไม่สามารถจัดลงไว้ในกลุ่มอื่น ๆ ปัจจุบันส่วนใหญ่ถูกใช้สำหรับองค์การที่ไม่แสวงหาผลกำไร (Non-Profit Organization)

กลุ่มที่เปิดให้กับหน่วยงานหรือองค์กรเฉพาะด้าน

.gov (Government) สำหรับหน่วยงานต่างๆ ที่อยู่ภายใต้การกำกับดูแลของรัฐบาลกลางสหรัฐ

.edu (Education) กำหนดให้ใช้สำหรับกลุ่มสถาบันการศึกษาของสหรัฐอเมริกาเท่านั้น โดยจำกัดให้เฉพาะมหาวิทยาลัยและวิทยาลัย ที่มีหลักสูตรการศึกษา 4 ปี

.mil (Military) สงวนไว้สำหรับหน่วยงานทางทหารของสหรัฐอเมริกาเท่านั้น

.int (International) สำหรับองค์กรหรือหน่วยงานที่จัดตั้งขึ้น เพื่อดำเนินงานระหว่างประเทศ
กลุ่มของชื่อโดเมนในประเภท ccTLD


ในส่วนของการจัดแบ่งประเภทตามขอบเขตทางภูมิศาสตร์ จะเป็นการกำหนดรหัสประเทศ โดยปัจจุบันยึดตามองค์การสหประชาชาติ รหัสดังกล่าวจะมีลักษณะเป็นตัวอักขระ 2 ตัว ซึ่งเป็นชื่อย่อหรือใกล้เคียงกับชื่อย่อของประเทศนั้น ๆ สำหรับบทบาทการควบคุมกำกับชื่อโดเมนกลุ่ม ccTLD จะขึ้นกับองค์กรที่ดูแลระบบข้อมูลชื่อโดเมนประจำสัญชาตินั้น ๆ เป็นหลัก ซึ่งหน่วยงานดังกล่าวส่วนใหญ่มักเป็นหน่วยงานเอกชนที่เป็นผู้บุกเบิกเครือข่ายอินเทอร์เน็ตในประเทศนั้น ๆ มาแต่ต้น เช่นในกรณีของประเทศไทย จะมี THNIC (Thailand Network Information Center) ซึ่งเป็นหน่วยงานภายใต้การสนับสนุนของสถาบันเทคโนโลยีแห่งเอเชีย (AIT) เป็นผู้ดูแลระบบข้อมูลชื่อโดเมน .th และให้บริการรับจดชื่อโดเมน .th ทั้งหมด

ในแต่ละประเทศ การจัดแบ่งลักษณะการใช้งานของชื่อโดเมนจะอยู่ภายใต้การดูแลขององค์กรของประเทศนั้นๆ สำหรับในกรณีของประเทศไทย THNIC มีการจำแนกชื่อโดเมนในระดับ SLD ออกเป็น 7 ประเภท คือ

.co.th สำหรับองค์กรธุรกิจที่จดทะเบียนในประเทศไทย ในอดีตจำกัดให้จดได้เพียง 1 ชื่อต่อ 1 บริษัทหรือห้างหุ้นส่วนเท่านั้น โดยชื่อที่จดจะต้องเป็นชื่อ/ชื่อย่อ/หรือส่วนหนึ่งส่วนใดของชื่อบริษัทเท่านั้น ต่อมาเมื่อวันที่ 31 สิงหาคม 2543 จึงได้ขยายให้สามารถจดชื่อได้หลายชื่อ โดยสามารถอ้างอิงจากเครื่องหมายการค้าที่จดทะเบียนได้

.net.th   สำหรับหน่วยงานไทยที่ให้บริการอินเทอร์เน็ตหรือเครือข่าย

.or.th     สำหรับองค์การในประเทศไทยที่ไม่แสวงหาผลกำไร

.ac.th    สำหรับสถาบันการศึกษาของไทย

.go.th    สำหรับหน่วยงานราชการไทย

.mi.th    สำหรับหน่วยงานทางทหารของกองทัพไทย

.in.th     สำหรับองค์กรหรือบุคคลทั่วไป

สำหรับชื่อโดเมน .in.th นั้น ทาง THNIC เพิ่งจะเปิดให้จดและใช้งานเมื่อเดือนมีนาคม 2542 ที่ผ่านมา เพื่ออำนวยความสะดวกแก่บุคคลหรือองค์กรทั่วไปให้สามารถจดชื่อ .th ของประเทศไทยได้ โดยไม่ต้องแสดงหลักฐานใด ๆ ในการขอจด ต่างจากชื่อโดเมน 6 ประเภทแรกที่ได้มีการเปิดให้บริการมาตั้งแต่ต้น ซึ่งผู้ขอจดจำเป็นต้องยื่นหลักฐานเพื่อแสดงสิทธิ์ตามกฎหมายที่มีต่อชื่อนั้น ๆ เช่น เอกสารรับรองการจัดตั้งบริษัท หนังสือสำคัญแสดงการจดทะเบียนเครื่องหมายการค้า หรือ อื่น ๆ ซึ่งจะต้องสามารถแสดงให้เห็นได้ว่าชื่อที่ขอจด มีความเกี่ยวข้องกับกิจการของผู้ขอจดให้กับทาง THNIC ก่อน จึงจะสามารถจดและใช้งานชื่อนั้น ๆ ได้
ประวัติความเป็นมาของชื่อโดเมน

การนำชื่อโดเมนมาใช้งานอย่างจริงจังเริ่มต้นในช่วงเดือนพฤศจิกายน ค.ศ.1983 ในตอนต้น ชื่อโดเมนประเภท .arpa, .com, .org, .edu และ .gov จะถูกกำหนดให้อยู่ภายใต้การดูแลของ DARPA (The Defense Advanced Research Project Agency) ส่วน .mil จะอยู่ภายใต้การดูแลของ DDN (The Defense Data Network) แต่ในท้ายที่สุด SRI ก็เป็นผู้เข้ามาดูแลชื่อโดเมนทั้งหมด ในฐานะของตัวแทนของทั้ง 2 หน่วยงาน ภายใต้ชื่อ SRI-NIC หรือ The NIC ต่อมาเมื่อวันที่ 1 ตุลาคม ค.ศ.1991 หน้าที่ในการดูแลการจดทะเบียนก็ได้ถูกโอนกลับมาอยู่ภายใต้การดูแลของกระทรวงกลาโหมอีกครั้ง โดย DISA (Defense Information System Agency) ได้มอบหมายให้ GSI (government Systems Inc.) เข้ามาทำหน้าที่แทน SRI-NIC โดยในขณะนั้นมีโฮสต์ประมาณ 6 แสนเครื่อง และต่อมาในวันที่ 1 มกราคม ค.ศ.1993 สถาบันวิทยาศาสตร์แห่งชาติ (NSF : National Science Foundation) ก็ได้เปิด   Web SiteInterNIC  เพื่อให้บริการข้อมูลเกี่ยวกับอินเทอร์เน็ต รวมทั้งการบริการจดชื่อ
โดเมนภายใต้ข้อตกลงร่วมกับเอกชน 3 ราย ชื่อ AT&T ในส่วนระบบฐานข้อมูล, General Atomics/CERFnet ในส่วนของการบริการข้อมูลข่าวสารต่างๆ และ Network Solutions Inc. (NSI) ในส่วนของการให้บริการจดทะเบียนชื่อโดเมนประเภทกลุ่ม .com, .net, .org และ .edu เป็นเวลา 5 ปี ซึ่งต่อมาได้รับการขยายสัญญาไปอีกจนถึง 30 กันยายน ค.ศ.2000


แต่เดิมนั้นค่าใช้จ่ายในส่วนของการดูและรักษาชื่อโดเมนได้รับเงินทุนสนับสนุนจาก NSF แต่ต่อมาจำนวนผู้ใช้อินเทอร์เน็ตได้เพิ่มจำนวนขึ้นอย่างมาก ดังนั้นในวันที่ 13 กันยายน ค.ศ.1995 NSI จึงได้รับอนุญาตให้เก็บค่าบริการจดชื่อโดเมน 100 ดอลล่าร์ สำหรับการจดและรักษาชื่อใน 2 ปีแรก และปีต่อไปปีละ 50 ดอลล่าร์ โดยมีข้อตกลงว่า 30% ของรายได้ จะต้องถูกส่งเข้ากองทุน Intellectual Infrastructure Fund (IIF) เพื่อนำมาใช้ในการปรับปรุงและพัฒนาเครือข่าย ต่อมากองทุนดังกล่าวได้ถูกยุบไป NSI จึงได้ปรับลดค่าบริการลงมาเหลือ 70 ดอลล่าร์ ต่อ 2 ปีแรกและ 30 ดอลล่าร์สำหรับปีต่อ ๆ ไป โดยในช่วงนั้น NSI เป็นเพียงหน่วยงานเดียวที่มีสิทธิผูกขาดในการให้บริการรับจดทะเบียนชื่อโดเมนในกลุ่ม .com, .org, .net และ .edu


สิทธิผูกขาดที่ NSI ได้รับ เป็นปัจจัยสำคัญอันหนึ่ง ที่ทำให้เกิดกระแสต่อต้านในรูปแบบของการเสนอทางเลือกอื่นในลักษณะของกลุ่มโดเมนอื่น ทำให้ IANA (The Internet Assigned Number Authority) ซึ่งมีหน้าที่ในการดูแลการออกชื่อโดเมนในขณะนั้นมีความตื่นตัวที่จะแก้ปัญหา ต่อมาเพื่อแก้ไขปัญหาดังกล่าว กระทรวงพาณิชย์สหรัฐฯ และ NTIA (National Telecommunications and Information Administration) ได้ถ่ายโอนหน้าที่ความรับผิดชอบทั้งในส่วนของการจัดสรรชื่อโดเมน เลขไอพี และการออกมาตรฐานโพรโตคอลที่ใช้ในการรับส่งข้อมูลบนเครือข่ายที่ IANA เป็นผู้ดูแลอยู่ภายใต้สัญญาร่วมกับรัฐบาลสหรัฐฯ ไปสู่องค์การกลางสากลที่ไม่แสวงหาผลกำไรในชื่อ The Internet Corporation for Assinged Names and Nubmers หรือ ICANN หลังจากที่ ICANN ก่อตั้งขึ้นมา ก็ได้มีการพิจารณาให้มีบริษัทรับจดโดเมนเพิ่มเติมขึ้นมา จากเดิมที่มีแต่ NSI ผูกขาดอยู่เพียงเจ้าเดียว ทำให้ในปัจจุบัน สามารถจดโดเมนกับบริษัทใดก็ได้ สำหรับค่าใช้จ่ายขึ้นอยู่กับบริษัทที่จด ส่วนใหญ่จะอยู่ระหว่าง 15-35 ดอลล่าร์ 
[image: image214.png]The et Corporaton
for Asigned Names 4nd Numbers

TCANN





สำหรับในปี ค.ศ.2000 ที่ผ่านมา ICANN ได้มีการพิจาณาออกชื่อโดเมนใหม่กลุ่ม gTLD อีก 7 ประเภท คือ

.aero   อุตสาหกรรมเกี่ยวกับการบิน

.biz   (Businesses) เกี่ยวกับธุรกิจ

.coop   (Cooperatives)   สหกรณ์

.info   ข้อมูลทั่วๆ ไป

.museum   เกี่ยวกับพิพิธภัณฑ์

.name   สำหรับส่วนบุคคล

.pro (Professional)  สำหรับวิชาชีพเฉพาะ เช่น ทนายความ, นักบัญชี, นายแพทย์ ฯลฯ
 Web Site  Hosting


 Web Site  Hosting คือ เครื่องคอมพิวเตอร์ที่เชื่อมต่อกับระบบอินเทอร์เน็ตตลอดเวลา ซึ่งเมื่อทำ   Web Site เสร็จเรียบร้อยแล้ว จะต้อง Upload ไฟล์ทั้งหมดไปไว้ที่  Web Site  Hosting เพื่อให้ผู้คนสามารถเข้าชมได้ตลอดเวลา  Web Site  Hosting จะจัดตั้งเองก็ได้ แต่ไม่เป็นที่นิยมทำกัน เพราะจะเสียค่าใช้จ่ายค่อนข้างสูง เนื่องด้วย  Web Site  Hosting จะต้องเปิดตลอดเวลา และคู่สายอินเทอร์เน็ตที่เชื่อมต่อมายังตัว Hosting จะต้องเป็นคู่สายความเร็วสูงที่เรียกว่า lease line ซึ่งค่าใช้จ่ายจะสูงมาก อยู่ที่ระดับแสนบาทขึ้นไปต่อเดือน ปัจจุบันจึงนิยมใช้บริการ  Web Site  Hosting กับบริษัทที่เปิดให้เช่า ซึ่งค่าใช้จ่ายจะถูกกว่าและสะดวกในการดูแล สำหรับ  Web Site  Hosting ส่วนใหญ่จะแบ่งออกเป็น 2 ประเภทใหญ่ ๆ ตามลักษณะของระบบปฏิบัติการ (OS : Operating System) คือ 
1.  Web Site  Hosting ที่ใช้ระบบ Windows NT หรือ Windows 2000

2.  Web Site  Hosting ที่ใช้ระบบ Unix หรือ Linux

เวลาจะเลือกใช้บริการ  Web Site  Hosting ส่วนมากแต่ละบริษัทก็จะมีให้เลือกหลากหลายรูปแบบ ส่วนประกอบหลัก ๆ ที่เป็นปัจจัยต่อด้านราคาคือ
1. ปริมาณพื้นที่เก็บข้อมูล (Disk Space) ขึ้นอยู่จำนวนข้อมูลภายใน   Web Site ว่ามากหรือน้อย ส่วนมากนิยมใช้หน่วยเป็น Megabyte (MB)

2. จำนวนรายชื่ออีเมล์ (POP3 E-Mail Address) ก็คือชื่อที่อยู่หน้า @ ที่คุณสามารถจะใช้ได้ (yourname@yourdomain.com) ปกติการจะเช็คอีเมล์ที่ทำงานแบบ POP3 จะต้องเช็คผ่านโปรแกรมรับส่งอีเมล์ เช่น Outlook Express จะไม่สามารถเข้าไปเช็คภายใน   Web Siteได้ ถ้าต้องการให้เช็คภายใน   Web Siteได้ จะต้องหา  Web Site  Hosting ที่สนับสนุนการทำงานที่เรียกว่า  Web Site  Base E-Mail ด้วย
3. ปริมาณการรับส่งข้อมูล (Data Transfer) เป็นการกำหนดปริมาณการเรียกใช้ข้อมูลผ่าน Web Site  โดยปกติ  Web Site  Hosting ที่มีราคาต่ำ จะกำหนดให้ปริมาณรับส่งข้อมูลน้อยกว่า  Web Site  Hostng ที่มีราคาสูงกว่า เพื่อป้องกันการเช่า  Web Site  Hosting ราคาถูก โดยที่มีคนเข้ามาชมเยอะ จะทำให้   Web Site อื่น ๆ ที่อยู่ภายใน  Web Site  Hosting เดียวกัน โหลดข้อมูลได้ช้า
สำหรับปัจจัย 3 ข้อนี้ เป็นปัจจัยใหญ่ ที่มีผลต่อด้านราคาของ  Web Site  Hosting ส่วนปัจจัยด้านอื่นๆ ก็จะต้องพิจารณาให้เหมาะสมกับการใช้งาน แต่ส่วนมากรายละเอียดปลีกย่อยของแต่ละบริษัท มักจะใกล้เคียงกัน
การตรวจสอบและแก้ไขความผิดพลาดบนเอกสาร Web Site  (Check and Fix Bugs)

ก่อนขั้นตอนการ Upload ควรมีการตรวจสอบภาพรวมของเอกสาร Web Site ที่เตรียมไว้ให้ถูกต้องเรียบร้อยก่อน ทั้งนี้เพื่อเป็นการป้องกันปัญหา Linkผิดพลาดหรือรูปภาพไม่แสดงผล ซึ่งขั้นตอนการตรวจสอบความผิดพลาดนี้ สามารถกระทำได้บนโปรแกรม Adobe Golive 

วิธีการตรวจสอบและแก้ไขความผิดพลาดบนเอกสาร Web Site  (How to Check and Fix Bugs)

1.  ใช้คำสั่ง File > New Site
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2.  ที่หน้าต่างใหม่ เลือก Single User แล้วกดปุ่ม Next

[image: image216.png]GoLive Site Wizard

Welcome to the Site Wizard

This wizard helps you create new Web sites. Whekher you are a single user ar you wark
with a team on a workaroup server, you can create riew blank sk, stes that are based
on existing files on your loca herd disk, or sies that are copied from a remote server.

 single User Select this option t create stes on your local hard disk

€ workgroup Select tis option ta wark an stes for a werkaroup. You can
Ut an existing site or create new workaroup stes;

e 2ok





3.  เลือก Options for Local Sites เป็น Import from Folder แล้วกดปุ่ม Next
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4.  เลือกโฟลเดอร์หลักที่เก็บเอกสาร Web Site ที่ปุ่ม Browse ทางด้านบน จะปรากฏไฟล์ index.html ขึ้นมาที่ช่องด้านล่างอัตโนมัติ
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5. กดปุ่ม Browse เพื่อ save ไฟล์เอกสาร .site  ซึ่งก็คือไฟล์หลักของทั้งSiteงาน 
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6.  จบขั้นตอนโดยการกดปุ่ม Finish
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7.  จากนั้น ไฟล์ .site ที่ save ไว้ จะถูกเปิดขึ้นมา โดยที่ช่อง Status จะแสดงสถานะของไฟล์งาน ซึ่งที่สถานะปกติจะเป็นเครื่องหมายถูก หากพบจุดผิดพลาดภายในไฟล์งาน จะปรากฏ icon รูปแมลง (Bug) สามารถแก้ไข Bug ได้โดยการ Double Click เปิดไฟล์งานนั้นๆ ขึ้นมาแก้ไขได้ทันที
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8.  Clickที่ icon รูปแมลงบน Toolbar เพื่อค้นหาจุดผิดพลาด ซึ่งสามารถสังเกตเห็นได้ง่ายๆ จากสีแดงที่ปรากฏ ดังตัวอย่าง เกิดความผิดพลาดคือ รูปภาพไม่แสดงผลเนื่องจากไม่พบไฟล์ที่ชื่อ mount.jpg
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9.  แก้ไขได้ง่ายๆ โดยการ Browse ไฟล์ใหม่ ซึ่งจากตัวอย่างเกิดจากชื่อไฟล์ถูกเปลี่ยนแปลง
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10.  Save อีกครั้งเพื่อ Update Status
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11.  ที่ไฟล์ .site จะพบว่าสภานะของไฟล์งานได้รับการแก้ไขเป็นปกติ
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การตรวจสอบและแก้ไขข้อผิดพลาดบนเอกสาร Web Site  เป็นขั้นตอนที่ควรกระทำก่อนการ Upload ไฟล์งานจริง
ทั้งนี้เพื่อป้องกันข้อผิดพลาดซึ่งอาจเกิดขึ้นบน  Web Site  Site ในภายหลัง นอกจากนี้ ไฟล์ .site ยังอำนวยความสะดวกอย่างมากต่อการจัดระบบของ  Web Site  Site โดยรวม อาทิ การเปลี่ยนชื่อไฟล์ การโยกย้ายตำแหน่งของไฟล์งาน โดยไม่มีผลกระทบกับการแสดงผลจริง เนื่องจากจะมีการ Update ให้สอดคล้องสัมพันธ์กันทั้งระบบ
Upload

ความหมาย
“Upload” คือ การถ่ายโอนชุดข้อมูลสำเนาจากเครื่องคอมพิวเตอร์ไปยังเครื่องแม่ข่าย (Server) มักจะได้ยินคู่กับคำว่า “Download” ซึ่งมีความหมายในทางกลับกัน คือ การถ่ายโอนชุดข้อมูลสำเนาจากเครื่องแม่ข่ายลงมายังเครื่องคอมพิวเตอร์
ประโยชน์
เพื่อนำเอกสาร Web Site เข้าสู่ระบบอินเทอร์เน็ต เอื้อประโยชน์ให้บุคคลทั่วไปสามารถเข้าถึง  Web Site  Site ที่จัดทำไว้ได้
ประเภทของการ Upload
หลังจากเตรียมและตรวจสอบข้อผิดพลาดของไฟล์งานเรียบร้อยแล้ว จะทำการ Upload ข้อมูลขึ้นไปยัง Server โดยการ Upload นั้น มีอยู่ 2 ประเภทหลักๆ อันได้แก่
1.  การ Upload ผ่านระบบ FTP (File Transfer Protocol)

2.  การ Upload ผ่านระบบ HTTP (Hyper Text Transfer Protocol)

วิธีการ Upload ผ่านระบบ FTP ด้วยโปรแกรม WS_FTP Pro

1.   New Site ขึ้นมาใหม่ โดยการกดที่ปุ่ม New Site
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2. ที่หน้าต่างใหม่ ตั้งชื่อ  Site ตามต้องการ พร้อมทั้งกรอก Host Name ซึ่งในที่นี้เป็นการ Upload ขึ้นไปที่พื้นที่ของ Web Site โรงเรียน จึงกรอกเป็น ftp.netdesign.ac.th (รูปแบบคือ ftp. ตามด้วยชื่อ  Web Site  Site ) จากนั้นกดปุ่ม Finish
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3. กรอก User ID และ Password ที่ได้รับจากทางโรงเรียนให้ถูกต้อง แล้วกด Connect
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4. เมื่อ Connect ได้แล้ว จะมีข้อความ "Transfer Complete" ขึ้นมาที่ส่วน Status หน้าต่างจะแบ่งเป็น 2 ฝั่ง ทางซ้ายคือ Directory ภายในเครื่องของ(Local System) ส่วนทางขวา คือ Directory บน Server(Remote Site) วิธีการ Upload คือ Double Click เข้าไปในโฟลเดอร์ที่เก็บข้อมูลของ  Web Site  Site ไว้ในเครื่องทางด้านซ้าย ดังภาพ
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5.  เมื่อเข้าถึงโฟลเดอร์ที่ต้องการแล้ว สามารถเริ่มต้น Upload ได้โดยClickเลือกที่ชื่อไฟล์หรือโฟลเดอร์ที่ต้องการ แล้วกดปุ่ม --> เพื่อ Upload โดยสามารถเลือก Upload ได้หลายๆ ไฟล์พร้อมกัน
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6.  เมื่อเสร็จสิ้นการ Upload จะพบว่ารายชื่อไฟล์และโฟลเดอร์จะถูกทำสำเนาและถ่ายโอนมาที่ Remote Site
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7.  กดปุ่ม Close ด้านล่าง หลังจากใช้งานเสร็จเรียบร้อยแล้ว จากนั้นสามารถปิดโปรแกรม โดยกดที่ปุ่ม Exit
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วิธีการ Upload ผ่านระบบ HTTP ( Web Site -Based)

1.  เข้าไปที่หน้าแรกของ Web Site โรงเรียน เพื่อ log-in เข้าสู่หน้า Upload 

2.  เริ่มต้นจากการ Browse เลือกไฟล์เอกสาร Web Site (.html) ก่อน
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3.  เมื่อเลือกไฟล์ได้ตามต้องการแล้ว กดปุ่ม Upload ด้านล่าง 

[image: image234.png]Upload!




4.  เมื่อ Upload เรียบร้อย รายชื่อไฟล์จะปรากฏที่ด้านบน
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5.  การ Upload รูปภาพ จะต้องสร้างโฟลเดอร์ภาพขึ้นมาใหม่ก่อน โดยกรอกชื่อโฟลเดอร์ภาพ(ตามที่ตั้งไว้บนเครื่อง) แล้วกดปุ่ม “สร้าง Folder”
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6.  Clickเข้าไปที่ Folder ภาพ(image) เพื่อ Upload ไฟล์ภาพด้านใน
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7.  Browse ไฟล์ภาพและ Upload ในลักษณะเดียวกันกับไฟล์เอกสาร .html ในขั้นตอนที่ 2 และ 3
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8.  รายชื่อไฟล์ภาพจะปรากฏที่ด้านบน หากต้องการออกจากโฟลเดอร์ภาพ Clickที่ “ออกจาก Folder”
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9.  ออกจากระบบหน้า Upload โดยการClickที่ Log Off


หลังจากทำการ Upload ไฟล์งานทั้งหมดเสร็จเรียบร้อยแล้ว สามารถเข้าไปชมผลงาน  Web Site  Site ได้ที่ http://www.netdesign.ac.th/member/รหัสนักเรียน ทั้งนี้ สามารถจะ Update หน้า Web Site เพิ่มเติมได้อีกตามความต้องการ โดยวิธีการ Upload ไฟล์งานที่แก้ไขเพิ่มเติมแล้วขึ้นไปทับไฟล์เดิมบน Server

                                                                 ผู้แต่ง  อ. รชิษฐ์  บุษยาสกุล
                                                                                 Email :: tum@spaze.net
                                                                           อ.วรรณวนัช  ฤกษ์ลัภนะนนท์
                                                                                  Email :: yok@spaze.net
บทที่ 10

เทคนิคการประชาสัมพันธ์ Web และตรวจสอบผู้เยี่ยมชม Web

· การประชาสัมพันธ์ Web ผ่าน Search Engine 

· การนับจำนวนและตรวจสอบสถิติผู้เข้าชม Web (Counter and Statistics)

· Cascading Style Sheet

Search Engine

Search Engine คืออะไร

Search Engine สามารถแบ่งออกเป็น 2 ระบบด้วยกัน คือ
1. Search Engine ระบบ Directory

Search Engine ระบบนี้จะจัดแบ่งรายชื่อ Web Site ต่างๆ ไว้แยกตามหมวดหมู่ การค้นหารายชื่อ Web Site  User จะต้องเลือกเข้าไปตามหมวดหมู่หลักก่อน แล้วจึงเลือกหมวดหมู่ย่อยๆ ในหมวดหมู่หลักอีกที ตัวอย่างการค้นหาเช่น ต้องการค้นหารายชื่อของโรงเรียนสอนภาษาที่ซิดนีย์ ออสเตรเลีย 
2. Search Engine ระบบ Robot 

Search Engine ระบบนี้จะค้นหารายชื่อ Web Site  โดยการใช้โปรแกรมอัตโนมัติที่เรียกว่า “Spider” หรือ “Robot” เข้ามาเก็บข้อมูลตาม Source ของเว็บต่างๆ 
วิธีการค้นหาข้อมูลของ Web Site ใน Search Engine

เราสามารถค้นหา Web Site ที่เราต้องการได้ด้วยการกรอก Keyword ที่เกี่ยวข้องแล้วทำการค้นหา  (search)  

ตัวอย่างเช่น หากเราต้องการค้นหาข้อมูลเกี่ยวกับการเรียนภาษาที่ Sydney 
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รูปที่ 10.1 วิธีการค้นหาข้อมูลของ Web Site ใน Search Engine

วิธีการลงทะเบียนเพิ่มรายชื่อ Web Site ใน Search Engine 


กระบวนการขั้นสุดท้าย (Post-Production) ในการผลิต Web Site ก็คือ ขั้นตอนของการประชาสัมพันธ์ Web Site ของเราให้เป็นที่รู้จัก สำหรับการประชาสัมพันธ์ Web Site มีวิธีการหลากหลายรูปแบบซึ่งในบทนี้จะขอแนะนำวิธีการประชาสัมพันธ์ Web Site โดยผ่านระบบ Search Engine ซึ่งเป็นอีกวิธีการหนึ่งที่จะทำให้ User สามารถค้นหา Web Site ของเราได้ 

วิธีที่จะทำให้ User เข้าไปค้นหารายชื่อ Web Site ใน Search Engine แล้วปรากฏรายชื่อ Web Site ของเราขึ้นมาได้นั้น สิ่งที่เราจะต้องทำ ได้แก่
1. เตรียม Keyword, Title และ Description ที่เหมาะสมซึ่งอาจเป็นคำที่เกี่ยวข้องกับ Web Site ของเรา โดยวิธีการเพิ่ม Keyword, Title และ Description นั้นจะต้องกลับไปเตรียมที่โปรแกรม Adobe Golive ในส่วนของ Toggle Head Section และนำเอาอุปกรณ์ใน Palettes Object ส่วนของ Tab Head มาวาง 2 ตัว ได้แก่ 
· อุปกรณ์ Keyword เพื่อพิมพ์ Keyword ลงไปซึ่งสามารถใส่ Keyword ได้มากเท่าที่ต้องการ
· อุปกรณ์ Meta วางลงไปในส่วนของ Toggle Head Section เพื่อพิมพ์คำอธิบายเกี่ยวกับ Web Site  ซึ่งควรพิมพ์คำอธิบายที่กระชับ และไม่ควรยาวจนเกินไปนัก
2. เข้าไปที่เว็บของ Search Engine เพื่อทำการลงทะเบียนเพิ่มรายชื่อ Web Site ของเราเข้าไปเก็บเอาไว้ในระบบฐานข้อมูลของตัว Search Engine ซึ่งขั้นตอนการลงทะเบียนเพิ่มรายชื่อใน Search Engine มีดังนี้
2.1 Search Engine ระบบ Directory

Search Engine ระบบ Directory ในปัจจุบันที่ได้รับความนิยมมีอยู่เพียง 1 เว็บไซด์ คือ www.yahoo.com ซึ่งขั้นตอนในการลงทะเบียนเพิ่มรายชื่อเว็บไซด์ของเราเข้าไปในระบบฐานข้อมูลของ Search Engine ระบบ Directory นั้นขั้นตอนแรกจะต้องทำการเลือกหมวดหมู่ที่มีความเกี่ยวข้องกับเนื้อหาของเว็บไซด์ของเราเสียก่อนที่Category 

· เริ่มต้นโดยการเลือกหมวดใหญ่ก่อนที่ Web Site Directory แล้วค่อยเลือกเข้าไปในหมวดย่อยๆ ของ Category 

· เมื่อเลือกหมวดที่ต้องการเพิ่มรายชื่อ Web Site ได้ตรงตามความต้องการแล้วให้ลงทะเบียนเพิ่มรายชื่อ Web Site ของเราเข้าไปโดย Click ที่ Suggest a site 

· จะมีรูปแบบการลงทะเบียนเพิ่มรายชื่อ Web Site ให้เราเลือก 2 รูปแบบด้วยกัน คือ แบบ Express และ แบบ Standard ถ้าเลือกแบบ Express จะเป็นการเพิ่มรายชื่อ Web Site ที่ต้องเสียค่าใช้จ่าย ส่วนแบบ Standard สามารถลงทะเบียนเพิ่มรายชื่อ Web Site ได้ฟรีแต่ไม่รับรองว่าจะนำรายชื่อ Web Site ของเราเข้าระบบฐานข้อมูลเมื่อไหร่
· เมื่อเลือกรูปแบบการลงทะเบียนเพิ่มรายชื่อ Web Site ได้แล้ว หลังจากนั้นให้เข้าไปกรอกรายละเอียดตามขั้นตอนของระบบต่อไป
2.2 Search Engine ระบบ Robot 

ตัวอย่างรายชื่อของ Search Engine ระบบ Robot ที่ได้รับความนิยมจากผู้ใช้ ได้แก่ เป็นต้น หลังจากที่เตรียม Keyword และ Description ที่แท็บ Toggle Head Section เรียบร้อยและทำการ Upload ไฟล์งานขึ้นไปบน Server แล้ว 
Tip & Trick

ตัวอย่างรายชื่อของ Search Engine ระบบ Robot ที่ได้รับความนิยมจากผู้ใช้ ได้แก่ google.com, altavista.com, amazon.com, metacrowler.com, hotbot.com, go.com, lycos.com, sanook.com, siamguru.com, infoseek.com, thaifind.com

1.การเขียนคำสั่ง META tags

<META> tags คือ คำสั่งในภาษา html เพื่อช่วยในการค้นหา และจัดลำดับความสำคัญของ Web Site โดย Search Engine ทั้งหมดจะค้นหาใน META tags ภายใน Web Site ของท่าน ตัวอย่างสำหรับการเขียนคำสั่ง <META> tags จะมีลักษณะดังต่อไปนี้
<html>

<head>

<title>NetDesign : Spin Your Way to Success</title>
<meta name="keywords" content = "webdesign training,webdesign school,e-commerce, web design, web graphic, webdesigner, webcontest, netdesign, netdesigncenter, designcenter, thaidesign, thai designer, thaiwebmaster, webmaster ">

<meta name="description" content = " NetDesign (Under the Pratonage of Ministry of Education)">

</head>

Tip & Trick

META tags จะต้องถูกใส่ในระหว่างคำสั่ง <HEAD></HEAD> ซึ่งเป็นส่วนบนสุดของเอกสาร html เท่านั้น

Meta Tag “description” คือ คำอธิบายหรือรายละเอียดโดยย่อเกี่ยวกับ Web Site ของท่าน ควรจะเป็นข้อความภาษาอังกฤษ หรือ ตัวเลข ที่มีความยาวไม่เกิน 1 บรรทัด หรือ ประมาณ 1-80 ตัวอักษร

Meta Tag “keywords” คือ คำจำกัดความสั้นๆ ที่ท่านคิดว่าผู้ที่จะเข้ามาเยี่ยมชม Web Site ของท่านจะสามารถหา Web Site ของท่านเจอ เช่น web site เกี่ยวกับดอกไม้ ผู้ที่ต้องการจะค้นหา web site เหล่านี้ก็มักจะพิมพ์คำว่า “ flower “ ช่องค้นหาของ search engine ดังนั้นท่านจะต้องคาดเดาว่า ผู้ที่จะเข้ามาเยี่ยมชม web site ของท่านจะใช้คำจำกัดความคำใดเป็นข้อความหลักในการค้นหา การพิมพ์คำจำกัดความเหล่านี้ ท่านจะต้องแยกคำจำกัดความแต่ละคำโดยการใช้เรื่องหมายลูกน้ำ ( , ) ตามที่เห็นดังตัวอย่างข้างบน ควรมีความยาวไม่เกิน 255 ตัวอักษร)


Tip & Trick


ข้อควรระวัง : อย่าใช้ META tags “ keyword ” คำเดียวกันซ้ำเกิน 5 ครั้งใน 1 หน้า
Search Engine บางแห่ง Lycos จะแบน Web Site ของทันที เมื่อตรวจสอบพบว่า Web Pageนั้นมีข้อความซ้ำคำเดิมๆเพื่อปรับการจัดอันดับหรือตำแหน่ง ( Search Ranking )

2. Page Title


“Title” คือ หัวเรื่องของ Web Site สามารถใช้ถ้อยคำที่กระชับ ได้ใจความ และสามารถดึงความสนใจของผู้เยี่ยมชม Web Site เพราะเมื่อ รายชื่อ Web Site ของไปปรากฏอยู่ในสารบัญ ของ Search Engine Title ที่เขียนได้น่าสนใจจะสามารถทำให้ผู้ค้นหาเลือกที่จะ Click เพื่อเข้าชม Web Site นั้นๆ ได้มากกว่า Web Site บางแห่งเช่น Infoseek จะใช้ title ของเป็นสิ่งเริ่มแรกสำหรับกระบวนการค้นหา  เพราะฉะนั้นควรตั้งชื่อ Title โดยพยายามคิดเกี่ยวกับสิ่งซึ่งจะทำให้ผู้เข้าชม Web Site สามารถหา Web Site ของเจอโดยง่าย 
3.เนื้อหาของหน้าเว็บ (Text Content)


Text Content คือ ข้อความที่เป็นตัวพิมพ์ซึ่งปรากฏอยู่ในหน้า Web นั้นๆ Search engine บางตัวเช่น Excite จะไม่อ่าน META tag แต่จะค้นหาข้อความภายในเนื้อหาของ Web Site  ถ้าใช้ตัวหนังสือแบบรูปภาพ (Graphic Text) ก็จะไม่ได้รับการจัดอันดับจาก Search Engine 

การใส่ META tag ด้วยโปรแกรม Adobe Golive 6

โปรแกรม Adobe Golive 6 สามารถช่วยอำนวยความสะดวกในการเขียนคำสั่ง Meta Tags โดยผู้ออกแบบไม่มีความจำเป็นต้องไปยุ่งเกี่ยวกับ Source code โดยมีขั้นตอนการทำงานดังนี้

1.อุปกรณ์ที่ใช้ในการใส่ Meta Tags ให้หน้า Web Page อยู่ใน Palette Object ในกลุ่มเครื่องมือ Head มีอยู่ด้วยกัน 2 ตัวคือ อุปกรณ์ keywords (ตัวที่ 3 จากซ้าย) และ อุปกรณ์ Meta tags (ตัวที่ 5 จากซ้าย)




รูปที่ 10.2 อุปกรณ์ Keywords และ Meta Tags

รูปที่ 10.3 

2. เปิดหน้าเอกสารที่ต้องการจะใส่ Meta Tags ซึ่งโดยมากจะนิยมใส่ Tags นี้ในหน้า Home Page  (Index.html) เนื่องจากเป็นหน้าแรกที่ต้องการให้ผู้เยี่ยมชมค้นพบ และ Click บริเวณ ลูกศรหัวมุมบนด้านซ้าย 
( Toggle Head Selection ) เพื่อเปิดส่วนของ Head และจับอุปกรณ์ Keywords (รูปกุญแจ) และ อุปกรณ์ Meta ไปวางในช่องว่างดังกล่าว

3. Click เลือกที่ อุปกรณ์ Keywords ที่ใส่ลงไปใน Toggle Head Selection และไปเลือกที่ Palette Inspector เพื่อระบุข้อความที่เป็นคำจำกัดความสั้นๆของ Web Site ของ โดยกรอกข้อความลงไปในช่องด้านล่างสุด และ กด Enter เพื่อใส่ข้อความถัดไป ควรใส่ข้อความไม่เกิน 25 คำ เพราะ search engine บางแห่งเช่น yahoo จะไม่รับข้อความที่มีความยาวมากเกินไป

4. Click เลือกที่ อุปกรณ์ Meta Selection และไปเลือกที่ Palette Inspector เพื่อระบุข้อความที่เป็นคำจำกัดโดยย่อของ Web Site และให้พิมพ์บริเวณช่องตรงกลางว่า Description เพื่อบ่งบอกให้ Search Engine ทราบถึงลักษณะของ Meta Tags ตัวนี้ว่าเป็น Tag ประเภทคำอธิบาย
5. โปรแกรม Adobe Golive จะทำการแปลงคำสั่งให้กลายเป็น Meta Tags Source Code ให้อัตโนมัติ จะต้อง Upload หน้าเอกสาร.html นี้ขึ้นไปบน Server อีกครั้งหลังจากได้แก้ไขคำสั่ง Meta Tags นี้แล้ว เพื่อให้ Search Engine ได้เข้ามาค้นหาต่อไป
การทำงานของ Search Engine :

Altavista.com    จะค้นหาสำหรับ Page Title และ Description ใน <META> เพื่อให้ตรงกับการค้นหาคีย์เวิร์ด ประมาณ 1 เดือนหลังจากการ Submit ของ ,มันจะย้อนกลับมาเยี่ยมชม Web Site ของเพื่อหาหน้าอื่นๆที่ถูกเพิ่มเข้าไป Altavista จะใช้ระยะเวลาในการดำเนินการ 1-3 วัน
Excite.com   จะค้นหาจากคำ ( Text Content ) ในหน้าเว็บของ ทำให้แน่ใจว่าหน้าของมีคีย์เวิร์ดซึ่งผู้เข้าชม Web Site จะใช้ค้นหาสำหรับเว็บของ Excite จะตาม link บนหน้าเว็บเพื่อจะหาหน้าอื่น ๆ เพื่อเก็บลงฐานข้อมูลต่อไป Excite จะใช้ระยะเวลาในการดำเนินการ 4-6 สัปดาห์
HotBot.com  จะทำการค้นหา Web Page แต่ละหน้าซึ่งมีคีย์เวิร์ดใน <META> จะถูกจัดอันดับให้สูงกว่าหน้าซึ่งไม่มี <META>มันจะค้นหาทั้งใน META tags  และ page title เพื่อทำให้แน่ใจว่าคีย์เวิร์ดมีอยู่ในทั้ง2ที่ คำธรรมดาบางคำเช่น ”the”, “web”,” A” หรือแม้แต่ “HTML” จะถูกยกเว้นในการค้นหา ถ้าหน้าของมีคำเฉพาะเจาะจงจะได้ถูกจัดอันดับสูงขึ้น จะใช้ระยะเวลาในการดำเนินการ 4-6 สัปดาห์ Hotbot จะใช้ระยะเวลาในการดำเนินการ 3-5 สัปดาห์
Infoseek .com  จะค้นหาหา Page Titles ที่ตรงกับคีย์เวิร์ด Infoseek จะทำการจัดเก็บข้อมูล Web Site เพื่อการค้นหาลงฐานข้อมูลโดยตรงทันทีที่มีการแจ้งชื่อไปยัง Infoseek สามารถ Update Record ได้บ่อยมากกว่า 1ครั้งใน 24 ชั่วโมง
Yahoo.com จะเก็บเว็บของในหมวดหมู่ รายชื่อของ Web Site อาจจะถูกจัดเก็บได้มากกว่า 1 หมวดหมู่ ขึ้นอยู่กับเนื้อหาของว่ามีความสัมพันธ์กับหมวดหมู่ใดบ้าง ขั้นตอนการหาจะตรงกับ Page Title และ description อาจจะจำเป็นต้อง Submit  Web Site ของบ่อยครั้งก่อนจะได้รับการจัดเข้าไปอยู่ใน List  Yahoo จะใช้ระยะเวลาในการดำเนินการ 4-6 สัปดาห์
Counter and Statistics 

ขั้นตอนหลังจากการผลิต Web Site  นอกจากการประชาสัมพันธ์ Web Site ให้เป็นที่รู้จักแล้ว จำเป็นอย่างยิ่งที่จะต้องมีการเก็บข้อมูลของผู้ที่เข้ามาเยี่ยมชม Web Site ของเรา เนื่องจากข้อมูลหรือการเก็บสถิติเหล่านี้จะเป็นประโยชน์อย่างยิ่งต่อผู้ที่มีหน้าที่ออกแบบ Web Site  เพื่อใช้เป็นข้อมูลพื้นฐานในการวิเคราะห์และประเมินผล ปรับปรุง Web Site ให้มีประสิทธิภาพตรงกับความต้องการของ User ให้มากที่สุด ตัวอย่างรายชื่อ Web Site ที่ให้บริการ Free Counter ได้แก่
Thecounter.com, sitemeter.com, cybercounter.net, freewebcounter.net, truehits.net

วิธีการนำ Counter มาติดตั้งใน Web Site 


ในที่นี้ขอยกตัวอย่างการนำ Counter ของ www.sitemeter.com มาติดตั้งในเว็บของเรา
· ขั้นตอนแรก ให้เข้าไปที่ www.sitemeter.com เลือกไปที่หน้า Site Meter > Home หาคำว่า Site up for a free Site Meter  Click เลือก Site up 

· ให้ทำตามขั้นตอนที่กำหนดมาให้ รวมถึงการกรอกรายละเอียดต่างๆ ที่เกี่ยวข้องกับ Web Site ของเรา เช่น URL, Site Name, Code Name, Email เป็นต้น
· เมื่อทำตามขั้นตอนจนมาถึงหน้าที่แสดงข้อมูลของเรา ให้ตรวจสอบดูว่าถูกต้องหรือไม่ ถ้ามีข้อมูลส่วนไหนผิดพลาดให้ย้อนกลับไปแก้ไขข้อมูลให้ถูกต้องก่อน และเมื่อตรวจสอบแล้วข้อมูลทุกอย่างถูกต้องก็ให้ Click ปุ่ม Next เพื่อเป็นการยืนยัน
· เมื่อปรากฏหน้า “The signup for your Site Meter counter is complete !” ก็เป็นอันเสร็จขั้นตอนของการสมัครขอใช้ Free Counter ต่อจากนั้นให้ Click ที่ปุ่ม Manager ที่เมนูบาร์ด้านบน เลือก Pass Word เพื่อทำการเปลี่ยนแปลง Pass Word 

· ขั้นตอนต่อมาในส่วนของ Manager ให้เลือกที่ HTML Code เลือกโปรแกรมที่ใช้สร้าง Web Site  (Adobe Golive) เมื่อปรากฏหน้า Adobe’ Golive Installation Instructions ขึ้นมาจะมี HTML Code ให้เลือกใช้ 2 แบบด้วยกัน คือ JavaScipt HTML กับ Regular HTML สามารถเลือกใช้แบบใดแบบหนึ่งก็ได้ โดยทำการ Click เลือกที่ HTML Code ทั้งหมดแล้ว Copy เพื่อนำมาวางในโปรแกรม Golive 

Cascading Style Sheet


Cascading Style Sheet (CSS) คือ กลุ่มคำสั่งที่ถูกนำมาช่วยเสริมสมบัติของ HTML เพื่อให้เราสามารถจัดรูปแบบข้อความและจัดองค์ประกอบหรือจะทำการตกแต่งเว็บเพจได้อย่างมีประสิทธิภาพมากขึ้น เช่น เราสามารถใช้คำสั่ง CSS เพื่อกำหนดสมบัติของ จุดเชื่อมโยง ให้มีเส้นใต้ แล้วมีการกระพริบได้เมื่อนำ  Mouse  เข้ามาแตะบริเวณ จุดเชื่อมโยงนั้น ๆ หรือจะทำการตกแต่งแบบฟอร์มให้มีสีสัน หรือจะให้มี การใส่สีที่แถบเลื่อน (Scrollbar) เป็นต้น

Style Sheet เป็นอุปกรณ์ที่ใช้ในการตกแต่งแต่จะทำการตกแต่งได้นั้นจะต้องมีการระบุว่าจะนำสมบัติที่ได้ทีการตกแต่งนั้น ๆ ใส่เข้าไปกับตัวไหนในหน้างานก็จะต้องตั้งชื่อให้สอดคล้องกับ Tag ในภาษา HTML ด้วย  อย่างเช่น 
การกำหนดค่าของตัวอักษรที่เป็น Link  (Text Link) 
ตัว “a” ในภาษา HTMLจะหมายถึง การทำ  Link ซึ่งจะเขียนเป็น <a href = “___” >ข้อความที่จะให้เป็น Link </a> ดังนั้นหากต้องการกำหนดสีให้กับ Text Link หรือไม่ต้องการให้ Text Link มีเส้นใต้ สามารถกำหนดได้ด้วยคำสั่ง CSS ซึ่งทำได้โดย 
· เปิดไฟล์งานหน้าที่ต้องการขึ้นมา เลือกทำงานที่แท็บ Layout 

·  Click ที่ไอคอน (รูปขั้นบันได) Open CSS Editor จะเปิดหน้าต่างในส่วนของคำสั่ง CSS ขึ้นมา 
·  Click  Mouse ขวา เลือกคำสั่ง New Style > a

· กำหนดค่าต่าง ๆ ที่ Inspector ในส่วนของ Font ได้ตามต้องการ

และถ้าต้องการทำให้ Text Link เมื่อ Mouse Over แล้วเปลี่ยนสี หรือมีเส้นใต้สามารถกำหนดได้โดย 
·  Click ที่ไอคอน (รูปขั้นบันได) Open CSS Editor จะเปิดหน้าต่างในส่วนของคำสั่ง CSS ขึ้นมา 
·  Click  Mouse ขวา เลือกคำสั่ง New Style > a:hover

· กำหนดค่าต่าง ๆ ที่ Inspector ในส่วนของ Font ได้ตามต้องการ
การกำหนดขนาดตัวอักษรไม่ให้มีการขยาย (Fix Font)

จะต้องมีการ New Class Style เพื่อทำการสร้าง Class ขึ้นมาก่อน ซึ่ง Class จะต้องมีจุดนำหน้าเสมอ แล้วทำการปรับแต่งสมบัติ โดยกำหนด size ,font ที่ต้องการเสร็จแล้ว เวลาเรียกใช้งาน จะต้องใช้งาน Palette CSS ด้วยโดยทำการปาดดำ (highlight) ที่ตัวหนังสือแล้วก็ทำการ Span เข้าไปข้อความนั้น ๆ ก็จะถูกไม่สามารถเปลี่ยนแปลงขนาดได้
การกำหนดสีให้กับ Scrollbar

New Style > body


Scrollbar-arrow-color


Scrollbar-base-color


Scrollbar-track-color
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รูปที่ 1.3 การศึกษาทางไกล http://www.thai2learn.com





รูปที่ 1.1 ห้องแสดงสินค้าของ http://www.hondacars.com
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รูปที่ 4





รูปที่ 1.5  Web Site ของ  http://www.ibm.com





ธุรกิจออนไลน์ http://www.bn.com





 ธุรกิจออนไลน์ http://www.amazon.com
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เครื่องมือ META tag





ที่ช่อง Floating Box ก็เลือกชื่อ Floating Box ที่ตั้งชื่อไว้เช่นเดียวกัน





ที่ช่อง Floating Box ให้เลือกชื่อ Floating Box ที่ตั้งชื่อไว้





เสร็จแล้วให้ใส่ Head Action ลงไปที่ส่วน Head Section เลือก Exec. เป็น “ OnLoad “





วาง Floating Box ลงไปที่หน้างาน ใส่ Image เข้าไปข้างใน และ Browse รูปภาพแทนลงไป จากนั้นให้ตั้งชื่อให้กับ Floating Box ด้วย





ทำ Link ( ใส่ # ) เตรียมเอาไว้ เพื่อทำการใส่ Action 





ที่ช่อง Image ให้เลือกรูปหลักไว้ ส่วนตรงช่อง Link ให้ Browse ไปหาภาพที่ต้องการจะให้แทนลงไปที่รูปหลัก เมื่อแตะที่ Link นี้





จากนั้น ให้เลือก Link ตัวแรกก่อน แล้วไปดูที่ Palette action เลือก Events เป็น Mouse Enterแล้วไปเลือก Action ในหัวข้อ Image > Set Image URL





สำหรับ Action นี้จำเป็นต้องตั้งชื่อให้กับภาพหลักก่อน โดยไป Click ที่รูปภาพ แล้วไปดูที่ Inspector ตรง Tab More จะมีช่อง Name อยู่ ให้ตั้งชื่อเอาไว้ตรงนี้





วาง Image ลงไปเป็นรูปที่จะให้เป็นรูปหลัก





Text ธรรมดา ทำ Link เอาไว้เพื่อใส่ Action





ที่หน้าแรกของ TOYOTA นั้นมีการใส่ Menu ของรูปรถรุ่นต่างเอาไว้ โดยถ้าเอา Cursor แตะลงไปที่ชื่อรถรุ่นไหน ก็จะมีรถรุ่นนั้นปรากฎอยู่ตรงกลาง และถ้าไม่ได้เลือกแตะที่ไหน ตรงกลางก็จะกลับเป็น Logo ของ TOYOTA อีกด้วย





วางอุปกรณ์ Head Action จาก Object Palette ในหัวข้อ Smart ลงใน Headsection ดังรูป จากนั้นไปดูที่ Inspector เลือก Exec. ให้เป็น Onload





จากนั้น ให้เลือก Action > Open Window เหมือนตัวอย่างแรก ตั้งค่าลักษณะเดียวกัน





กดที่ปุ่ม Toggle Head Section ( มุมซ้ายบน ) เพื่อจะใส่ Action ที่ส่วนหัว





พอ Click ลงไปที่ Link ก็สามารถเปิด Browser ขนาดที่กำหนดได้	








จากนั้นให้ Click ที่ปุ่ม Action แล้วเลือก Link > Open Window  ที่ช่อง Link ให้ Browse ไปหาหน้า  Web Site ที่เตรียมไว้ ส่วนช่อง Size ให้ใส่เป็นขนาดของ Browser ที่ต้องการจะเปิดขึ้นมา ส่วนของ Checked Box ด้านล่างก็เป็น Function ของ Browser ถ้าไม่ต้องการก็เอาเครื่องหมายถูกออกให้หมด





ควรจะออกแบบให้ชิดมุมซ้ายบนเนื่องจาก เวลากำหนดขนาดหน้าต่างที่จะเปิดขึ้นใหม่ จะคิดค่าจากมุมซ้ายบน		





ส่วนถ้าต้องการจะใช้ Cction อะไรกับส่วนหัว ก็สามารถ Click ที่ปุ่ม Action ก็จะมีชุดของ Action ให้ลือกใช้ ซึ่งเป็นชุดเดียวกับ Action ที่ Link นั่นเอง





จากนั้นให้ไปหาอุปกรณ์ Head Action ที่ Tab Smart ใน Palette Object





วางอุปกรณ์ Head Action ลงบนส่วนหัวของ HTML แล้วไปดูที่ Inspector จะสามารถเลือก Action มาใส่ได้





ถ้าต้องการใส่ Action ให้ส่วนหัวของ HTML ให้ไปที่มุมซ้ายบนของหน้า Layout จะมี ปุ่ม “ Toggle Head Section “ ให้กดเพื่อจะเปิดการทำงานส่วนหัวของ  HTML ลงมา
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จากนั้นให้ไปกดที่ Icon Actions ก็จะมีชุดของ Action ให้เลือกใช้มากมาย โดยถ้าเลือก Action ตัวไหนก็เท่ากับว่ามีการทำ Action กับ Link นั้นเรียบร้อยแล้ว





เมื่อเลือก Events หรือเหตุการณ์เรียบร้อย แล้วให้กดที่ New Item  เพื่อบอกว่าต้องการเลือก  Events นั้นๆ โดยที่สามารถจะใส่ Events ลงไปกี่ตัวก็ได้ และถ้าจะลบ Events ตัวไหนออก ก็ให้เลือก Events แล้วกดที่ Icon รูปถังขยะก็จะสามารถลบ Events นั้น ๆ ออกได้





ปรับความเร็วของ Animation มีหน่วยเป็น FPS(Frame per second )





แผงควบคุมการเล่น Animation ในกรณีที่ต้องการทดสอบAnimation โดยไม่ต้องไปที่ Preview





“ Loop “ ถ้ากดที่ปุ่มนี้ไว้ Animation ของเมื่อเล่นจบ จะเริ่มต้นเล่นใหม่ไปเรื่อยๆ 





Autoplay ปกติจะถูกกดไว้ เมื่อ Preview  Animation จะเริ่มเล่นอัตโนมัติ





ถ้าต้องการ Animation ในลักษณะวิ่งเป็นเส้นตรงให้เลือก KeyFrame ที่อยู่ตรงกลางทั้งหมด แล้วกด Delete บน Keyboard ให้เหลือแต่เฉพาะ KeyFrame เริ่มต้น และ KeyFrame สุดท้ายเท่านั้น ตอนนี้จะได้ Animation ที่วิ่งเป็นเส้นตรงแล้ว








สี่เหลี่ยมสีม่วงที่เห็นจะเรียกว่า “ KeyFrame “ ซึ่งจะเกิดขึ้นทุกครั้งที่มีการเปลี่ยนแปลงเส้นทางในกรณีที่สร้าง Animation จากการลากด้วยมือจะมี KeyFrame เกิดขึ้นเยอะเนื่องจากคงไม่สามารถลากเป็นเส้นตรงได้ด้วยมือของเราเอง





สามารถเข้าไปปรับการทำงานของ Animation ที่ “Open DHTML timeline editor “ ซึ่งเป็น Icon มุมบนขวา ดังรูป








และในกรณีที่มี Floating- Box ซ้อนทับกันหลายๆ ตัว ก็สามารถสลับตำแหน่งบนล่างให้กับมันได้ โดยใช้ค่า Z-Index ในการเปรียบเทียบค่ากัน ถ้า Floating Box ไหนที่ค่า Z-Index มากกว่าก็จะอยู่ทับ Floating Box ที่มีค่า Z-Index น้อยกว่า





ถ้าใส่ Image ลงไปใน Floating Box 


( 1 ภาพ ใส่ Floating Box 1 อัน ) จะเห็นได้ว่าสามารถนำรูปภาพทั้งสองมาวางทับกันได้ โดยใช้วิธีการ Click ที่ขอบ Floating Box แล้วลากมาทับกัน
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สามารถพิมพ์ Text ลงไปด้านใน หรือจะใส่รูปภาพก็ได้ ถ้ารูปที่ใส่นั้นใหญ่กว่า Floating Box มันจะขยายเองอัตโนมัติ
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ถ้าต้องการกำหนดคุณสมบัติของ Floating Box


ให้ Click ที่ขอบของ Floating Box แล้วไปดูที่ Inspector จะสามารถปรับค่าต่างๆ รวมถึงการทำ Animation ให้กับ Floating Box ด้วย ค่า Left กับ Top เป็นตำแหน่งของ Floating Box ตัวนี้ที่หน้างาน ส่วนค่า Width กับ Height เป็นขนาดของ Floating Box ตัวนี้ และสามารถจะใส่ Background Color และ Background Image ของ Floatig Boxได้ที่ช่อง Color และ BG Image





ลากอุปกรณ์  Floating Box ลงไปวางในหน้างานจะมีลักษณะดังรูป ถ้าอยากจะเลื่อน Floating Box ให้ Click ที่ขอบค้างไว้แล้วลาก จะเห็นว่าสามารถเลื่อนอุปกรณ์ตัวนี้ไปไหนก็ได้ในหน้างาน โดยไม่ต้องพึ่ง Layout Grid  ( * บทที่ 5 )





DHTML กับ Adobe Golive6


ใน Adobe Golive 6 นั้นมีอุปกรณ์ที่เอาไว้ทำงานเกี่ยวกับ DHTML โดยตรงที่ชื่อว่า “Floating Box“ นั่นหมายความว่า ถ้ามีการใช้อุปกรณ์ตัวนี้ที่งานหน้านี้แสดงว่า Web Page หน้านี้จะกลายเป็น DHTMLทันที











รูปที่ 3





รูปที่ 1





รูปที่ 2
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แบบฟอร์ม





E-mail





Mail.asp





Form





Programming System





Out put





Image Object





Button Object





Reset Object





Submit Object





Hidden Object





Popup Object





List Box Object





Check Box Object





ถ้าทำการกำหนด Group ไม่เป็นตัวเดียวกัน จะสามารถเลือกได้ทั้งชายและหญิง


ถ้าต้องการให้เลือกได้ ตัวใดตัวหนึ่งให้ทำการตั้ง Group ให้ตรงกันด้วย





Radio Object





ส่วนมากอุปกรณ์ตัวนี้ไม่ได้รับความนิยมเนื่องจากไม่มีผลกับทาง การเขียนโปรแกรม


ส่วนมากจะใช้การพิมพ์ข้อความธรรมดาแทน





Label Object





File Browser Object





Text area Object





กรณี เป็น Text Field ธรรมดาจะไม่มีการ check ที่ Is Password Field





Password  Object





Text Field Object





Form Object





แท็บ  Forms บนหน้าต่าง Palette  จะเป็นที่เก็บอุปกรณ์ต่าง ๆ ที่ใช้ในการสร้างแบบฟอร์มทั้งหมด





คลิ๊ก แท็บ Forms บน Palette Object





Row Span





Column Span





Cell Space





Border





Cell Pad





พื้นที่แต่ละช่องจะเรียกว่า เซล (Cell)





มองตามแนวนอนเรียกว่า แถว (Row)





มองตามแนวตั้งเรียกว่า สดมภ์ (column)





ลาก Table ไปวางบนหน้าต่าง Layout





Main_menu.gif





Main_menu_over.gif





Over





Normal





Rollover Object





คลิ๊ก แท็บ Smart





เครื่องมือ Keywords Keywords
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